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EcoStruxure IT Data Center Expert 8.1.0

What's new in EcoStruxure IT Data Center Expert 8.x

Learn about the new features available in the Data Center Expert 8.x releases.

The Data Center Expert 8.1 release contains improvements including:

The Data Center Expert public APl is now available at https://<server_address>/isxg/
rest

The Data Center Expert Virtual Appliance OVA is now built on ESXi 6.7.

Event log messages can now be forwarded to a Syslog server. Go to System >
Server Administration Settings > Syslog Configuration to enable Syslog
integration and configure settings.

The event log now includes:

« Syslog configuration messages: Enable, Disable, and any changes that occur.

» Threshold configuration messages when a user creates, deletes, or modifies a

threshold.

* Notification policy messages, including the policy name, when a user creates,

deletes, or modifies a notification policy.

» Device group messages when devices are moved from one group to another.
The timeout for AD/LDAP is now configurable up to 300 seconds; the default is 15
seconds. Go to System > Server Administration Settings > Users and Device
Group Access > Authentication Servers.

Note: When you increase the authentication server timeout, also increase the timeout
on the desktop client login screen.

A new $(SENSORVAL_NOLABEL) alarm action macro does not include special
characters.

When you configure the Short Message Email alarm action, you can replace the
default §(SENSORVAL) macro in the Subject and Message fields with $
(SENSORVAL_NOLABEL) to display the sensor value without the label, for example,
81.2, rather than 81.2 ° F.

You can now customize device labels for SNMP and Modbus devices. Right click the
device and select Device Label Settings.

The Data Center Expert server now checks the available disk space before performing
a software update and before restoring a backup.

The loading time for the list of backups was optimized.

There is now a progress indicator in the Updates > Apply Server Updates display.
Obsolete options were removed from the desktop client:

» Customer Experience Program

* ION Enterprise Settings

* Remote Monitoring Service (RMS)

« InfraStruxure Manager Migration Utility

See the release notes for more information.

Data Center Expert 8.0

The 8.0 release contains improvements including:

Device discovery for NetBotz Appliances

The device discovery types in the Device > Add devices option are more descriptive
and include guidance for NetBotz Appliance models.
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* Compressed backups

The Compress Backup option was removed from the backup share configuration.
* Device Launch Settings

The Device Launch Settings option now defaults to HTTPS and port 443.
* DDF retrieval

Data Center Expert now attempts to retrieve Device Definition Files (DDFs) from APC
NMC devices using HTTP/HTTPS in addition to FTP/SCP attempts.
e HTTP Strict Transport Security (HSTS) support

To enhance security, an HSTS entry can be added to HTTP response headers to
automatically redirect HTTP connections to HTTPS.

A new setting on the Web Server tab in the System > Administration Settings > Server
Access option allows you to Enable HTTP Strict Transport Security.

Note: If you select HTTP, it is recommended that you enable HSTS unless it prevents
older NetBotz Appliances from posting successfully.

Learn more about HSTS
* Updated Modbus communication terminology

Modbus.org announced it is expunging all occurrences of inappropriate language of
the query and response paradigm of Modbus communications. The organization is
using "client-server" instead of "master-slave" to describe Modbus communications.
More...

See the release notes for more information.


https://https.cio.gov/hsts/
https://www.modbus.org/docs/Client-ServerPR-07-2020-final.docx.pdf
https://www.modbus.org/docs/Client-ServerPR-07-2020-final.docx.pdf
https://community.se.com/t5/EcoStruxure-IT-Help-Center/ct-p/ecostruxure-it-help-center?category=data-center-expert&board=data-center-expert-release-notes
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About Help

Help is available at any time, and can be viewed and invoked in various ways. Relevant
topics can be printed from the Help browser window.

To open help in a separate Help browser window, select Help Contents in the Help

menu.

To open the Help view for the currently selected view, select Dynamic Help in the
Help menu, or by press F1. This Help view provides access to information directly related
to the selected view; when a different view is selected, it automatically updates to provide

access to help for the new view.

Context-sensitive help is also available in displays; clicking the question-mark (?) button in
the lower-left corner adds a version of the Help view to the display that provides access to

information directly related to that display.

Select What's New in the Help menu to see information about new features and

enhancements.

Click EcoStruxure IT Help Center in the Help menu to access the most up-to-date Data
Center Expert documentation online. Visit the help center

Help menu

This menu's options access the online help in a separate Help browser, search and dynamic
help in a Help view, and copyright and version information.

Help Contents

Opens the online help in a separate Help
browser window.

Search Help

Opens the search function in the Help view.

Dynamic Help

Opens the Help view with access to
context-sensitive information about the
currently selected view.

About EcoStruxure IT Data Center
Expert

Opens the "About Data Center

Expert" display which provides copyright
and version information, and the MAC
address and serial number of the Data
Center Expert server.

"About Data Center Expert" display

This display, accessed by selecting About in the Help menu, provides software version
and build numbers, the MAC address of the Data Center Expert server, and copyright

information.

A unique serial number is generated for the Data Center Expert virtual appliance at startup

and is available in this display.
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The serial number for a Data Center Expert hardware server is available only on its serial
number sticker.

Note: Please have the software version and build numbers, and the Data Center Expert
server MAC address and serial number available when contacting support.
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Console features

The Data Center Expert server creates a consolidated view of your network's physical
infrastructure layer. Real-time device monitoring, custom reporting capabilities, private
networking, advanced security and immediate event notification all enable quick
assessment and resolution of critical situations.

The console provides the Data Center Expert client access to server functions and features.
This console has the following major elements:

* An application bar that provides access to Monitoring, Surveillance, Alarm
Configuration, and Reports perspectives and views

* Seven main menus ( File, Device, Alarm Configuration, Updates, System,
Window, and Help)
Note: Right-click menus are also available in the perspectives and views.

» A status bar at the bottom of the display

Perspectives and views

Monitoring

The console uses perspectives and views to provide information, and access to major
functions.

There are five perspectives you can choose for the console:

* Monitoring: provides access to the data and functions you can use to monitor and
manage your devices.

« Surveillance: provides access to data and functions you can use to monitor and
manage the surveillance equipment at monitored devices.
Note: The surveillance feature is separately-licensed. Its license must be entered at
the Data Center Expert server using License Key in the "Server Administration
Settings" display accessed by Server Administration Settings inthe System menu.

« Alarm Configuration provides options used to configure how the Data Center
Expert server reports alarm conditions.

* Reports provides access to reports about the devices the Data Center Expert server
monitors.

When you log on to your Data Center Expert server, the console opens with the
Monitoring perspective displayed; Monitoring, Surveillance, Alarm Configuration ,
and Reports buttons below the main menus allow you to switch between perspectives.

This perspective opens with five views displayed, by default.

» Device Groups view: used in this perspective to create the device groups to which
monitored devices can be assigned, and to select a device group to view or manage
its devices.

* Device View: lists the devices assigned to the group selected in the Device
Groups view, provides information about those devices, and launch to management
applications at some of those devices.

* Map View: displays icons for the devices in the group selected in the Device
Groups view, each icon providing quick access to information about its sensor values;
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the icons, which are displayed against a user-definable background, can be
repositioned and resized.

Active Alarms view: provides information about any alarms that exist for the devices
assigned to the group selected in the Device Groups view.

Virtual Sensors view: allows users with Device Administrator or Server Administrator
to create, modify, and delete virtual sensors.

You can use the Window menu to add any other views to the Monitoring perspective.

Surveillance

Alarm History view: allows you to review the alarms that occurred during a specified
period of time, for all devices within a selected device group, or for a device, or set of
devices, selected in that group.

Custom Properties Editor view: allows you to add, edit, or remove custom property
keys, and modify their value, on devices and sensors selected in the Device View or
Map View.

Note: The value of a custom property key must be modified one device or sensor at
a time.

Saved Discoveries view: allows you to run or schedule previously performed or new
processes used to discover and add devices to the list of devices the Data Center
Expert server monitors.

Firmware Update Status view: allows you to view information about the status of
ongoing update processes for monitored SNMP devices and NetBotz Appliances.
Device Configuration Status view: allows you to view information about the status
of ongoing configuration processes for monitored SNMP devices and NetBotz
Appliances.

This perspective opens with two views displayed, by default.
Note: For more information about how the identified views are used for surveillance
functions, see Surveillance perspective.

Thumbnails view: provides thumbnail views and identification information for the
surveillance equipment.

Device Groups view: used in this perspective primarily to select a device group to
view the thumbnails for that group's surveillance equipment.

Alarm Configuration

This perspective opens with two views displayed, by default.

Navigation view: provides a list of device groups and devices monitored by the Data
Center Expert server, and allows you to create thresholds by device or by device
group, and add them to notification policies.

Threshold Alarm Configuration view: provides a list of thresholds associated with
the device group or device selected in the Navigation view, and allows you to modify
thresholds by type or by device, and add them to notification policies.

Device Alarm Configuration view: provides a list of device alarms associated with
the device group or device selected in the Navigation view, and allows you to modify
alarms by type or on the device that reports the alarm.

Notification Policies view: allows you to create and edit the policies used by the
Data Center Expert server to generate alarm notifications, and view the thresholds
you have added to those policies.
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Reports

This perspective opens with the Available Reports displayed by default, including Sensor
History Reports, Snapshot Reports , and Saved Sensor Reports. When an available
report is generated, that report appears in its own view.

Snapshot Reports include:

Battery Age

Device Type Inventory

Environmental Humidity

Environmental Temperature

UPS Runtime

Main menus

A menu bar immediately below the console title bar provides seven menus, with options
that control or configure Data Center Expert features and functions.

Menu

Options

File

Change Server: closes the session, and accesses the " Data Center Expert Logon"
display.

Reboot Server: reboots the Data Center Expert server.

Note: When a reboot finishes, an e-mail is sent to the Data Center Expert
Administrator users that include an e-mail address as part of their user credentials.

Shut Down Server: shuts down the Data Center Expert server.

Client Preferences: accesses settings specific to the Data Center Expert client you
use.

Exit: closes the Data Center Expert client.

Device

Add Devices: accesses the "Device Discovery" wizard used by the Device discovery
processes.

Create Virtual Sensor: accesses options to create a virtual sensor used to monitor
the average or total value of multiple numeric sensors of the same sensor type.

SNMP Device Communication Settings: accesses options used to configure
various functions for how the Data Center Expert server communicates with, and
monitors, SNMP devices.

Modbus Device Communication Settings: accesses options used to configure
various functions for how the Data Center Expert server communicates with, and
monitors, Modbus devices.

Note: Modbus support is a separately-licensed feature.

NetBotz Appliance Communication Settings: accesses options used to configure
various functions for how the Data Center Expert server communicates with, and
monitors, NetBotz Appliances.

NetBotz Appliance Configuration: accesses an Alert Settings option used to
define the alert notifications generated by each monitored NetBotz Appliance, as well
as options used to configure various functions at the monitored NetBotz Appliances.
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Menu

Options

APC SNMP Device Configuration: accesses settings used to select an APC SNMP
device or saved configuration file, and use it to configure settings at the other APC
SNMP Devices monitored by the Data Center Expert server.

Manage Custom Property Keys: accesses settings used to create, modify, or
remove user-created property keys for monitored devices.

Surveillance Settings: accesses settings used to configure various functions for the
surveillance devices at monitored NetBotz Appliances.
Note: Surveillance support is a separately-licensed feature.

Alarm
Configuratio
n

Defines how the Data Center Expert server performs notifications when thresholds
and device alarms are triggered for its monitored devices.

Create Thresholds: accesses options used to define the threshold alarms for devices
monitored by the Data Center Expert server.

Create Notification Policy: accesses settings used to create a notification policy
used by the Data Center Expert server to generate alarm notifications.

Manage Alarm Actions: accesses settings used to create, modify, and delete alarm
actions from the Data Center Expert server.

Network Management System Integration: accesses settings used to enable the
Data Center Expert server to send SNMPv1/SNMPvV3 traps to defined Network
Management System consoles for alarms that occur at the monitored SNMP, Modbus,
and NetBotz Appliances, and associated devices.

Reports

Provides options used to generate Sensor History reports and Snapshot reports, and
manage the export configurations that are used to export reports on a scheduled
basis.

Generate Sensor History Report: accesses the "Report Criteria” display used to
generate Sensor History and Custom Sensor History reports.

Snapshot Reports: generates the selected snapshot report for the device groups
specified.

Manage Export Scheduling: accesses the display used to schedule when reports
will be automatically exported.

Updates

Provides options used to update the Data Center Expert server and its monitored
NetBotz Appliances and SNMP devices.

Apply Firmware Updates: accesses the "Select Device Update" display used to
download firmware updates to monitored NetBotz Appliances or SNMP devices.

Apply Server Updates: accesses the "Apply Server Update" display used to update
the Data Center Expert server.

Schedule Update Checks: accesses settings used to schedule when the Data
Center Expert server will check for available APC device firmware updates.

System

Server Administration Settings: accesses options used to configure a wide range
of Data Center Expert server functions.

Users and Device Group Access: accesses the "Users and Device Group Access"
display used to manage the users, the Monitoring and Surveillance access those
users have to the device groups, and the authentication servers that provide remote
access to the Data Center Expert server.
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Menu

Options

Building Management Settings: accesses settings used to configure the MODBUS
TCP Output Module support that allows a Building Management System to monitor
status for the devices managed by the Data Center Expert server.

Note: MODBUS TCP Output Module support is a separately-licensed feature.

Window

Provides a Restore Default Screen Layout: option that restores the selected
perspective to its default views and layout, and five categories of options that access
views of the same name that are used in the Monitoring, Surveillance, and Alarm
Configuration perspectives.

Alarms: Active Alarms and Alarm History

Alarm Configuration: Navigation, Notification Policies, Threshold Alarm
Configurations, and Device Alarm Configurations

Device: Device Groups, Device View, Map View, Virtual Sensors, Saved
Discoveries, Custom Properties Editor, Device Configuration Status, and
Firmware Update Status.

Surveillance: Thumbnails only

Help

Provides options used to access the help, and information about the application.

EcoStruxure IT Help Center: Provides access to the most up-to-date Data Center
Expert documentation online. Visit the help center

Help Contents: Opens the help in a separate window with the top item in the table of
contents selected.

Search Help: Opens the search function in the Help view.

Dynamic Help: Opens the Help view with information about the view selected in
the Monitoring, Surveillance, Alarm Configuration, or Reports perspective.

About EcoStruxure IT Data Center Expert : Opens the display that provides
software version and build numbers, the MAC address and serial number of the Data
Center Expert server if available, and copyright information.

Status bar

Reports information about the Data Center Expert server. Each type of information can be
clicked to access a related view or display.

Information Description

Device status

How many devices have a warning or critical
condition.

Clicking this area accesses the Active
Alarms view.

Devices

The number of devices the Data Center Expert
server is monitoring.

Clicking this area accesses the Device
View.

Device discoveries in progress How many discovery processes are currently in

progress.

10
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Clicking this area accesses the Saved
Discoveries view.

User The username you used to log on, and the
hostname or IP address of your Data Center
Expert client.

Clicking this area accesses the "Logged on
Users" display that identifies all users
logged on at the server.

Note: A lock icon is displayed in the status
bar when the user is logged on using SSL.

Progress indicator Shows the status loading device alarms,
sensors, thresholds and other services when
the Data Center Expert client starts.

"Logged on Users" display

Use this display to review information about the users ( Username), their Logon Time,
and the hostname or IP address of their Data Center Expert clients ( Client).

Right-click options common to all views

All views share options accessed by right-clicking within the top border of a view. These
options physically affect a view, but not the information the view provides.

Option Description
Detached Detaches the view, creating an unanchored,
free-floating view.
Restore Currently disabled.
Move Allows you to move a view to anywhere else

within the selected perspective.

Size Highlights the side of the view you want to use to
resize the view: Right, Left, Top, or Bottom.
Note: The sides of the view which can actually
be used to resize that view will be the only
enabled options.

"Configure Columns™ display

Use this display, accessed by the (@) icon, to identify the columns that appear in various
views and displays.

11
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Initial setup requirements

The following actions should have been performed during the Data Center Expert server
installation.

» The server was physically installed.

» The server was connected to a power source.

» The public and private local area network (LAN) settings were defined at the server.
Note: You can verify these settings are defined correctly by selecting Server
Administration Settings in the System menu, and then selecting Network
Settings in the "Server Administration Settings" display.

With those actions performed, you can log on to the Data Center Expert desktop client and
configure the server to use all of the Data Center Expert server's functions and features to
monitor and manage your company-wide physical infrastructure devices, and other APC,
NetBotz, and 3rd-party devices on your networks.

You can then use a browser to launch to the IP address or hostname of the Data Center
Expert server, and access the Data Center Expert web client, a real-time overview of
active alarms and device details for that server on a computer, tablet, or mobile device.

Minimum setup requirements

There are a several actions you must take to configure the server to perform the most basic
functions needed to monitor SNMP devices, Modbus devices, and NetBotz Appliances.

1. Ifthe Data Center Expert client is installed on your machine, go to step 3. Otherwise,
do the following:
a. Use a browser to launch to the IP address or hostname of the server.
b. Logintothe Data Center Expert web client using the Administrator
Username and Password, and click Download Clientin the upper right corner.

2. Click | agree to accept the software license agreement, and follow the on-screen
instructions to install the Data Center Expert client.

3. Launch your client and log on at the Data Center Expert server using the
Administrator Username and Password.

4. Enter Data Center Expert licenses, if you want to start monitoring more than 25
devices, or to use the separately-licensed Surveillance feature. Otherwise, go to step
5.

a. Select Server Administration Settings > License Keys inthe System menu.
b. Enter the license keys.
Note: You can also enter the license numbers for other separately-licensed
features, in addition to Surveillance.

5. Make sure the administrator credentials include the e-mail address of the person you
want notified when alarm conditions directly related to Data Center Expert server
operations occur.

a. Select Users and Device Group Access in the System menu.

b. Select the Data Center Expert Administrator ( apc, by default) in the User
and User Group Details section of the Users tab, and click Edit User.

c. Editthe E-Mail Address credential, if needed.
Note: You can change the default Username and Password values, as well.

6. Define the e-mail settings the Data Center Expert server will use to send e-mails to
the administrator when alarm conditions related to the server operations occur.

12
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7.

10.

11.

a. Select Server Administration Settings > E-mail Settings in the System
menu.

b. Define the Primary and Secondary tab settings, as needed.

Enable the SOCKS server feature to enable communication with any devices you want
to monitor on the private LAN, if necessary.

a. Select Server Administration Settings > Server Access inthe System
menu.

b. Enable the SOCKS Server option in the SOCKS Proxy tab.

Add a remote NFS or Windows share repository the Data Center Expert server can
use instead of the local repository.

a. Select Server Administration Settings > Storage Settings in the System
menu.

b. Use the Repositories tab to add a remote repository.

c. Usethe Purge Settings tab to define the purge settings you want the repository
to use.

Define at least one NFS or Windows share location to be used for backup files of
the Data Center Expert server configuration data, or its configuration and repositories
data.

a. Select Server Administration Settings in the System menu.

b. Select Server Backup/Restore in the "Server Administration Settings" display.

c. ldentify the NFS or Windows share location at which backup files will be saved.

d. Schedule how often those files will be created automatically.

Note: By default, backup files will be created every Friday at 1:00 AM.
Discover the SNMPv1 (includes 200 and 750 series NetBotz appliances), SNMPv3
(includes 200 and 750 series NetBotz appliances), Modbus devices, and NetBotz
Appliances (includes 300-500 series NetBotz appliances) you want your server to
monitor.

Note: All four device types require their own discovery process, not only on the public
LAN, but on the private LAN, as well.

a. Select Add Devices inthe Device menu, or click the green +iconinthe Device
View.

b. Select which type of device you want to discover (SNMPv1, SNMPv3, NetBotz
Appliance, or Modbus TCP), and click Next.

c. Define the parameters to be used for the discovery process.

Run the discovery process.

e. Repeat steps a through d, as needed, to discover all the types of devices you
want the Data Center Expert server to monitor (SNMPv1, SNMPv3, NetBotz
Appliance, or Modbus TCP), on both the public and private LANSs.

Define any or all the alarm notifications you want available to the Data Center
Expert server for any SNMPv1, SNMPv3, and Modbus devices discovered during step
9.

Note: Additionally, each NetBotz Appliance has its own unique profiles it can use for
alarm conditions at the devices it monitors (see step 13).

o

The Data Center Expert server has a Default notification policy. Device alarms and
communication link status thresholds for all monitored devices are included in the
Default notification policy at device discovery.

You must create at least one alarm action, and add it to the Default notification policy,
or another notification policy you create, before the Data Center Expert server can
generate alarm notifications for conditions that occur at monitored SNMP and Modbus
devices.

a. Select Manage Alarm Actions in the Alarm Configuration menu.

b. Click Create to access the Alarm Action wizard.

c. Inthe "Choose Alarm Action Type" display, select the type of alarm you want to
create, and click Next.

13
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d.

Inthe "Configure Alarm Action" display for the selected action, define the settings
you want the action to use, and click Finish to exit the wizard.

12. Add alarm actions to the Default notification policy.

a.

C.

In the Alarm Configuration perspective, in the Notification Policies view,
select the Default notification policy. Right-click and select Edit.

Note: To create a new notification policy, right-click or use the Create
Notification Policy icon.

Click Add to configure the alarm actions to add to the notification policy. Click
Manage Actions to create alarm actions, or modify or remove existing alarm
actions on the Data Center Expert server.

Note: You click Choose Thresholds to add user-created thresholds, for the
device groups or devices selected, to the Default notification policy .
Communication link status thresholds for monitored SNMP and Modbus devices
are added to the Default notification policy at device discovery.

Check-mark one or more actions to configure their notification options, check-
mark the actions you want to add to the natification policy, and click OK.

13. Create thresholds for sensor types supported by monitored devices.

a.

e.

Select the sensor type on which you want to add a threshold from the Create
Thresholds option in the Alarm Configuration menu. Alternatively, select a
device group or device, and right-click to select the Create Thresholds option.
Inthe "Select Threshold Type" display, select the threshold type you want to add,
and click Next.

In the "Select Sensors" display, select the sensor or sensors for which you want
to add thresholds, and click Next.

In the "Create Threshold" display, define the settings, and, if desired, click
Threshold Scheduling to configure when the Data Center Expert server will
generate notifications if the threshold becomes active. Click Next.

In the "Select Notification Policies" display, select the notification policies to
which you want to add the alarm threshold, and click Finish to exit the wizard.

14. Define any or all the alert actions you want available to any NetBotz Appliances
discovered during step 9, to associate with the alert profiles used for alert notifications.
Each NetBotz Appliance has its own unique profiles it can use for alarm conditions at
the devices it monitors.

Note: An alert action must be available to the Data Center Expert server, and to each
monitored NetBotz Appliance, for use with their alert profiles.

15.

a.

b.
c.

—h

Select Alert Actions, a NetBotz Appliance Configuration > Alert Settings
option in the Device menu.

In the "Select Alert Action Type" display, select an action.

In the "Select Next Action" display, select Create a new alert action.

In the "Select Next Action Devices" display, select the devices for which the
action can be used.

Define the action settings.

In the "Choose Next Action" display, select Configure another alert action to
repeat steps b through e, as needed, to finish defining all the alert actions for
your Data Center Expert server and monitored NetBotz Appliances.

Add at least one alert action to the one of the alert profiles used by each NetBotz
Appliance for alert notifications.

Note: The profiles at a NetBotz Appliance may have been defined already using its
NetBotz Advanced View. You can edit it to make sure someone in your organization
is notified when problems occur.

a.

b.

Select Alert Profiles, a NetBotz Appliance Configuration > Alert Settings
option in the Device menu.

In the "Select Parent Device" display, select the parent device (the individual
NetBotz Appliance) associated with the profile you want to configure.

14
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c. Inthe "Select Alert Profile" display, select the alert profile you wish to modify,
and click Next.

d. Configure the alert profile to include at least one of the alert actions available to
the selected parent device.

e. Repeat steps a through d to add at least one alert action to the alert profile used
by each monitored NetBotz Appliance.

Other support and feature setup requirements

Once the minimum setup requirements are defined, you can begin to configure the Data
Center Expert server to use all of its features and functions.

Create the device groups and subgroups, in the Device Groups view, that you can
use to group monitored devices that are physically or logically associated with each
other, for easier access to information about associated devices.

Assign devices to the device groups by selecting Unassigned in the Device
Groups view and dragging them from the Device View into your groups and
subgroups.

Add the local and remote users and user groups that you want to have access to the
server, and define the monitoring and surveillance access that non- EcoStruxure IT
Administrators users and user groups will have at the exiting device groups, by
selecting Users and Device Group Access in the System menu.

Customize the Map View for a group selected in the Device Groups view, by using
the Map Settings and Map Label Settings right-click options in the Map View.
Define any new alert actions, alert thresholds, and alert profiles you want to use for
the NetBotz Appliances the Data Center Expert server monitors, using the NetBotz
Appliance Configuration > Alert Settings options in the Device menu.

Create virtual sensors to view and monitor the average or total value of multiple
numeric sensors of the same sensor type, using the options in the Virtual Sensors
view.

Define any new alarm actions, thresholds, and notification policies you want to use for
the SNMP and Modbus devices the Data Center Expert server monitors, using the
options in the Alarm Configuration menu.

Define the remaining administration settings, as needed, using Server
Administration Settings in the System menu.

Configure the settings the Data Center Expert server uses to communicate with its
monitored SNMP devices, as needed, using SNMP Device Communication
Settings in the Device menu.

Configure the settings the Data Center Expert server uses to communicate with its
monitored Modbus devices, as needed, using Modbus Device Communication
Settings in the Device menu.

Configure settings the Data Center Expert server uses to communicate with its
monitored NetBotz Appliances, as needed, using NetBotz Appliance
Communication Settings in the Device menu.

Define custom property keys that describe monitored devices using the Add Custom
Property option in the Monitoring perspective or Custom Properties Editor view.
Manage custom property keys using the Custom Properties Editor view or Manage
Custom Property Keys option in the Device menu.

License your surveillance cameras, if any, using the Thumbnails view.

Note: A surveillance license must be entered in the License Keys section of the
"Server Administration Settings" display.

Configure the settings that affect how the surveillance equipment operates, using
Surveillance Settings in the Device menu.

Note: At least one camera must be defined as licensed to configure these settings.
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« Define the settings for your Data Center Expert client, using Client Preferences in
the File menu.

» Define how often you want the Data Center Expert server to check for firmware
updates available from APC, using Schedule Update Checks inthe Updates menu.

« Configure the settings the Data Center Expert server will use to log on to the web
interface at the monitored devices, using the right-click Device Launch Settings
option in either the Device View or Map View.

« Generate and manage graph or table-formatted reports for device sensors, using
the Saved Reports view, or the right-click Generate Sensor History Report option
in the Device Groups view, Device View, and Map View.

« Configure the Data Center Expert server to send SNMPv1traps and SNMPv3 informs
to defined Network Management System consoles for alarms that occur at the
monitored SNMP, Modbus, and NetBotz Appliances, and associated devices, using
Network Management System Integration in the Alarm Configuration menu.

» Configure settings at one or more of the monitored APC SNMP devices, using APC
SNMP Device Configuration in the Device menu.

» Select devices to enable for Modbus support, a separately licensed feature, using
the Building Management Settings option in the System menu.

Data Center Expert Web Client

The Data Center Expert web client provides a real-time overview of active alarms and
device details for the Data Center Expert server. The Data Center Expert web client is
available on a computer, tablet, or mobile device with an internet browser, in English only.

To access the Data Center Expert web client, you use a browser to launch to the IP address
or hostname of the Data Center Expert server, and provide a valid username and password
for that server.

Note: Tologintothe Data Center Expert web client, a user must have at least View Access
for one device group that contains a minimum of one device.

For more information, see the help in the Data Center Expert web client.

Data Center Expert Virtual Appliance

The Data Center Expert server is available as a virtual appliance, supported on VMware
ESXi 7.0.3. The full-featured demo of the virtual appliance monitors up to five device nodes
and one surveillance node. You can purchase a license key to upgrade to a production
version to monitor additional device nodes and activate supported applications, or to migrate
from a Data Center Expert server hardware version to a Data Center Expert virtual
appliance.

Starting with Data Center Expert 8.1, VMware ESXi 6.7 is used as the reference
virtualization platform for the Data Center Expert virtual appliance; only E1000E and
VMXNETS3 network adapters are supported. VMware ESXi 4.1.0 was used as the
reference virtualization platform in prior versions.

The Data Center Expert virtual appliance is delivered as an OVA (Open Virtualization
Archive), expected to function properly on any virtualization platform that supports this
format, or has an appropriate converter utility.

To use the full-featured demo version of the Data Center Expert virtual appliance, you
download the *.ova file from the APC web site, and deploy it to your virtualization platform
using the default hardware configuration. For more information, see Data Center Expert
virtual appliance equivalent configurations.
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The demo version monitors a maximum of five device nodes and one surveillance node by
default. You must upgrade the Data Center Expert virtual appliance demo to the production
version to monitor 25 device nodes (as displayed in the Data Center Expert client "License
Keys" display), add license keys to monitor additional nodes, or activate supported
applications.

Note: You can add an additional network adapter to enable private networking, or add
additional hard disks to increase storage, after the OVA template is deployed.

To upgrade the demo to the production version, you must purchase and apply an activation
key, available on the APC web site. To monitor additional device nodes or activate
supported applications, you must purchase and apply node license keys and application
license keys for the virtual appliance.

To migrate a Data Center Expert hardware server to a virtual appliance, you must purchase
and apply an activation key, and contact APC Support for new node license keys and
application license keys for the virtual appliance. To receive these keys, you are required
to provide a unigue MAC address and serial number for the Data Center Expert virtual
appliance, and for the Data Center Expert hardware server you are replacing.

A unique serial number is generated for the Data Center Expert virtual appliance at startup.
It is displayed in the "About Data Center Expert" display, accessed from the Help menu.
Note: The serial number for a Data Center Expert hardware server appears only on its
serial number sticker.

This section of the Data Center Expert Virtual Appliance help fully describes deploying
the Data Center Expert virtual appliance, and the upgrade and migration processes. It is
available as a separate printable document on the APC web site.

Deploying and configuring a Data Center Expert virtual appliance

The Data Center Expert virtual appliance demo version monitors up to five device nodes
and one surveillance node. You can upgrade to a production version after the OVA is
deployed. Starting in DCE 8.1, ESXi 6.7 is used as the reference virtualization platform.

1. Download the *.ova file from the APC web site.
2. In your virtualization platform client interface, browse to the location of the *.ova file,
and load the OVA. This may take several minutes.

Alternatively, you may have the option to specify the URL for the *.ova file in your
virtualization environment client interface.

3. Follow the prompts to accept the end user license agreement, and respond to options
required to configure the OVA.

Select thin provisioned disk format to allocate storage space on demand. Select thick
provisioned disk format to allocate all storage space immediately.

Configuring the network settings

You must provide the MAC Address, IP Address, hostname, and network settings before
using the Data Center Expert virtual appliance.
1. Selectthe Data Center Expert virtual appliance you created, and select the option to
edit the virtual machine settings.
2. Specify the MAC Address for the virtual appliance manually.

A unique MAC Address is required for each Data Center Expert . If the MAC
Address originally assigned to the virtual appliance is changed, an error will
occur on the primary interface, and the virtual appliance will not start.

3. Power on the virtual appliance.
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4.

In the console view, login to the virtual appliance using apcset up as the username
and password.

Within five seconds, press mto modify the settings.

Follow the prompts to specify the IP Address, hostname, subnet mask, and DNS
servers for the virtual appliance.

After the virtual appliance has restarted, type its IP Address or hostname into a
browser to login to the Data Center Expert client.

Adding an additional network adapter

You can add one additional network adapter to enable private networking. You cannot
remove a network adapter once it has been added.
Starting in DCE 8.1, only E1000E and VMXNET3 network adapters are supported.

1.
2.

3.

oo

1
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Gracefully shut down the virtual appliance.

Selectthe Data Center Expert virtual appliance, and select the option to edit the virtual
machine settings.

Select the options to add an ethernet adapter.

Specify the type and the network connection.
Ensure this connection is mapped correctly, particularly when the DHCP server will

be enabled on the private network interface.

Power on the virtual appliance.

In the console view, login to the virtual appliance using apcset up as the username
and password.

Within five seconds, press mto modify the settings.

Accept the settings you configured previously, or modify settings if needed.

Press vy to acceptthe Enable private network interface option.

Specify whether you want to enable the DHCP server on the private network interface.

Upgrading a Data Center Expert virtual appliance demo version to production

To upgrade from the demo to the Data Center Expert virtual appliance production version,
you must install the activation key.

1.
2.

Purchase the activation key for the virtual appliance.

Login to the Data Center Expert client. In the "License Keys" display, accessed from
the Server Administration Settings option in the System menu, and apply the
activation key.

Apply the new virtual appliance node license keys and application license keys you
received from APC Support.

The upgrade is complete one you have applied the license and application keys. If
you want to modify the virtual appliance settings, continue to Step 4.

In your virtualization platform client, gracefully shut down the Data Center Expert
virtual appliance.

Select the option to edit the Data Center Expert virtual appliance settings.

Modify the hardware, if necessary.

See help for Deploying and configuring a Data Center Expert virtual server, and Data
Center Expert virtual server equivalent configurations.
Power on the virtual appliance.

Migrating a Data Center Expert hardware server to a virtual appliance

To migrate a Data Center Expert hardware server to a virtual appliance, you must purchase
and apply an activation key. Additionally, you must contact APC Support for new node
license keys and application license keys for the virtual appliance.
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1. Perform a back up of the Data Center Expert hardware server, using the Server
Backup/Restore option, accessed from the Server Administration Settings option
in the System menu.

2. Deploy the demo version OVA, and configure it using the hardware equivalents for
the Data Center Expert Basic, Standard, or Enterprise server from which you are
migrating. The available disk space for the virtual appliance must be greater than
the disk space used by the hardware server.

You cannot restore to a virtual appliance with fewer CPU, fewer network adapters,
less RAM, or less available disk space than the hardware server.

See help for Deploying and configuring a Data Center Expert virtual appliance, and
Data Center Expert virtual appliance equivalent configurations.

3. Perform arestore on the virtual appliance, using the Server Backup/Restore option,
accessed from the Server Administration Settings option in the System menu.

You cannot restore to a virtual machine other than the Data Center Expert virtual
appliance.

4. Apply the activation key to the virtual appliance.

5. Login to the Data Center Expert client. In the "License Keys" display, accessed from
the Server Administration Settings option in the System menu, apply the new
node license keys and application license keys you received from APC Support.

Adding disk space to a virtual appliance
To increase storage for the virtual appliance, you must create additional hard disks.

You cannot change the size of an existing hard disk, or remove a hard disk once it has been
created. An error will occur on the primary interface, and the Data Center Expert virtual
appliance will not start.

1. Gracefully shut down the virtual appliance.

2. Inyour virtual server console, select the option to add a hard disk.

3. Choose the hard disk size.

See Data Center Expert virtual server equivalent configurations.
4. Choose thin or thick provisioning.
5. Power on the virtual appliance.

Changes in the disk space will take effect once the Data Center Expert virtual appliance
has restarted. Do not shut down the virtual appliance while the disk reconfiguration process
is running.

The "Storage Settings" display, accessed from the Server Administration Settings option
in the System menu, shows the total storage space available for the virtual appliance, not
the individual hard disks.

Note: To store large amounts of surveillance data, using a remote repository is
recommended.

About changing hardware resource settings for the Data Center Expert virtual
appliance

After you have deployed the OVA, you can make changes to the Data Center Expert virtual
appliance settings from your virtualization platform client interface. You use apcset up as
the username and password.
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Network settings: You can configure an additional network adapter to enable the private
network (APC LAN) as the apcsetup user or through the Data Center Expert client.

MAC Address settings: A unique MAC address is required for each Data Center Expert
virtual appliance. If the MAC address originally assigned to the primary or secondary
network interface is changed, an error will occur on the primary interface, and the virtual
appliance will not start. A message will be displayed indicating the MAC address expected
before normal startup will be allowed.

Hard disk settings: To increase storage for the virtual appliance, you can create additional
hard disks. You cannot change the size of an existing hard disk, or remove a hard disk once
it has been created. An error will occur on the primary interface, and the Data Center
Expert virtual appliance will not start.

Changes in the disk space will take effect once the Data Center Expert virtual appliance
has restarted.

The "Storage Settings" display, accessed from the Server Administration Settings option
in the System menu, shows the total storage space available for the virtual appliance, not
the individual hard disks.

Note: To store large amounts of surveillance data, using a remote repository is
recommended.

RAM settings: You can add RAM to the Data Center Expert virtual appliance. You must
gracefully shut down the virtual appliance to configure the settings.

CPU settings: You can add CPUs to the Data Center Expert virtual appliance. You must
gracefully shut down the virtual appliance to configure the settings.

Note: VMware supports fault tolerance on virtual machines with 1 CPU only. Please refer
to your vendor's documentation for more information about fault tolerance.

Hardware resource configuration guidelines

Use the DCE sizing guide to determine the hardware resources necessary for a Data
Center Expert virtual appliance to monitor a given number of device nodes.

Note: VMware supports fault tolerance on virtual machines with 1 CPU only. Please refer
to your vendor's documentation for more information about fault tolerance.

The disk space required to monitor a given number of nodes varies according to the device
types monitored and the amount of data you want to store. The minimum hard disk size is
18 GB.

To determine whether to add another hard disk, you can view available disk space in the
"Storage Settings" display, accessed from the Server Administration Settings option in
the System menu. View this display periodically to help determine how quickly the virtual
appliance consumes disk space.

Note: To store large amounts of surveillance data, using a remote repository is
recommended.

Fault tolerant configuration guidelines
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Use the DCE sizing guide to determine the hardware resources necessary for a Data
Center Expert virtual appliance fault tolerant configuration.

VMware supports fault tolerance on virtual machines with 1 CPU only. Please refer to your
vendor's documentation for more information about fault tolerance.

Note: The actual number of device nodes supported varies according to the device types
discovered.

Minimum and maximum Data Center Expert virtual appliance configurations

For information about supported configurations equivalent to Data Center Expert Basic,
Standard, and Enterprise servers, see the DCE sizing guide .

Note: The actual number of device nodes supported varies according to the device types
discovered.

Note: VMware supports fault tolerance on virtual machines with 1 CPU only. Please refer
to your vendor's documentation for more information about fault tolerance.

Data Center Expert server equivalent configurations

The Data Center Expert virtual appliance equivalent configurations are based on Data
Center Expert Basic, Standard, and Enterprise server hardware configurations in the DCE
sizing guide .

Hardware Server Virtual Appliance Equivalent

Data Center Expert Basic Up to 500 device nodes supported
4 GB RAM

4 CPU

Data Center Expert Standard Up to 2000 device nodes supported
8 GB RAM

8 CPU

Data Center Expert Enterprise Up to 4000 device nodes supported
16 GB RAM

16 CPU
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Server Administration Settings (System menu)

This menu option accesses "Server Administration Settings" display options used to access
settings that directly affect the operation of your Data Center Expert server.

E-mail Settings option

Use this option's elements to enable your Data Center Expert server to send e-mail
notifications.

This option has two tabs (one for the Primary SMTP server, one for the Backup), each
with the same elements, as well as the From address field definition used for Data Center
Expert server e-mail notifications.

These settings are used by the Data Center Expert server to send e-mail alarm notifications
for monitored SNMP and Modbus devices, and for e-mail messages related to Data Center
Expert server functions, such as storage disk status and repository purge messages.

E-mail notifications for Data Center Expert server system events are sent in batches every
two minutes. These notifications repeat every five minutes, then every ten minutes, then
every hour until the event clears. No notification is sent when the event clears.

Note: Up to a two-minute delay in sending a notification is possible, depending upon when
the event occurred, or when the notification should repeat, in relation to the interval at which
email notifications are sent.

Element Description

"From" address Define the address that will identify that the e-
mails are sent by the Data Center Expert server.

SMTP Server Identify the hostname or IP address of the Simple
Mail Transport Protocol (SMTP) server to be
used by the Data Center Expert server.

Port Identifies the number of the port at the SMTP
server used for communication with the Data
Center Expert server.

Secure SMTP (Requires STARTTLS Select to use the Secure SMTP protocol for
extension) communication between the Data Center
Expert and SMTP servers.

Requires Logon Select to define the Username and

Password, the Data Center Expert server must
use to log on at the SMTP server.

Note: Enable this option only when using an
SMTP server that requires logon access.

"Server SSL Certificates” display
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Use this display to manage the SSL certificates on the Data Center Expert server used
for secure communication with an SMTP server, Active Directory or OpenLDAP server, or
a NetBotz Appliance.

For information about discovering NetBotz 750 Appliances, see NetBotz 750 Appliance
discovery .

You access this display from the Server SSL Certificates option in Server
Administration Settings, a System menu option.

When you select NetBotz Appliance in the device discovery process, and select the
security mode Require SSL, validate certificates option, use this display to add the
certificate from the NetBotz Appliance you want to discover to the Data Center Expert
server first. Otherwise, device discovery will not complete successfully.

Adding and removing server SSL certificates does not require the Data Center Expert
server to reboot.

Element Description

List Subject: The name of the certificate.

Issued to (Organization): The name of the
organization to which the certificate was
issued.

Issued by (Organization): The name of the
organization that issued the certificate.

Issued on: The date the certificate was
issued.

Expires on: The date the certificate expires.

Add Accesses the display used to import a certificate
from afile, or paste a certificate into the text field.

Remove Remove the selected certificate from the Data
Center Expert server.

View View details of the selected certificate.

License Keys option

Use this option's elements to enter the license keys for the Data Center Expert Device
Packs that identify how many devices the server can monitor, and for any applications that
need access to information about those monitored devices, at the server.

The MODBUS TCP Output Module and the Surveillance feature are examples of
applications that need to have license keys entered at the Data Center Expert server.

Supported number of nodes

« AP9465 - DCE Basic server, supports up to 525 nodes
« AP9470 - DCE Standard server, supports up to 2025 nodes
« AP9475 - DCE Enterprise server, supports up to 4025 nodes

For details about sizing your DCE server or VM, see the DCE sizing guide .
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Element Description

List Identifies the license keys by License Type, the
number of devices each license enables the
server to monitor ( Node Count), and how many
of those devices are being monitored ( Used
Node Count).

Add License Key Click to add a license key to the list.

License Key Details Click to view information about the selected
license key, and copy it into a document.

"License Key Details" display

Use this display to view information about the selected license key, and copy it into a

document.
Type Description

License Type Identifies the selected license by type.

Node Count The number of devices the license enables the
server to monitor.

Used Node Count The number of monitored devices using the
license.

Installed On The date the license was installed on the server.

Expires On The date the license will expire, if any.

Expired Whether or not the license has expired.

License Key The unique key associated with the license.

Map Settings

Configure whether devices and sensors are automatically placed on maps. The Data Center
Expert client must be restarted after disabling or re-enabling maps.

Element Description

Normal Devices and sensors are automatically placed on
maps when devices are added to device groups,
the default. All map features are available.

Automatic placement disabled Maps must be manually edited to place devices
and sensors on maps. All other map features are
available.

Maps disabled Map view is not displayed in the Data Center

Expert client. Any maps that were associated
with device groups will not be updated.

Network Settings option
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Use this option's elements to define the settings the server uses to communicate on its
public and private local area networks (LANS), as well as settings used while discovering
devices on the private LAN. The Data Center Expert server is not a multi-homed server.

Note: To apply changes in the Public LAN1 or Private LAN2 tabs, you must click OK
when asked if you want to restart the server. You can log on after the server finishes
rebooting, which can take a few minutes.

Public (LAN1) tab

Use this tab to define the settings the Data Center Expert server will use to communicate
on the public LAN, the port for which is labeled 1 on the Data Center Expert server.

Note: Changes are applied only in response to a Data Center Expert server reboot.

Element Description

Hostname Identify the Data Center Expert server's
hostname.

IP Address Identify the public network address of the server.

Subnet Identify the TCP/IP subnet address for the
server's local network segment.

Gateway Identify the IP address of the gateway.

Domain Identify the name of the network domain on which

the server resides.

Primary DNS Identify the IP address of the primary Domain
Name Service (DNS) server used to map IP
addresses to domain names.

Secondary DNS Identify the IP address of the DNS server used
when the primary DNS server is busy or off-line.

Tertiary DNS Identify the IP address of the DNS server used
when the primary and secondary DNS servers
are busy or off-line.

Private (LAN2) Network A tab

Use this tab to define the settings the Data Center Expert server will use to communicate
on the private LAN, the port for which is labeled 2 on the Data Center Expert server.

Note: Changes are applied only in response to a Data Center Expert server reboot.

When Reset APC Devices is selected on the DHCP Discovery tab, only the devices on
Network A, defined by the Data Center Expert server IP address and subnet mask, will be
reset.

The Data Center Expert server is not a multihomed server. The private LAN (LAN2) is a

private network used to communicate with devices monitored by the Data Center Expert
server only. Integration with other network configurations, such as routing to a public LAN
or redundant links, is not supported.

Element Description

25



EcoStruxure IT Data Center Expert 8.1.0

IP Address Identify the private network address of the Data
Center Expert server.
Subnet Mask Identify the TCP/IP subnet address for the local

network segment.

Note: When Enable Private DHCP LAN is
selected, the Subnet Mask selection defines
this address; otherwise, type in the subnet
mask's IP address.

Enable DHCP on Network A Select to use the Data Center Expert server as
a Dynamic Host Configuration Protocol (DHCP)
server for the devices on the private LAN,
Network A, enabled by default.

Starting and Ending IP Address Define the range of IP addresses available to the
DHCP LAN.

The first two parts of the four-part IP
addresses are defined by the IP Address
value, while the last two parts are initially
defined by the Subnet Mask selection.

Note: You can edit the last 2 IP address values,
except you cannot increase the Ending IP
Address value: Total available addresses
changes to Invalid IP range if you do.

Subnet Mask A list of subnet mask addresses, each providing
a different Starting and Ending IP Address
range.

Total Available Addresses Identifies how many addresses are available,

based on the Starting and Ending IP
Address range.

Apply server time zone offset on Private LAN| Check-mark to assign the Data Center Expert
server's time zone offset to the devices on the
private LAN.

Private (LAN2) Network B tab

Use this tab to define the settings the Data Center Expert server will use to communicate
on the private LAN, the port for which is labeled 2 onthe Data Center Expert server. Devices
with static IP addresses can be discovered on Network B on the private LAN.

Note: Changes are applied only in response to a Data Center Expert server reboot.

When Reset APC Devices is selected on the DHCP Discovery tab, devices on private
LAN Network B, defined by its IP address and subnet mask, will not be reset.

The Data Center Expert server is not a multihomed server. The private LAN (LAN2) is a

private network used to communicate with devices monitored by the Data Center Expert
server only. Integration with other network configurations, such as routing to a public LAN
or redundant links, is not supported.

Element Description

Enable Network B on Private LAN Select to use Network B on the Data Center
Expert server private LAN for devices with static
IP addresses.
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IP Address Identify the private network address of the Data
Center Expert server private LAN Network B,
192.168.16.1 by default.

Subnet Mask Identify the TCP/IP subnet address for the private
LAN network B segment, 255.255.255.0 by
default; otherwise, type in the subnet mask's IP
address.

Private (LAN2) DHCP Discovery tab

Use this tab to define settings the Data Center Expert server will use when discovering
SNMPvV1 devices, or devices that use the APC DCall protocol, on its private Dynamic Host
Configuration Protocol (DHCP) LAN, Network A.

Note: Changes are applied without a Data Center Expert server reboot.

Element Description

Private Discovery Settings Enable Private DHCP Discovery: select to
enable the Data Center Expert server to
automatically discover any SNMPv1 devices, or
devices that use the APC DCall protocol, on the
private network. All other private network devices
can be discovered by a device discovery process
that searches the private network's IP addresses.

Read Community Name: define the name
to be used to discover SNMPv1 devices
( public is the default).

Trap Registration On Discovery, Register for Priority Scanning
(SNMP Trap Directed Polling): select to register
the Data Center Expert server as a trap receiver
at a selected APC SNMPV1 device. This allows
for faster reporting of errors at that device by the
server: as a trap receiver, the server will poll the
device as soon as it receives an SNMPv1 trap
from that device; as a non-trap receiver, the
server reports device alarms during normal scan
intervals only.

Note: Only APC SNMPv1 devices discovered
after this option is selected have the Data Center
Expert server registered as a trap receiver.

Write Community Name: define the name
that can be used to register the Data Center
Expert server as a trap receiver at
discovered APC SNMPv1 devices

( private is the default).

Reset APC Devices Click to reset private LAN APC devices, on
Network A only, to use new IP addresses.
Note: The Write Community Name is used to
reset the APC devices.
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Server Access option

Use this option's elements to enable, disable, and configure the security policy and settings
associated with the different network-accessible processes that run on your Data Center
Expert server: web server, SSH daemon, SNMP daemon, and SOCKS proxy.

Web Server tab

Use the Ports section of this tab to enable or disable HTTP web communication and identify
the IP port the Data Center Expert server uses for HTTP and HTTPS communication. Use
the SSL Certificate section to change the current Secure Socket Layer (SSL) certificate
used for HTTPS communication.

HTTP and HTTPS settings

Note: Enabling and disabling HTTP access or changing the HTTP or HTTPS ports used
can prevent devices from providing data to your Data Center Expert server.

Option Description

Enable HTTP Port Select to enable the Data Center Expert server
to use HTTP, a non-secure Internet protocol, for
web communication at the defined IP port. HTTP
is disabled by default.

Enable HTTPS Port The Data Center Expert server always uses
HTTPS, a secure Internet protocol, for web
communication. You can specify the IP port, 443
by default.

Enable HTTP Strict Transport Security Allow the Data Center Expert server to add an
HTTP Strict Transport Security (HSTS) entry to
HTTP response headers. This automatically
redirects HTTP connections to HTTPS.

If you select HTTP, it is recommended that
you enable HSTS unless it prevents older
NetBotz Appliances from posting
successfully.

Learn more about HSTS

Note: IP ports 1 - 65535 are valid, with the exception of ports 20, 21, 22, 23, 25, 123, 161,
162, and 389. These are ports reserved for use by NetBotz Appliances and by well-known
protocols. Using these reserved ports creates a conflict that can result in operational
difficulties.

SSL Certificate

Provides information about the current SSL certificate and allows you to change the
certificate.

The Data Center Expert server generates a default, self-signed SSL certificate that can be
used for secure HTTPS web communication.
* Change Certificate: Accesses the "Change Server SSL Certificate" wizard to create
or add a new certificate. You also can create a certificate signing request to send to
a certificate signing authority.
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Changing the SSL certificate

You can use the "Change Server SSL Certificate" wizard to create or add a new certificate.
You also can create a certificate signing request to send to a certificate signing authority.

Creating a new self-signed certificate:

1.

2.

3.

In the Web Server tab for the "Server Administration Settings" display's Server
Access option, click Change Certificate.

In the "Choose Certificate Action" display, select Create New Self-Signed
Certificate and click Next.

In the "Specify Certificate Parameters" display, edit the parameters, as needed, and
click Next.

Note: Country is limited to two alphabetical characters.
In the "Update Certificate" display, click Finish to overwrite the default SSL certificate
with a new, self-signed SSL certificate created by the Data Center Expert server.

Note: You can log on to the server again after it finishes rebooting.

Creating a certificate signing request (CSR):

Use this procedure to create a certificate signing request to send to a certificate signing
authority.

1.

2.

In the Web Server tab for the "Server Administration Settings"” display's Server
Access option, click Change Certificate.

In the "Choose Certificate Action" display, select Create Certificate Signing
Request (CSR) and click Next.

In the "Specify Certificate Parameters" display, edit the parameters, as needed, and
click Next.

Note: Country is limited to two alphabetical characters.
In the "Copy Certificate Signing Request” display, copy the provided CSR text to a
text file.

Note: You can manually select the text and use Ct r | +C, or right-click anywhere in
the text to use the Select All and Copy options, to copy the CSR text.

Submit the CSR to the appropriate 3rd-party certificate authority for signing.

Use the Add Certificate option in the "Choose Certificate Action” display to add the
newly signed certificate at the Data Center Expert server.

Adding a new signed certificate:

Use this procedure to import a 3rd-party signed SSL certificate.

1.

2.
3.

In the Web Server tab for the "Server Administration Settings" display's Server
Access option, click Change Certificate.

In the "Choose Certificate Action" display, select Add Certificate and click Next.

In the "Add Certificate" display, use Ctrl +V to paste a copy of the certificate in the
text box, or click Import Certificate to import the certificate from its text file, and
click Next.

In the "Update Certificate" display, click Finish to overwrite the current SSL certificate
with the new SSL certificate.

Note: You can log on to the server again after it finishes rebooting.
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"Change Server SSL Certificate" wizard

Use this wizard's displays to create self-signed certificates, add signed Secure Socket Layer
(SSL) certificates thatthe Data Center Expert server can use for secure, SSL-based HTTPS
web communication, and to create a certificate signing request to send to a certificate
signing authority.

"Choose Certificate Action” display:

Use this display to choose the action you want to perform using the "Modify Server SSL
Certificate" wizard.

* Create New Self-Signed Certificate: replace the default SSL certificate with a new
signed certificate generated by the Data Center Expert server.

» Create Certificate Signing Request (CSR): use a CSR to access a copy of a new
signed certificate to be imported using the Add Certificate option.

* Add Certificate: replace the current SSL certificate with the SSL certificate acquired
using the Create Certificate Signing Request (CSR) option.

"Specify Certificate Parameters" display:

Use this display to edit the certificate parameters when creating a self-signed certificate

( Create New Self-Signed Certificate selected in the "Choose Certificate Action" display)
or when creating a certificate signing request (CSR) ( Create Certificate Signing Request
(CSR) selected in the "Choose Certificate Action" display).

Edit the parameters, as needed.
Note: Country is limited to two alphabetical characters.
"Copy Certificate Signing Request" display:

Use this display to copy ( C r | +C) the provided CSR text to a text file you use to submit
the CSR to a 3rd-party certificate authority for signing.

Note: The resulting SSL certificate can be imported to the Data Center Expert server using
the Add Certificate option in the "Choose Certificate Action" display.
"Add Certificate" display:

Use this display either to paste a copy ( Ct r | +V) of a signed SSL certificate or to import
an SSL certificate using the Import Certificate button.

"Update Certificate" display:

Use this display to overwrite the current SSL certificate with a self-signed certificate that
was created by the Data Center Expert server ( Create New Self-Signed Certificate
selected in the "Choose Certificate Action" display) or with a 3rd-party certificate that is
imported to the server ( Add Certificate selected in the "Choose Certificate Action" display).

Note: When you click Finish, you can log on to the server again after it finishes rebooting.

SSH Server tab
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Secure Shell (SSH), a program that provides strong authentication and secure
communications over insecure channels, is used to log on at a Data Center Expert server
on the network,from a command line to execute commands at that server.

Note: SSH is primarily intended for use with technical support guidance in troubleshooting
device issues.

Option Description

SSH is currently running Enabled by default. Allows SSH access to the
Data Center Expert server. Disabling SSH will
cause the SSH daemon to be terminated. No new
SSH sessions will be allowed. Existing SSH
sessions will not be affected.

SSH starts at boot time Enabled by default. Starts SSH whenever the
server is turned on or rebooted.

SNMP Server tab

Use this tab to enable or disable the use of an SNMP agent at your Data Center Expert
server, to define the community names and port setting used for SNMP access to monitored
devices, and to identify the contact and location information for the server.

Element Description

Enable SNMP Agent Select to enable the SNMP agent settings.

Read-only Community Name Define the community name used for read-only
SNMP requests.

Read/Write Community Name Define the community name used for read and
write SNMP requests.

Port Identify the number of the port used for SNMP
agent communication.

System Contact Identify the contact person for the Data Center
Expert server.

System Location Identify the location of the Data Center Expert
server.

SOCKS Proxy tab

Use this tab to enable or disable the Data Center Expert server's built-in SOCKS v5 proxy
server. This proxy server, which uses port 1080, allows users with proxy access to access
devices that reside on the private DHCP LAN, by accessing the Data Center Expert server
from the public LAN.

Security Policy tab
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Configure the system-wide cryptographic policy used by the Data Center Expert server.
Crypto policies are a system component that configure the core cryptographic subsystem
security policies instead of using individual configurations.

Select one of the cryptographic policies the Data Center Expert server supports:

» Future: Most restrictive to withstand near-term future attacks

» Default: Secure settings for current threat models

* Legacy policy: Least restrictive for maximum compatibility

* DCE: Custom policy, less restrictive than Default and more restrictive than Legacy

These policies are applied consistently to running services and are kept up to date as part
of Data Center Expert software updates.

When a new policy is set, the web server and SSH server on the DCE server will restart.

The DCE policy is selected by default. The DCE policy is similar to the Legacy policy except
that the DCE policy does not allow any RC4 or 3DES based ciphers.

See the documentation for security policy definitions from Red Hat here .

Server Backup/Restore option

Use this option's elements to automatically, on a scheduled basis, or manually create
backup files for your Data Center Expert server's configuration data, or its configuration
and repository data, and to use a backup file to manually restore the server data, if needed.

The backup is delivered as a single file with a .dce file extension for easier filename filtering.

Note: If a server backup fails, an email is sent to the Data Center Expert
Administrator users that include an email address as part of their user credentials.

Element Description

List Lists the backup entries by Destination
Server and provides information about each
entry.

Backup Type: what data will be saved in
backup files:

* Full: all server data (configuration and
repository) will be saved in every
backup file.

» Synchronized: only changes to
server data (configuration and
repository) will be saved after the initial
backup file.

» Configuration: only server
configuration data will be saved in
every backup file.

Schedule Enabled: whether or not backup
scheduling is enabled.

Scheduled Days/Time: when automatic
backups will occur.
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Current Status: Whether or not a backup is

in progress.

Backup Details Provides information about the backup entry
selected in the list.

Backup Progress Provides information about ongoing backup
activity.

Add Backup Click to add a backup entry to the list.

Edit Backup Click to edit the backup entry selected in the list.

Remove Backup Click to remove the backup entry selected in the
list.

Start Backup Click to manually start a backup using the entry

selected in the list.

Stop Backup Click to stop a manually-started backup.

Note: An backup-cancelled email will be sent to
the Data Center Expert Administrators that
include an e-mail address as part of their user
credentials.

Restore from Backup Click to use the "Restore from Backup" wizard to
select a backup file to be used to restore the Data
Center Expert server.

Managing the backup entries

At least one backup entry should be defined and used to create scheduled backup files for
the configuration data on the Data Center Expert server, or its configuration and repository
data.

Note: To delete a backup entry, select it in the list and click Remove Backup.
1. Select Server Administration Settings in the System menu.
2. In the "Server Administration Settings" display, select Server Backup/Restore.
3. Select to edit or add a backup entry.
* To edit a backup entry, select the listed entry and click Edit Backup.
* To add a backup entry, click Add Backup and select Windows Repository
or NFS in the "Choose Remote Mount Type" display.
4. In the appropriate settings display, do the following:

a. Configure the Windows Share ("Windows Backup Share Settings" display) or
NFS Share ("NFS Backup Share Settings" display) settings.

b. Select whether you want to backup all server configuration and repository data
for each backup ( Full), just the changes to the server configuration and
repository data for each backup ( Synchronized), or just the configuration data
( Configuration).

c. Click Test Mount.

Note: An error message will occur if the share settings are defined incorrectly.
d. Click Next to edit the schedule used to automatically backup the server data,
or Finish.

Note: The default schedule settings will cause a backup to occur every Friday
at 1:00 AM.
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5. In the "Backup Schedule" display, select the days on which a backup will occur, and

the time it will occur on those days.

"Choose Remote Mount Type" display

Use this display to select Windows Share or NFS as the remote mount type for the saved

backup file.

"Windows Backup Share Settings™ display

Use this display to add or edit the settings for a Windows share used to backup the Data
Center Expert server's configuration data, or its configuration and repository data.

The backup is delivered as a single file with a .dce file extension for easier filename filtering.

Element

Description

Server Hostname or IP

Identity the hostname or IP address of the
Windows share server.

Username Identify the username required to access the
server.
Password Identify the password required to access the

server.

Verify Password

Retype the password.

Domain Identify the domain to which the Windows share
is connected.
Share Identify the name of the Windows share.

Subdirectory

Identify the subdirectory in the Windows share
that will be used to store data.

Note: If no subdirectory is specified, data will be
stored in the share's root directory.

Security

Specify the NT LAN Manager authentication
level: NTLM, NTMLi, NTLMv2, NTLMv2;i,
NTLMSSP, or NTLMSSPi.

Backup Type

Select the type of backup that will be performed.

Full: each backup file will contain all server
configuration and repository data.

Synchronization: the first backup file will
contain all server configuration and repository
data, while subsequent files will contain only new
or changed data.

Configuration: each backup file will contain
all server configuration data, but no
repository data.

Test Mount

Click to test the Windows share settings.

"NFS Backup Share Settings" display

Use this display to add or edit the settings for a NFS share used to backup the Data Center
Expert server's configuration data, or its configuration and repository data.
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Element

Description

Server Hostname or IP

Identity the hostname or IP address of the NFS
share server.

Share

Identify the name of the NFS share.

Subdirectory

Identify the subdirectory in the NFS share that will
be used to store data.

Note: If no subdirectory is specified, data will be
stored in the share's root directory.

Protocol

Select the transport protocol: UDP or TCP.

Version

Select the NFS version: v2.0, v3.0, v4.0, or v4.1.

Backup Type

Select the type of backup that will be performed.

Full: each backup file will contain all server
configuration and repository data.

Synchronization: the first backup file will
contain all server configuration and repository
data, while subsequent files will contain only new
or changed data.

Configuration: each backup file will contain
all server configuration data, but no
repository data.

Test Mount

Click to test the NFS share settings.

"Backup Schedule” display

Use this display to schedule when the Data Center Expert server's configuration data, or
its configuration and repository data, will be backed up automatically.

Element

Description

Schedule Enabled

Select to have the Data Center Expert server
data backed up automatically as defined by the
Days and Time settings.

Days

Select the day, or days, the backups will occur.

Time

Select the time of day the backups will occur.

Using the "Restore from Backup' wizard

Use this wizard to select the backup file, whether at an existing or new location, you want
to use to restore the Data Center Expert server configuration, or configuration and

repository, data.

n e

Select Server Administration Settings in the System menu.
In the "Server Administration Settings" display, select Server Backup/Restore.

3. Click Restore from Backup, and use the "Choose Backup Location Type" display to
select whether you want to navigate to a backup file at an existing or new location.
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Navigating to a backup file at an existing location

You can use the "Restore from Backup" wizard to select a backup file at the NFS or Windows
share at which the Data Center Expert server saved that file.

In the "Choose Backup Location Type" display, select Existing Backup Location.
In the "Existing Backup Location" display, select the listed location.

In the "Restore from Backup" display, select the listed backup file, and click Finish.
Click OK when asked if you want to use the data from a previous date to restore your
server.

PR

Note: The server will restart as a result of the restore process. You can log on after
the server finishes rebooting, which can take a few minutes.

Navigating to a backup file at a new location

You can use the "Restore from Backup" wizard to select a backup file at the NFS or Windows
share at which the Data Center Expert server did not save that file.

1. In the "Choose Backup Location Type" display, select New Backup Location and
either Windows Share or NFS.

2. In the appropriate display, identify the Windows Share ("New Windows Backup
Location" display) or NFS Share ("New NFS Backup Location" display) location of
the backup file.

3. In the "Restore from Backup" display, select the listed backup file, and click Finish.

4. Click OK when asked if you want to use the data from a previous date to restore your
server.

Note: The server will restart as a result of the restore process. You can log on after
the server finishes rebooting, which can take a few minutes.

"Restore from Backup" wizard

Use this wizard to restore your Data Center Expert server using a backup file at an existing
or new share location.

"Choose Backup Location Type" display

Use this display to choose the location of the backup file you want to use to restore the
Data Center Expert server's configuration data, or its configuration and repository data.

Option Description

Existing Backup Location Select to locate a backup file at a location that
has been used to save your Data Center
Expert server data.

New Backup Location Select to locate a backup file from an archived
location, a location where the current backup files
are not being saved.

"Existing Backup Location™ display
Use this display to select the location of the backup file from the list.
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"Restore from Backup" display

Use this display to select the listed backup file you want to use to restore the Data Center

Expert server.

Note: The Backup Source column identifies which server was the source of the backup

file.

"New Windows Backup Location" display

Use this display to identify the Windows share location for the backup file you want to use

to restore your Data Center Expert server.

The backup is delivered as a single file with a .dce file extension for easier filename filtering.

Element

Description

Server Hostname or IP

Identity the hostname or IP address of the
Windows share server.

Username Identify the username required to access the
server.
Password Identify the password required to access the

server.

Verify Password

Retype the password.

Domain Identify the domain to which the server is
connected.
Share Identify the name of the Windows share that

contains the backup file.

Subdirectory

Identify the subdirectory in the Windows share
that contains the backup file.

Note: If no subdirectory is specified, the backup
file is stored in the share's root directory.

Security Specify the NT LAN Manager authentication
level: NTLM, NTMLi, NTLMv2, NTLMv2i,
NTLMSSP, or NTLMSSPi.

Backup Type Specify the backup type: Full, Syncronized, or

Configuration.

"New NFS Backup Location" display

Use this display to identify the NFS share location for the backup file you want to use to

restore your Data Center Expert server.

Element

Description

Server Hostname or IP

Identity the hostname or IP address of the NFS
share server.

Share

Identify the name of the NFS share.

Subdirectory

Identify the subdirectory in the NFS share that will
be used to store data.

Note: If no subdirectory is specified, data will be
stored in the share's root directory.
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Protocol Select the transport protocol: UDP or TCP.

Version Select the NFS version: v2.0, v3.0, v4.0, or v4.1.

Backup Type Specify the backup type: Full, Syncronized, or
Configuration.

Server Proxy Settings option

Use this option's elements to define the settings the Data Center Expert server must use
to communicate through a proxy server.

Note: A Data Center Expert server needs to use the internet to communicate with APC to
download firmware updates, for example.

Element Description
Use Proxy Select to enable the proxy settings.
Proxy Hostname/IP Identify the hostname or IP address of the proxy
server.
Port Identify the port at the proxy server that the Data

Center Expert server will use to communicate
with that server.

Username Identify the username to be used to access the
proxy server.

Password Identify the password to be used to access the
proxy server.

Test Proxy Click to make sure the Data Center Expert server
can access the identified proxy server using the
proxy settings you define.

Do not use proxy server for the following Lists the internet addresses you want the Data
addresses Center Expert server to be able to communicate
with directly, without using the proxy server.
Add Click to add the IP address of a host to the list.
Remove Click to remove a selected host from the list.

Storage Settings option

Use this option's elements to identify the Repositories the Data Center Expert server can
use, to define the Purge Settings for the data stored in the repositories, and when the
server connects to an Enterprise Server, to review the Disk Array Status for that server.

Note: If your organization uses multiple Data Center Expert servers, and Windows or NFS
repository servers for remote storage, each Data Center Expert server should use its
repository server: multiple Data Center Expert servers should not store data on the same
remote repository.

Repositories tab
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Use this tab to manage the repositories the Data Center Expert server can use, and review
information about a selected repository.

Element Description

List Lists the local and remote repositories, and
identifies each repository's Status, Type,
Maximum Capacity, and Conditions.

Details Identifies the Type, Status, and Condition for
the selected repository.

Usage Provides information about the current usage for
the selected repository, as well as detail about
the Type of data that can be stored, as well as
the allotted capacity ( Size) and current usage

( Percentage) for each Type.

Status Message Provides status information when something
occurred at the server for the selected repository,
such as the server went offline, or the an
authentication ( Username or Password) value
changed for a Windows repository.

Note: This Status Message appears only when
status at the selected repository's server has
changed. If the problem persists, contact the
Administrator for the affected repository server.

Use Remote Storage Only Select to have the Data Center Expert server
limited to using a remote repository, only
(disabled when no remote repository is
available).

Note: If the remote is offline, the server will store
data in the local repository until the remote
becomes available.

Migrate to Remote Click to migrate the server configuration and
repository data currently stored in the local
repository to the remote storage repositories.
Note: Disabled when no remote repository is

available.
Add Repository Click to add a remote repository.
Edit Repository Click to edit a selected remote repository.
Remove Repository Click to remove a selected remote repository
from the list.

Managing the remote repositories

At least one remote repository should be defined and used by the Data Center Expert
server, rather than the local repository.

Note: If your organization uses multiple Data Center Expert servers, and Windows or NFS
repository servers for remote storage, each Data Center Expert server should use its
repository server: multiple Data Center Expert servers should not store data on the same
remote repository.

You can add, edit, or delete any remote repository, but not the local repository.

Note: To delete a repository, select it in the Repositories tab, and click Delete
Repository.
1. Select Server Administration Settings in the System menu.
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2. In the "Server Administration Settings" display, select Storage Settings.
3. Inthe Repositories tab, select to edit or add a repository.
* To edit a repository, select the listed repository and click Edit Repository.
* To add a repository, click Add Repository and select Windows Repository
or NFS Repository in the "Choose Repository Type" display.
4. In the appropriate settings display, do the following:
a. Configure the Windows Share ("Windows Repository Settings" display) or NFS
Share ("NFS Repository Settings" display) settings.
b. Click Test Repository Settings.

Note: An error message identifies why the test failed, if the share settings are
defined incorrectly.
c. Configure the File System settings, and click Finish.
5. Use the Purge Settings tab to define when data will be purged from all online
repositories that are not in an error or read-only state.

"Choose Repository Type" display:

Use this display to select whether you want to add a Windows Repository or NFS
Repository.

"Windows Repository Settings" display:
Use this display to add or edit the settings for a Windows repository.

This display has two sections and a Test Repository Settings button. This button must
be used to test the Windows Share settings when adding a repository, or when changing
more than the Repository Name during an edit of a repository.

You will be unable to add or edit the File System settings until the test is successful.

Note: The Data Center Expert server will generate an error message that identifies why
a test failed. If the problem persists, contact the Administrator for the repository server you
are trying to use.

Windows Share section:

Configure the settings that identify where the Windows repository will reside, and the
username and password needed to access the repository.

Element Description

Repository Name Identify a name for the repository.

Server Hostname or IP Identity the hostname or IP address of the
Windows share server.

Username Identify the username required to access the
Windows share.

Password Identify the password required to access the
Windows share.

Verify Password Retype the password.

Domain Identify the domain to which the Windows share

is connected.

Share Identify the name of the Windows share.
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Subdirectory Identify the subdirectory in the Windows share
that will be used to store data.

Note: If no subdirectory is specified, data will be
stored in the root directory of the share.

Security Specify the NT LAN Manager authentication
level: NTLM, NTMLi, NTLMv2, NTLMv2i,
NTLMSSP, or NTLMSSPI.

Backup Type Select the type of backup that will be performed.

Full: each backup file will contain all server
configuration and repository data.

Synchronization: the first backup file will
contain all server configuration and repository
data, while subsequent files will contain only new
or changed data.

Configuration: each backup file will contain
all server configuration data, but no
repository data.

File System section:

Select whether the repository's file system is enabled, and, when enabled, whether it is
read-only, and its maximum capacity.

Element Description
Enabled Select to enable the repository.
Read-only Select if you want to allow only read access to

the repository.

Free Space Identifies how much free space is available for
the repository.

Maximum Capacity Identify the maximum capacity of the repository,
based on the available Free Space. For
example, if there is 79.85 gigabytes (GB)
available, type in a number that is equal to, or
less than 79.85, and select GB from the drop-
down menu.

"NFS Repository Settings" display:
Use this display to add or edit the settings for an NFS repository.

This display has two sections and a Test Repository Settings button. This button must
be used to test the NFS Share settings when adding a repository, or when changing more
than the Repository Name during an edit of a repository.

You will be unable to add or edit the File System settings until the test is successful.

Note: The Data Center Expert server will generate an error message that identifies why
a test failed. If the problem persists, contact the Administrator for the repository server you
are trying to use.
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NFS Share section:

Configure the settings that identify where the NFS repository will reside.

The backup is delivered as a single file with a .dce file extension for easier filename filtering.

Element Description
Repository Name Identify a name for the repository.
Server Hostname or IP Identity the hostname or IP address of the NFS
share server.
Share Identify the name of the NFS share.
Subdirectory Identify the subdirectory in the NFS share that will

be used to store data.
Note: If no subdirectory is specified, data will be
stored in the root directory of the share.

Protocol Select the transport protocol: UDP or TCP.

Version Select the NFS version: v2.0, v3.0, v4.0, or v4.1.

File System section:

Select whether the repository's file system is enabled, and, when enabled, whether it is
read-only, and its maximum capacity.

Element Description
Enabled Select to enable the repository.
Read-only Select if you want to allow only read access to

the repository.

Free Space Identifies how much free space is available for
the repository.

Maximum Capacity Identify the maximum capacity of the repository,
based on the available Free Space. For
example, if there is 79.85 gigabytes (GB)
available, type in a number that is equal to, or
less than 79.85, and select GB from the drop-
down menu.

Purge Settings tab

Use this tab to define settings that affect automatic purges, or to manually purge the
repositories.

Note: You can choose to include the repository data in the backup files created using

Server Backup/Restore, a Server Administration Settings option in the System menu.
The Total Repository Usage section identifies allotted capacity ( Size) and current usage
(Percentage) for each Type of data stored in all repositories, unless Use Remote Storage
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Only is selected in the Repositories tab. In that case, identifies capacity and usage for all
remote repositories, only.

Note: If an error condition occurs at a repository, an e-mail is sent to the Data Center
Expert Administrators that include an e-mail address as part of their user credentials.
Automatic Purge Settings

Use this section to define the settings for the conditions that will cause an automatic purge
of the repositories.

Type Description

Begin Purge Identify the percentage of total capacity that will
initiate a purge.

End Purge Identify the percentage of total capacity that will
cause the purge to end.

Warn of Purge Identify the percentage of total capacity that will
result in a warning that a purge may occur soon.

Send Warning E-mails Select to send e-mails to the Data Center
Expert Administrators that include an e-mail
address as part of their user credentials, when
the Warn of Purge threshold is reached.

Apply Purge Settings Click to save changes to the settings.

Manual Purge

Use this section to perform a manual purge of the repositories.

Type Description

Purge Data Created On or Before Select the date for which all data stored on or
before that date will be purged.

Choose the Types of Data to Manually Purge | Select to include Alarm History Data, Alarm
Binary Data, Sensor Data, Untagged or All
Surveillance Data, or a combination of these
choices, in the manual purge.

Note: You can prevent tagged surveillance data
from being purged by selecting Untagged
Surveillance Data instead of All Surveillance
Data.

Run Manual Purge Click to purge the selected data for the defined
range of dates.

Disk Array Status tab
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Use this tab to view Overall Status and Individual Disk Status information for the disk
array associated with an Enterprise Server.

Note: If a disk array status changes to degraded, an e-mail is sent to the Data Center
Expert Administrators that include an e-mail address as part of their user credentials.

Syslog Settings option

Configure settings to forward event log messages to an external Syslog server.

All the data in the event log messages are transmitted over Syslog, including usernames,
email addresses, and information about share locations.

Note: Syslog functionality may differ depending on the Syslog server being used.

Element Description

Enable Syslog integration Check to forward event log messages to an
external Syslog server.

Syslog server address Specify the hostname or IP address of the Syslog
server.

Port Specify the port for the Syslog server, 514 by
default.

Message format Specify the message format for the Syslog
server, RFC_3164 by default.

Facility Specify the facility for the Syslog server, AUDIT
by default.

Timeout How long the server will wait to connect to the

Syslog server, 5 seconds by default.

Maximum retries The number of times the server will attempt to
connect to the Syslog server, 2 by default.

Apply and Test Click to to apply settings to your DCE server.
Check the destination Syslog server to verify
your configuration.

Time Settings option

Use this option's elements to define the date and time for the Data Center Expert server,
or identify any NTP servers that will provide those date and time values, and specify regional
settings.

Note: The Data Center Expert server must reboot before a change to any setting can take
effect.

Date and Time elements

Element Description
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Enable Data Center Expert as NTP Server

Checkmark to select whether a Network Time
Protocol (NTP) server you specify provides the
date and time values for the Data Center
Expert server; otherwise, these values are
defined by the Date and Time elements or Use
Client Time.

Use Remote NTP Server Time

When selected, a Network Time Protocol (NTP)
server you specify provides the date and time
values for the Data Center Expert server;
otherwise, these values are defined by the
Date and Time elements or Use Client Time.

Set NTP Time Manually

When selected, the NTP time is provided by the
Date and Time elements or Use Client Time.

NTP Server1-3

Identify the IP address or hostname of at least
one NTP server, when Use Remote NTP Server
Time is selected.

Date

Define the date the server will use, when Enable
Data Center Expert as NTP Server is not
selected, or when Enable Data Center
Expert as NTP Server and Set NTP Time
Manually are selected.

Time

Define the time the server will use, when
Enable Data Center Expert as NTP Server
is not selected, or when Enable Data Center
Expert as NTP Server and Set NTP Time
Manually are selected.

Use Client Time

Click to use your client time and date settings at
the server, when Enable Data Center
Expert as NTP Server is not selected, or
when Enable Data Center Expert as NTP
Server and Set NTP Time Manually are
selected.

Calendar

Displays the current date, and can be used to
define that date, when Enable Data Center
Expert as NTP Server is not selected, or
when Enable Data Center Expert as NTP
Server and Set NTP Time Manually are
selected.

Regional Settings elements

Element

Description

Server Locale

Select the language the Data Center Expert
server will use for messages, such as e-mails. By
default, the server uses the language associated
with the Server Time Zone setting, or English
(U.S.), if the associated language is not
supported.

Note: The server's measurements (metric or US
standard) and date formats will be matched to the
formats commonly used at the selected locale.

Use 24-hour Time on Server

Selectto have the Data Center Expert server use
a 24-hour clock.
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Server Time Zone

Select the time zone in which the Data Center
Expert server is located.
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Client Preferences (File menu)

Use this option's display to define settings that apply to your Data Center Expert client only.

Advanced View Settings

Use this option to enable Launch Advanced View, a right-click option for NetBotz
Appliances in the Device View and Map View.

Note: You must browse to a local copy of Advanced View. You can download the latest
version of Advanced View from https://www.apc.com/us/en/product/SFNBZ472/netbotz-
firmware-v4-7-2-rack-monitor-570-451-wall-monitor-455-355/

Although you can use Advanced View independent of the Data Center Expert server to
access NetBotz Appliances on a public network, there is no way to access the Advanced
View interface at a NetBotz Appliance on a Data Center Expert server's private LAN except
by using Launch Advanced View. This option allows access to the Advanced View
interface at any monitored NetBotz Appliance, whether that appliance is on the Data Center
Expert server's public or private LAN.

Note: Only a Data Center Expert Administrators, or a user with the Data Center
Expert Proxy role assigned, can use the Launch Advanced View option to access the
Advanced View interface at a NetBotz Appliance on the private LAN. In addition, before a
Data Center Expert Administrator or Data Center Expert Proxy user can access any
private-side device, SOCKS Proxy, a Server Access option for Server Administration
Settings in the System menu, must be enabled.

Audio Settings

Use this option to select whether your Data Center Expert client will play a sound when
alerts occur.

Element Description

Play Sound when an Alert Occurs Select to enable your client to play the sound for
the Select Audio File selection.

Select Provided Audio File Select the sound you want your client to play from
the drop-down list of files provided for the Data
Center Expert client.

Select Custom Audio File Browse to the AIFF, AU, WAV, or MIDI formatted
audio file you want your client to play.

Test Sound Click to hear the sound for the Select Provided
Audio File or Select Custom Audio File
selection.
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Browser Settings

Use this option to select the web browser your Data Center Expert client will use to connect
to the web interface at a monitored device.

Element Description

Use the Default OS Web Browser Select to use the operating system default web
browser to open a browser window external to
the Data Center Expert client (the default).

Use an Alternate Web Browser Select to use an alternate web browser to open
a browser window external to the Data Center
Expert client.

Path Identify the location of the alternate web browser
executable file.

Browse Click to browse to the executable file for the web
browser you want to use, if necessary, to select
its Path.

Test Browser Click to verify that the selected browser can
access the APC home page.

Use the Internal Web Browser when Check-mark to use the Data Center Expert client

Launching to Devices web browser to open a browser in a view inside
the Data Center Expert client (the default
selection).

Note: Use this option, when you specify Device
Launch Settings, to automatically log in to the
web interface of devices that use basic
authentication. See "Device Launch Settings"
display under Monitored Devices.

Client Language Settings

Use this option to select the language you want your Data Center Expert client to use. The
selected language will be used for all options, displays, status messages, thresholds, and
settings, with the exception of messages, such as e-mails, sent by the Data Center
Expert server, and identification information sent by monitored devices.

The default setting is Use OS Locale, which selects to use the language associated with
your client's location, if that language is supported. Otherwise, English is the default Use
OS Locale language.

Note: Server Locale, accessed by selecting Time Settings, a Server Administration
Settings option in the System menu, allows you to select the language the Data Center
Expert server uses for its messages.

Custom Property Settings

48



EcoStruxure IT Data Center Expert 8.1.0

Use this option to select whether to show a popup option when a custom property is added,
or to automatically add a column to the Device View for a newly created custom property.

Note: The default settings allow a popup option to appear, and columns to be added to
the Device View and "View Device Sensors" display, for each new custom property key
created.

When a custom property key is created using the Manage Custom Property Keys option
in the Device menu, or the Add Custom Property option in the right-click menu of the
Custom Property Editor, Device View, or Map View, a popup option appears, by default,
to select whether to add the new custom property key to the Device View as a column.
You can uncheck the Show popup option when custom property key is added option,
check-marked by default, to disable the popup option.

Additionally, a new column can be added to the Device View when each new custom
property key is created. You can uncheck the Add a new column to the Device view for
each new custom property key created option, checkmarked by default, to prevent new
columns from being created for every new custom property key.

To add, modify, or remove custom property keys, you use the Manage Custom Property
Keys option in the Device menu.

To show columns for custom property keys in the Device View, you use the Configure
Column icon in that view.

Device View Settings

Use this option to define the maximum number of devices that can be listed in the Device
View at any one time, using the Total Devices Shown setting ( 500, by default), and to
select to have devices with active Critical, Error, and Failure alarms highlighted in red,
using the Highlight Priority Alarms setting.

Note: Only the Device View is affected by the Total Devices Shown and Highlight
Priority Alarms settings.
The Total Devices Shown setting does not limit the number of devices the Data Center
Expert server can monitor, only how many it can display in the Device View. For example,
the server monitors 1000 devices, with 600 devices evenly distributed in six different device
groups:
* When All Devices is selected, only 500 devices will appear in the Device View. You
can use the Search feature to narrow the list down to a specific set of devices.
* When Unassigned is selected, the 400 devices that are not yet assigned to any
device group will be listed in the Device View.
< When any one of the six other device groups is selected, all the devices in that group
will be listed in the Device View.
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Monitored devices

The Data Center Expert server can monitor and manage APC, MGE, Modbus TCP,
NetBotz, and third-party devices. Once these devices have been discovered, you can do
the following:

* Review sensor and devices status information about the devices in the Device
View and Map View.

* Review information about existing device alarm conditions in the Active Alarms view.

* Review information about historical device alarm conditions in the Alarm History
view.

« Launch to the remote device management applications.

< Generate reports for sensors at the devices.

» Assign devices to groups and subgroups in the Device Groups view.

» Create alert thresholds on device sensors.

Supported devices

The Data Center Expert server can monitor APC, MGE, Modbus TCP, NetBotz, and third-
party devices that it can discover on its public and private LANSs.

* NetBotz Rack or Wall Appliances (except for 300, 303, 310, 400, and 410 models).

e Modbus TCP Output devices

« First generation power distribution units (PDUs) and AP76xx outlet strips, when
discovered on the private LAN, only.

* Any APC or third-party device that can communicate with the server using SNMPv1
or SNMP v3 communication, with three levels of support provided.

Basic SNMP support | The Data Center Expert server can provide only Type ( SNMP
Device only), on-line or communication lost Status, Hosthame, and
Groups information.

Model ID SNMP The Data Center Expert server can report Model information, in
support addition to the information provided for basic SNMP support.

Full SNMP support | The Data Center Expert server can provide sensor data and alarms
information, in addition to the information provided for model ID SNMP
support.

Note: Additional sensors can be created on devices using Supplemental OIDs, an SNMP
Device Communication Settings option in the Device menu.

Device Definition File (DDF)

DDFfiles include information on which sensors the Data Center Expert can report for SNMP
and Modbus devices. The Data Center Expert server ships with the DDF files necessary
for reporting sensors on all APC devices and some Modbus and third-party devices. In
addition:

» DDF files, for third-party and Modbus devices, may be available from APC Technical
support.
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* You can use Device Definition Files, an SNMP Device Communication
Settings and Modbus Device Communications Settings option in the Device
menu, to check the APC website for new or updated DDFs, and download those files
to the Data Center Expert server.

* APC SNMP devices that use a Network Management Card (NMC) version of 3xx or
higher have a DDF file that the Data Center Expert must download at discovery time.
This DDF file contains information about the alarm conditions the device can report.

Launch to device feature

The Data Center Expert server has the ability to launch to any discovered device that
supports an HTTP/HTTPS web interface.

You can access the devices web interface by doing one of the following actions in either
the Device View or Map View:
* Double-click the device in the Device View.
» Highlight the device in the Device View, and press Enter.
* Right-click the device in either the Device View or Map View, and select Launch
to Device.

An error will occur when the HTTP/HTTPS protocol or port definitions defined for this device
at the Data Center Expert server do not match the protocol and port definitions required by
that device. To check or set the HTTP/HTTPS settings, right-click the device and select
Device Launch Settings to access the "Device Launch Settings" display.

Note: You can select multiple devices in either the Device View or Map View to use the
"Device Launch Settings" display to define identical HTTP/HTTPS protocol and port
definitions for those devices.

Launch Advanced View feature

The Data Center Expert server has the ability to connect to the Advanced View interface
at any monitored NetBotz Appliance through Launch Advanced View, a right-click option
in the Device View and Map View.

The Launch Advanced View right-click option must be enabled by Advanced View
Settings, a Client Preferences option in the File menu. In addition, if the NetBotz
Appliance is on the Data Center Expert server's private network, SOCKS Proxy, a Server
Access option for Server Administration Settings in the System menu, must be
enabled, and you must be a Data Center Expert Administrator, or a user with the Data
Center Expert Proxy role assigned.

An error will occur when the HTTP/HTTPS protocol or port definitions at the Data Center
Expert server do not match the protocol and port definitions required by the selected
NetBotz Appliance. To check or set the HTTP/HTTPS settings, right-click the device and
select Device Launch Settings to access the "Device Launch Settings" display.

Note: You can select multiple devices in either the Device View or Map View to use the
"Device Launch Settings" display to define identical HTTP/HTTPS protocol and port
definitions for those devices.

"Device Launch Settings" display
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Use this display to define how the Data Center Expert server will use an Internet browser
to communicate with the device or devices selected by Device Launch Settings, a right-
click option in the Device and Map Views.

The Data Center Expert server uses these settings to connect to the web interface at any
monitored device ( Launch to Device, a right-click option in the Device View and Map
view), and to connect to the Advanced View interface at any monitored NetBotz Appliance
( Launch Advanced View, a right-click option in the Device View and Map view).

You specify the username and password used to automatically log in to the web interfaces
of APC SNMP devices with the following Network Management Card and firmware
revisions:
« rPDU with Network Management Card firmware revision 3.7.1 and higher.
« APC SNMP devices with a Network Management Card (AP9617, AP9618, or AP9619)
with firmware revision 3.7.0 and higher.
« APC SNMP devices with a Network Management Card (AP9630, AP9631, AP9635)
with firmware revision 5.1.0 and higher.
Note: You cannot automatically login to the web interfaces of APC SNMP devices
monitored by NetBotz Appliance versions 320, 420, and 500.

When Use the Internal Web Browser when Launching to Devices is selected in the
Client Preferences option of the File menu, you can double-click the device, or select the
right-click option Launch to Device, to automatically login to the web interface of devices
that use basic authentication without being prompted for credentials.

Element Description
HTTP Click to select the HTTP protocol for browser
communication.
HTTPS Click to select the security-enhanced HTTPS

protocol for browser communication.

Port Identify the number of the port used for browser
communication at a selected device: 80 is the
default for HTTP; 443 is the default for

HTTPS.
Username Identify the username used to login to the device.
Password Identify the password used to login to the device.
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Device and Map Views

Two views provide access to information about the monitored devices, one in a table format
( Device View), and one as icons on a graphic background ( Map View), with a unique
Map View available for each group in the Device Groups view, except for Unassigned,
which uses the default Map View only.

Note: Both views are included in the Monitoring perspective, by default, and can be
accessed from the Window menu, if needed.

"View Device Sensors" display

Use this display to view sensor data on the selected device. This display can be accessed
from the Device View, Map View, Active Alarms view, or Alarm History view.

Note: The Hostname, Model, Last Contact, and Set elements are not present when
more than one device is selected in the Device View or Map View.

Element Description

Hostname Identifies the hostname or IP address of the
selected device.

Model Identifies the model of the selected device, when
known.

Last Contact Identifies when the Data Center Expert server
last scanned the device for its sensor values.

Set Select the set of logically grouped sensors you
want to view.

Note: Some devices have sensors that cannot
be logically grouped in sets; they list their
individual sensors, instead.

Search Use to search the device labels, sensors, and
sensor values, and custom property keys, if any.

List Shows the sensors and sensor values for the
selected device or devices.

Note: When multiple devices are selected,
Device Label information is included to identify
which device reports a sensor value.

This " View Device Sensors" display also has right-click options to manage the list of
sensors and sensor values.

Option Description
Edit Custom Properties Allows you to add a custom property, or modify
the value of an existing property, for the selected
sensors.
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Delete Sensors Allows you to remove a sensor with a sensor
value of unplugged. This option is available for
SNMP devices only.

Note: When you delete a sensor, all historical
data for that sensor is also deleted.

Change State To: Allows you to change the state of sensors that
report state values.

When a user has Device Group Monitoring View Access or higher, and accesses the " View
Device Sensors" display from a camera, the display has a Camera tab.

Element Description
Automatically fit to window Checkmark to fit the image to the display.
Resolution Select the resolution you want to use to display
the real-time feed for the selected camera.

"Change Device Type" display

Use this display to select the appropriate device type for a third party device with no device
type defined, or to more accurately define a monitored SNMP device, Modbus device, or
NetBotz Appliance.

The selected device type and its associated icon will be displayed in Map View and the
Type column in Device View in the Monitoring perspective, and the Navigation view in
the Alarm Configuration perspective. You can select the 'Default’ setting to change the
icon and device type back to its original type.

Device Label Settings display

Define a custom label to display in the Device View's Label column for the selected SNMP
or Modbus device. Otherwise, the default device label is displayed.

Element Description
Use default device label Checked by default. Clear the check mark to
specify a custom device label.
Custom device label Modify the label for the selected SNMP or
Modbus device.

"Custom Label Settings" display

Use this display to define a custom identifier to display for the selected device or set of
devices in a map. You must select one device at a time to also define a specific sensor
value to display instead of the sensor value you set in Map Settings.
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Note: Sensor values can be displayed for the devices managed by a NetBotz Appliance,
but not for the NetBotz Appliance itself.

Element Description

Show Identifier Check-mark to select the identifier to show for the
selected device or set of devices.

Display the value set in Map Settings Select to make sure no changes are made to the
sensor value label settings you set in the Map
Settings option for the selected device.

Choose a specific sensor value Select to choose a specific sensor value to show
for the selected device.

Note: You cannot configure the sensor value
when multiple devices are selected.

List Select the sensor you want to use from the
available sensor list.

"Device Launch Settings" display

Use this display to define how the Data Center Expert server will use an Internet browser
to communicate with the device or devices selected by Device Launch Settings, a right-
click option in the Device and Map Views.

The Data Center Expert server uses these settings to connect to the web interface at any
monitored device ( Launch to Device, a right-click option in the Device View and Map
view), and to connect to the Advanced View interface at any monitored NetBotz Appliance
( Launch Advanced View, a right-click option in the Device View and Map view).

You specify the username and password used to automatically log in to the web interfaces
of APC SNMP devices with the following Network Management Card and firmware
revisions:
« rPDU with Network Management Card firmware revision 3.7.1 and higher.
« APC SNMP devices with a Network Management Card (AP9617, AP9618, or AP9619)
with firmware revision 3.7.0 and higher.
« APC SNMP devices with a Network Management Card (AP9630, AP9631, AP9635)
with firmware revision 5.1.0 and higher.
Note: You cannot automatically login to the web interfaces of APC SNMP devices
monitored by NetBotz Appliance versions 320, 420, and 500.

When Use the Internal Web Browser when Launching to Devices is selected in the
Client Preferences option of the File menu, you can double-click the device, or select the
right-click option Launch to Device, to automatically login to the web interface of devices
that use basic authentication without being prompted for credentials.

Element Description
HTTP Click to select the HTTP protocol for browser
communication.
HTTPS Selected by default, security-enhanced HTTPS

protocol for browser communication.

Port Identify the number of the port used for browser
communication at a selected device: 80 is the
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default for HTTP; 443 is selected by default for
HTTPS.
Username Identify the username used to login to the device.
Password Identify the password used to login to the device.

"Outlet Control” display
Use this display to control the outlets on supported APC Rack PDU devices.

You must specify the write community name for the Rack PDU device at device discovery,
or in the "Edit Device Scan Settings" display, accessed from the Device Scan Settings
option of the SNMP Device Communication Settings option in the Device menu.

You can configure delay parameters for the outlets via SNMP or by logging into the device.

A "Communication Error" is displayed when the Rack PDU device does not respond to a
command for any reason, for example, when the write community name identified in the
"Device Scan Settings" display is incorrect.

User permissions defined in the "Modify Device Group Access" display, accessed from
the Users and User Groups option in the System menu, determine which users have
access to outlet control. Data Center Expert Server Administrators, Device Administrators,
and Device Viewer users with monitoring access set for Administration Access or View
and Control can access outlet control.

CAUTION: When you perform a command at an outlet that is part of an outlet group, that
command will be executed at all outlets in the group. The Data Center Expert server cannot
determine which outlets are part of an outlet group.

Element Description

List Name: Select one or more outlets to control.

Status: The status of the outlet.

Command Select the command you wish to perform at the
selected outlets.

Note: Only the commands supported by the
selected device are listed.

Refresh Status Click to update the status of the outlets.
Perform Command Click to perform the command at the outlets
selected.

"Rack Access Control" display

Use this option's configuration display to control locks on rack doors monitored by the
selected NetBotz Rack Access PX-HID, or Rack Access Pod 170 devices associated with
the selected NetBotz Appliance.

Note: You must select one NetBotz Rack Access Device or NetBotz Appliance at a time
to configure Rack Access Control.
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IMPORTANT: The Select all option in Rack Access > Control unlocks only one door on
NetBotz 250 and 750 appliances. The NetBotz 250 and 750 do not allow both doors to be
unlocked at the same time.

Element Description

List Checkmark to select one or more locks, one or
more associated Rack Access Pod 170 devices,
or the NetBotz Appliance or NetBotz Rack
Access Device.

Door State The current state of the door, Open, or Closed

Handle State The current state of the door handle, Up, or
Down

Lock State The current state of the lock, Locked, or
Unlocked

Lock/Unlock Press to lock or unlock the selected doors.

Note: The state of the door, handle, or lock is Unplugged when the Rack Access Pod 170
has been removed from the NetBotz Appliance.

You can right-click a NetBotz Rack Access Device, NetBotz Appliance, or Rack Access Pod
170 to expand or collapse the list of door locks ( Expand or Collapse option).

Device View features

This view uses a table format to provide access to information about the monitored devices.
It also is used to manage which devices are assigned to which device groups, a function
that cannot be performed in a Map View.

Note: Device View Settings, a Client Preferences option in the File menu, hasa Total
Devices Shown setting that defines the maximum number of devices that can be listed in
the Device View at any one time ( 500, by default), and a Highlight Priority Alarms
setting that selects to have devices with active Critical, Error, and Failure alarms
highlighted in red in the Device View (disabled, by default).
In addition to managing the devices in the device groups, the Device View has the following
features:
» The device list provides information about each device in the device group selected
in the Device Groups view.
* You can click the Configure Columns icon to define which columns appear in
the view.
* You can click a column title to sort the list in ascending or descending order
based on the information in that column.
* A Search field and Clear button allow you to filter the device list to display only
the devices that include your typed text.
* You can select a device, or devices, to filter the Active Alarms view to show
only the alarms for selected devices.
Note: When a NetBotz Appliance is selected, the Active Alarms view will
display its alarms, including all alarms associated with the devices it monitors.
* You can double-click a device to log on to its web interface, if it has one, or use
the right-click Launch to Device option for a device.
Note: By default, the web interface of devices requiring basic authentication is
displayed as a view using the internal web browser. You can use the Launch
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in External Browser icon in that view to log on to the web interface in an external
browser.

 Right-click options, and icon buttons at the top of the view, perform the following
functions:

Initiate a device discovery process used to add SNMP devices, Modbus devices,
or NetBotz Appliances to be monitored by the Data Center Expert server ( Add
Devices option or the green + icon).

Delete devices that you no longer want the Data Center Expert server to monitor
( Delete Devices option or the x icon).

Note: This option is disabled for a device that has a NetBotz Appliance as its
parent device.

Generate a report or graph for the historical values of the sensors at selected
devices ( Generate Sensor History Report option or Generate Custom
Sensor History Report icon).

Access the Alarm History view to review historical alarm data for any selected
devices ( Show Alarm History option).

Define the port and protocol settings, and the username and password to be
used by the Data Center Expert server to communicate with monitored devices
( Device Launch Settings option).

Note: For monitored APC SNMP and Modbus devices, the default username
and password "apc" is provided by default.

Control the outlets at a selected APC devices ( Outlet Control option).

Log on to the web interface at a selected device, if it has one ( Launch to
Device option).

Log on to the Advanced View interface at a selected NetBotz Appliance (Launch
Advanced View option).

Note: This option is enabled by Advanced View Settings, a Client
Preferences option in the File menu.

Remove selected devices from a shared device group, without causing the Data
Center Expert server to stop monitoring those devices ( Remove Device from
Group option).

Request that the Data Center Expert server immediately scan selected devices
for sensor values, without waiting until the server would normally scan those
devices ( Request Device Scan option).

Note: This option is unavailable for NetBotz Appliances, and devices that have
a NetBotz Appliance as their parent device.

View all the values being reported by the sensors at selected devices ( View
Device Sensors option).

Select the appropriate device type for a third party device, or more accurately
define an SNMP device ( Change Device Type option).

Configure the device to use its default label or specify a custom label ( Device
Label Settings option).

Create thresholds for a selected device, or set of devices ( Create
Thresholds option).

Note: For information about this option, see Create Thresholds option,
under Alarm Configuration.

Configure selected APC SNMP devices to use the same values for shared
settings ( APC SNMP Device Configuration option).

Note: An APC SNMP Device Configuration option is also in the Device menu.
For information about these options, see APC SNMP Device Configuration.
Access an option to lock or unlock rack doors using the Rack Access
Control option for a main NetBotz Appliance, or any of its associated Rack
Access Pod 170 devices.

Note: The Rack Access Control option is available only when a Rack Access
Pod 170 is connected to the selected NetBotz Appliance.

58



EcoStruxure IT Data Center Expert 8.1.0

« Access a specific configuration option for a selected NetBotz Appliance or
camera pod ( NetBotz Appliance Configuration options).

Note: A NetBotz Appliance Configuration option is also in the Device menu.
For information about these options, see NetBotz Appliance Configuration.

» Access the Surveillance perspective with a selected camera highlighted in
the Thumbnails view ( Show in Surveillance Perspective option).

Note: Show in Surveillance Perspective is only available when a camera is
selected; when multiple cameras are selected, only the camera closest to the
top of the Devices View is highlighted in the Thumbnails view.

» Disable or re-enable notifications for any SNMP or Modbus device, or device
group ( Enter/Exit Maintenance Mode options).

» Create a custom property, or edit the value of an existing property, for the
selected devices or sensors ( Add Custom Property option).

» Access the Custom Properties Editor view to add, modify, or remove custom
properties for selected devices or sensors ( Open Custom Properties Editor
option).

» Create a virtual sensor for a selected device, or set of devices ( Create Virtual
Sensor option).

Note: For information about this option, see Virtual Sensors view.

NetBotz Appliances in the Device View

A NetBotz Appliance appears in the Device View as an expandable listing. When
expanded, each device it monitors is listed under the main NetBotz Appliance listing,
including an entry that reports the network status of the appliance itself.

The hostname or IP address of the NetBotz Appliance is reported in the Parent
Device column for the NetBotz Appliance, and for each associated device.

You can select the right-click View Device Sensors for the main (expandable) listing
for a NetBotz Appliance in the Device View (or for a NetBotz Appliance icon in the
Map View), to access information about all sensors for the NetBotz Appliance and
any devices that it monitors.

You can double-click the main NetBotz Appliance entry, or from any of its associated
devices, to launch to the appliance's web interface (or highlight the appliance in the
Device View or Map View and select the right-click Launch to Device option).
You can right-click a main NetBotz Appliance entry to connect to that device using
Advanced View (right-click Launch Advanced View option).

Note: This option must be enabled using Advanced View Settings, a Client
Preferences option in the File menu. In addition, if the NetBotz Appliance is on the
Data Center Expert server's private network, SOCKS Proxy, a Server Access option
for Server Administration Settings inthe System menu, must be enabled, and you
must be a Data Center Expert Administrator, or a user with the Data Center
Expert Proxy role assigned.

You can right-click a main NetBotz Appliance entry, or any of its Rack Access 170
devices, to lock or unlock rack doors using the Rack Access Control option.

Note: The Rack Access Control option is available only when a Rack Access Pod
170 is connected to the selected NetBotz Appliance.

You can move copies of any associated device, including the device that represents
the appliance, to any other device group; a copy of that device remains associated
with the main NetBotz Appliance listing.

Information columns
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The Device View columns provide information and status for listed devices.

Note: A Configure Columns icon at the top of the view allows you to define which columns
are displayed.

Column Description
Type The type of device, with SNMP Device used as
a generic identification.
Status The severity of the most serious alarm condition
at a device.

Note: You can select a device in the Device
View to access information about its alarms in
the Active Alarms view.

Monitored SNMP devices typically report
three status conditions:

Normal: no alarm conditions exist.

Warning, a condition exists that may
require attention to make sure it does not
deteriorate into a critical state. For example,
a UPS that is running on battery power
during a power failure will shut down its load
equipment if its battery power is depleted
before power returns to normal.

Critical: a condition exists that requires
immediate attention. For example, a
discharged battery can result in the loss of
UPS protection during a power failure.

NetBotz Appliances typically report two
status conditions, in addition to Normal:

Error: a sensor threshold violation exists
that requires immediate attention. For
example, a high temperature violation that
could lead to equipment damage.

Failure: an operational failure exists that
requires immediate attention. For example,
communication with a camera pod was lost
which could lead to an undetected security
violation.

Note: The status reported for alert
threshold violations can be defined by the
severity settings for each threshold. For
example, a door sensor can be set to
report Informational status for an open
door.

Model The device model, if known. For example,
Silcon DP310E for an APC UPS.

Hostname The hostname, or IP address, if no hostname is
defined, for a monitored SNMP device or NetBotz
Appliance.
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Note: A Hostname is provided for SNMP
devices monitored by NetBotz Appliances, but
not for non-SNMP devices such as sensor and
camera pods.

Parent Device Identifies the Data Center Expert server, for
SNMP devices directly monitored by the server,
or the hostname or IP address for a NetBotz
Appliance and its supported devices.

Serial Number The serial number assigned to a device, if known.

IP Address The IP address used by a monitored SNMP
device or NetBotz Appliance.

Note: An IP Address is provided for SNMP
devices monitored by NetBotz Appliances, but
not for non-SNMP devices such as sensor and
camera pods.

Location The location associated with a device, if known.

Application Version The application or firmware version number for a
device, if known.

Label The label defined for a device.

Maintenance Mode Indicates a device is in Maintenance Mode, and

alarm notifications for that device have been
disabled ( Yes), or not in Maintenance Mode, and
alarm natifications are enabled ( No), the default.

Groups The names of any device groups a device
belongs to, including All Devices and
Unassigned.

MAC Address The unique network interface identifier for the
device.

Contact Name The name of the contact associated with the
device.

Button icons (Device View)

In addition to standard minimize and maximize icons, four icons are available to perform
specific Device View functions.

Note: Except for the Configure Columns icon, right-click options are available to perform
the same functions.

Icon Description

. | Use this Export Device List icon to save a
s o copy of the device list as a *.csv (the default
selection) or *.txt file.

+ Use this Add Devices icon to initiate a
device discovery process used to add
SNMP devices, Modbus devices, or
NetBotz Appliances to be monitored by the
Data Center Expert server.
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Icon Description

b

Use this Delete Devices icon to delete
devices that you no longer want the Data
Center Expert server to monitor.

wh

Use this Custom Sensor History
Reports icon to create a report or graph for
the historical values of the sensors at
selected devices (see Reports feature).

FH

Use this Configure Columns icon to
identify the columns to be included in the
device list.

Map View features

The Map view presents devices as icons on a customizable graphic background. Devices
and sensors are automatically placed on maps by default. You can change this in the
System > Server Administration Settings > Map Settings option.

A unique Map View can be created for each group in the Device Group view, with each
view having the following features:
Note: The Map View for the Unassigned device group cannot be customized.

* You can create a representation of the monitored devices that makes visual sense,
according to your needs.
Note: By default, the device icons are positioned in a row layout on a tiled background,
and identified by a label that is positioned below the icons.

You can customize the background, and the size and shape of the icons.

You can define where the icon labels that identify the devices are positioned, or
disable those labels.

You can reposition the icons.

You can hover over an icon to view information about the device's sensors.
You can show the current value of a sensor at one or more of the device icons.
You can use the Find Devices, Groups, or Sensors in Map icon, or right-click
option, to search and select device groups and sensors by label, or devices by
IP address, location, hostname, model name or device label.

Note: Boolean operators are not supported.

Note: You can search and select device groups, devices, or sensors regardless
of whether the identifier is shown on the map. For more information about
identifiers and other icon settings, see Map Settings .

* You can select a device icon, or icons, to filter the Active Alarms view to show only
the alarms for selected devices.
Note: When a NetBotz Appliance is selected, the Active Alarms view will display
its alarms, including all alarms associated with the devices it monitors.

 Right-click options, and icons at the top of the view, allow you to perform functions
related to managing the Map View background and icons.

Reposition icons within the map ( Edit Map option or icon), and save the new
positions ( Save Map option or icon).

Reset the device icons back to their default positions ( Auto-Arrange option or
icon).

Select ( Select All option) or deselect ( Deselect All option) all devices in the
Map View.
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Select the graphic used for the background, and define how icons are displayed
( Map Settings option or icon).

Select sensor values to be displayed by the icons ( Custom Label Settings
option or icon).

Select the appropriate device type for a third party device, or more accurately
define an SNMP device ( Change Device Type option).

 Otherright-click options allow you to perform functions not directly related to managing
the Map View.

Delete devices that you no longer want the Data Center Expert server to monitor
( Delete Devices option).

Note: This option is disabled for a device that has a NetBotz Appliance as its
parent device.

Initiate the process used to create a report or graph for the historical values of
the sensors at selected devices ( Generate Sensor History Report option or
graph icon).

Access Alarm History view to review historical alarm data for any selected
devices ( Show Alarm History option).

Define the port and protocol settings to be used by the Data Center Expert server
to communicate with monitored devices ( Device Launch Settings option).
Note: For monitored APC SNMP and Modbus devices, the default username
and password "apc" is provided by default.

Control the outlets at a selected APC device ( Outlet Control option).

Log on to the web interface at a selected device, if it has one ( Launch to
Device option).

Log on to the Advanced View interface at a selected NetBotz Appliance (Launch
Advanced View option).

Note: This option is enabled by Advanced View Settings, a Client
Preferences option in the File menu.

Request that the Data Center Expert server immediately scan selected devices
for sensor values, without waiting until the server would normally scan those
devices ( Request Device Scan option).

Note: This option is unavailable for NetBotz Appliances, and devices that have
a NetBotz Appliance as their parent device.

View all the values being reported by the sensors at selected devices ( View
Device Sensors option).

Create a custom property, or edit the value of an existing property, for the
selected devices or sensors ( Add Custom Property option).

Access the Custom Properties Editor view to add, modify, or remove custom
properties for selected devices or sensors ( Open Custom Properties Editor
option).

Configure selected APC SNMP devices to use the same values for shared
settings ( APC SNMP Device Configuration option).

Note: An APC SNMP Device Configuration option is also in the Device menu.
For information about these options, see APC SNMP Device Configuration.
Create thresholds for a selected SNMP or Modbus device, or set of devices

( Create Thresholds options).

Note: For information about these options, see Create Thresholds , under
Alarm Configuration menu.

Disable or re-enable notifications for any SNMP or Modbus device, or device
group ( Enter/Exit Maintenance Mode options).

Access an option to lock or unlock rack doors using the Rack Access
Control option for a main NetBotz Appliance, or any of its associated Rack
Access Pod 170 devices.

Note: The Rack Access Control option is available only when a Rack Access
Pod 170 is connected to the selected NetBotz Appliance.
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Access a specific configuration option for a selected NetBotz Appliance or
camera pod ( NetBotz Appliance Configuration options).

Note: For information about these options, see NetBotz Appliance
Configuration under Device menu.

Add or edit alert thresholds for a selected NetBotz Appliance or devices that have
a NetBotz Appliance as their parent device ( Alert Thresholds options under
NetBotz Appliance Configuration ).

Note: For information about these options, see Alert Thresholds options,
under Alert Settings in the NetBotz Appliance Configuration option of the
Device menu.

Edit camera settings for a selected NetBotz Appliance or cameras that have a
NetBotz Appliance as their parent device ( Camera Settings option under
NetBotz Appliance Configuration ).

Create a virtual sensor for a selected device, or set of devices ( Create Virtual
Sensor option).

Note: For information about this option, see Virtual Sensors view.

Button icons (Map View)

In addition to standard minimize, maximize, zoom, and undo/redo icons, five icons are
available to perform specific Map View functions.

Note: Right-click options are available to perform the same functions as the five button

icons.

Icon Description

Use this Edit Map/Exit Edit Map icon to
reposition devices within the map, and save
the new positions.

Use this Find Devices, Groups, or
Sensors in Map icon to search and select
device groups and sensors by label, or
devices by IP address, location, hostname,
model nhame or device label.

Note: Boolean operators are not supported.

Use this Map Settings icon to define the
background, as well as how icons are
displayed.

157

Use this Auto-Arrange icon to reset the
device icons back to their default positions.

L&

Use this Custom Label Settings icon to
select the identifier and sensor values to be
displayed for the Map View devices.

Creating a customized background

Use the " Map Settings" display to create a custom background for a selected device
group's Map View.
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1. Access the " Map Settings" display by selecting the right-click Map Settings option,
or clicking the Map Settings icon, in the Map View:

2. Inthe " Map Settings " display Map Background section, select Custom
Background .

3. Click Select Image, and use the "Open" display to browse to, and open,
the.jpg,.png,.bmp, or.gif file you want to use for the background.

Note: You can click Save to save a copy of the selected graphic on your client, if
desired.
4. Repeat steps 1 through 3 for the Map Views of the other device groups.

Customizing the device icons

Use the " Map Settings" display to customize how the device icons are displayed in a
selected device group's Map View.

1. Access the " Map Settings" display by selecting the right-click Map Settings option,
or clicking the Map Settings icon, in the Map View.

2. In the " Map Settings" display, select the Map Settings option, and do any of the
following actions:

Note: The lcon Preview shows how your changes will affect the icons.

» Select whether you want to use Small or Large Icons.
* Use the Width and Height options to change the shape of the icon, if desired.
* When identifiers are enabled, select whether you want them displayed
horizontally at the bottom of the icons ( Horizontal), or vertically along the right
side of the icons ( Vertical).
3. Repeat steps 1 and 2 for the Map Views of any other device groups.

Selecting sensor values for a Map View's devices

Use the " Map Label Settings" display to select an identifier to display for all devices and
sensors in a Map View, and to select a sensor value to display on all devices on the map
that report the sensor. Use the " Custom Label Settings " display to select a custom
identifier or sensor value to be displayed for a specific device in a map.

Selecting Map Label Settings for all devices in a map

You can select an identifier and a sensor value for all devices to display in a Map View,
however, only devices that report that sensor will show its value.

1. Selectthe Map Settings right-click option, or the Map Settings icon at the top of
the Map View. Select the Map Label Settings option.

2. Check-mark the Show Identifier option, and select an identifier from the list.

3. Make sure the Show Value option is check-marked.

4. Select the sensor you want to use from the available sensor list.

Selecting Custom Label Settings for a selected device or set of devices

You can select a device or set of devices in a Map View, and select an identifier to display
instead of the identifier set in the Map Settings display. You must select one device at a
time to also define a custom value to display for a specific sensor.
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1. Select the device or set of devices in the Map View.
2. Selectthe Custom Label Settings right-click option, or the Custom Label
Settings icon at the top of the Map View.
3. Check-mark the Show Identifier option, and select the identifier you want the device
or set of devices to display.
4. When one device is selected, define the sensor value you want the device to display,
by choosing one of the following options:
» Select Display the value setin Map Settings if you want the selected device
to use the settings defined in the Map Settings display.
* Select Choose a specific sensor value, and select the sensor you want to use
from the available sensor list, if you want the selected device to use a custom
setting.

"Add to Map" display

Use this display to select the device groups, devices, and sensors to add to a map.

You access this display from the right-click menu in a map, after Edit Map is selected. You
use three tabs, Sensors, Devices, and Device Groups, to select the sensors, devices,
or device groups you want to add to the map.

You can use the Search field to filter the list on each tab based on the text you type.
Note: Only the Boolean operators AND, OR, and NOT are supported.

You can select the Configure Columns icon onthe Sensors and Devices tabs to identify
the columns that appear in the display. You can click the column headers to sort the list in
ascending or descending order.

The Unassigned group is automatically added to the map for the All Devices group. Any
device group you create, and any device you add to a device group, is automatically added
to the map for the selected device group. Sensors must be added to a map manually.

When all the device groups, devices, or sensors available for the selection are already
added to the map, the list on the Sensors, Devices, or Device Group tabs is empty.
When a device group, device, or sensor has not been added to the map, or has been
removed from the map, it is listed on the appropriate tab, and can be added to the map at
a later time.

Element Description

Sensors tab Displays all available sensors, for every device in
every device group, not already on the map.
Note: Sensors are not added to a map by
default. They must be added manually from this
display.

Devices tab Displays the devices, in every device group, not
already on the map.

Note: When the device group you select
contains only devices, the list in the Devices tab
is at first empty. Devices are added to the map
by default.

Device Groups tab Displays no device groups until one or more
device groups are removed from the map.
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Note: When the device group you select
contains only device groups, the list in the
Device Groups tab is at first empty. Device
groups are added to the map by default.

"Map Settings" display

Use this display to access Map Settings options used to define how the background and
icons will appear in a Map View for a device group.

Map Settings option

Use this option to customize how the background and icons will look ina Map View.

Element

Description

Custom Background

Click to select a graphic to use as a custom
background.

Select Image

Click to browse to and select the graphic you
want to use for the custom background.

Save

Click to save the selected background image as
a file at your local machine.

No Background

Click to use a blank background.

Grid Background (Default)

Click to use a blank-tiled background, the default.

Width Drag right or left to change the width of the icons.

Height Drag up or down to change the height of the
icons.

Small Icons Click to use small icons.

Large Icons Click to use large icons.

Identifier Orientation

Choose how to show the identifier you selected
in Map Label Settings or Custom Label
Settings, if any.

Horizontal will show the identifier below the
icon, horizontally, and Vertical will show the
identifier to the right of the icon, vertically.

Icon Preview

Shows the affect of applied Sizing and
Identifier definition on how icons will appear in
a Map View.

Note: Sensor values are always shown below
the icon, horizontally, and are not shown in the
Icon Preview.

Map Label Settings option

Use this option to define the identifier and sensor value labels to display for all devices and

Sensors on a map.

Note: Sensor values can be displayed for the devices managed by a NetBotz Appliance,

but not for the NetBotz Appliance itself.
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Element Description

Show Identifier Check-mark to select the identifier to show for all
devices and sensors on a map.

Show Value Check-mark to show the value of the selected
sensor for all devices on the map that report that
sensor.

List Select the sensor for which you want to show the
value.

Note: Only the devices that report the sensor will show the sensor value.

All the sensors for every device in the selected device group's Map View are listed. There
may be more than one sensor of a given type, as different devices report different sensors.
For example, the main input voltage sensor reported by a Smart-UPS is different than the
main input voltage phase 1 sensor reported by a Symmetra PX. Thus, if you select main

input voltage as the sensor, only devices that have that exact sensor will report the value.

Devices that report the selected sensor will update with the sensor value except for the
following:

» Devices that do not report the sensor value.

» Devices that have a different sensor defined in the Custom Label Settings display.
Note: You can also use the Custom Label Settings display to select a new sensor
value label for one device on a map without affecting the sensor value labels at any
other devices.
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Virtual Sensors view

This view allows users with Device Administrator or Server Administrator access to view,
create, modify, and delete virtual sensors for the Data Center Expert server. A virtual sensor
allows you to view and monitor the average or total value of multiple numeric sensors of the
same sensor type.

A virtual sensor can include numeric sensors for any device in any device group monitored
by the Data Center Expert server, including other virtual sensors.

A virtual sensor starts recording historical data when it is created. The value of the virtual

sensor is calculated and updated only when all the devices monitoring the included sensors
have been scanned. The value of the virtual sensor is a single value data point, representing
the weighted average or weighted total of all the historical sensor data collected since the
last calculation.

Only Device Administrators and Server Administrators can create virtual sensors.

To create a virtual sensor, you select whether you want it to report the average value or the
total value for the sensors you want to include. You then select a combination of sensor
type, device groups, and devices to filter the list of available sensors. Only device groups
and devices containing sensors of the selected sensor type are shown.

Note: You can select the sensor type Other Numeric only when all sensors for the
selection use the same unit of measure. You cannot create a virtual sensor for state sensors.

After you select the sensors you want to include in the virtual sensor, you identify a name
for the virtual sensor, and specify the device group in which you want to create its virtual
device parent.

For each virtual sensor created, a virtual device parent is also created and added to the
Device View and the Map View. You can right-click the Virtual Device parent, and
select View Device Sensors to view the virtual sensor. You can view all the virtual sensors
monitored by the Data Center Expert server in the Virtual Sensors view.

Note: You cannot create a virtual sensor directly from sensors you manually added to
the Map View.

Both physical and virtual devices are included in the device count in the Device View, and
the status bar at the bottom of the display. Virtual devices are not included in the Used
Node Count in the "License Keys" display, accessed from the Server Administration
Settings option in the System menu.

Right-click options, and button icons at the top of the view, perform the following functions:

« Create a virtual sensor in the specified device group ( Create Virtual Sensor option
or icon).

« Modify the name of the virtual sensor, and add or delete sensors included for the
selected virtual sensor ( Edit Virtual Sensor option or icon).

* Remove the selected virtual sensor from the Data Center Expert server ( Delete
Virtual Sensor option or icon).

« Generate a report or graph for the historical values of the selected virtual sensor
( Generate Sensor History Report option or icon).

» Create thresholds for the selected virtual sensor ( Create Threshold option).
Note: Forinformation about this option, see Create Thresholds option, under Alarm
Configuration.

* |dentify the selected virtual sensor in the Device View or Map View ( Select Virtual
Device option).
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Four menus provide access to create a virtual sensor:

Right-click menu Create Virtual Sensor in the Device Groups view of the
Monitoring perspective.

Right-click menu Create Virtual Sensor in the Device View of the Monitoring
perspective.

Right-click menu Create Virtual Sensor in the Map View of the Monitoring
perspective.

Create Virtual Sensor, an option in the Device menu.

Creating a virtual sensor

1.

Access the Create Virtual Sensor option:
* Right-click one or more devices in the Device View or Map View.
* Right-click a device group in the Device Groups view.
» Select Create Virtual Sensor from the Device menu.
» Select the Add iconin the Virtual Sensors view.
Select whether you want the virtual sensor to report the Average value or the
Total value of the sensors to be included.
Select the sensor type for the virtual sensor.

You can select the sensor type Other Numeric only when all sensors for the selection
use the same unit of measure. You cannot create a virtual sensor for state sensors.
Select the device groups containing the sensors you want to include in the virtual
sensor. This option is available when you select Create Virtual Sensor from the
Device menu, or from the Add icon in the Virtual Sensors view.

Only device groups containing sensors of the selected sensor type are shown.
Select the devices containing the sensors you want to include in the virtual sensor.

Only devices containing sensors of the selected sensor type are shown.
Select the sensors you want to include in the virtual sensor.

Only sensors of the selected sensor type are shown.
Identify a name for the virtual sensor.

This virtual sensor name appears in the Label column for both the virtual device
parent and virtual sensor.

Specify the device group in which you want to create the Virtual Device parent for the
virtual sensor.

Click Finish to create the Virtual Device parent and the virtual sensor.

The Virtual Device parent is added to the Device View and the Map View, with an
unaddressable IP Address. You access the virtual sensor from the right-click menu,
View Device Sensors, or from the Virtual Sensors view.

The Virtual Device is added to the device count only. It is not added to the Used Node
Count for the node license.

"Choose Device Groups" display

Use this display to choose the device groups containing the sensors you want to add to the
virtual sensor. Only device groups containing the selected sensor type are shown.
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"Choose Devices" display

Use this display to choose the devices that monitor the sensors you want to add to the virtual
sensor. Only devices monitoring the selected sensor type are shown.

A Search field and Clear button allow you to filter the list to display only the device groups
that include your typed text.

A Configure Columns icon allows you to define which columns are displayed.

Column Description
Type The type of device.
Hostname The hostname, or IP address, if no hostname is

defined, for a monitored device or NetBotz
Appliance, or <not addressable> for a virtual

device.
Label The label defined for a device.
Location The location associated with a device, if known.
Model The device model, if known.
Parent Device Identifies the Data Center Expert server, for

devices directly monitored by the server, or the
hostname or IP address for a NetBotz Appliance
and its supported devices.

Device Groups The names of any device groups a device
belongs to, including All Devices and
Unassigned.

<Custom Property Key Name> A custom property key, identified by name.

"Choose Sensors" display

Use this display to choose the sensors to add to the virtual sensor. Only sensors of the
selected sensor type are shown.

A Search field and Clear button allow you to filter the list to display only the sensors that
include your typed text.

A Configure Columns icon allows you to define which columns are displayed.

Column Description
Sensor The name of the sensor.
Current Reading The last reported value for the sensor.
Hostname The hostname, or IP address, if no hostname is

defined, for the device or NetBotz Appliance
monitoring the sensor, or <not addressable> for
a virtual device.

Unit of Measure The unit of measurement for the sensor.
Device Type The type for the device monitoring the sensor.
Device Model The model for the device monitoring the sensor.
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Device Label

The label defined for the device monitoring the
sensor.

Parent Device

Identifies the Data Center Expert server, for
devices directly monitored by the server, or the
hostname or IP address for a NetBotz Appliance
and its supported devices.

<Custom Property Key Name>

A custom property key, identified by name.

"Destination Device Group™ display

Use this display to choose the device group in which to create the virtual device parent for
the virtual sensor. The Virtual Device parent cannot be created in the All Devices group.

For each virtual sensor created, a virtual device parent is also created and added to the

Device View and the Map View.

"Virtual Sensor Name" display

Use this display to specify a name for the virtual sensor.

This virtual sensor name appears in the Label column for both the virtual device parent

and virtual sensor.

"Edit Virtual Sensor" display

Use this display to modify the selected virtual sensor.

Note: You cannot edit a virtual sensor until all sensors included in the virtual sensor are

loaded.

A Name field allows you to modify the name of the selected virtual sensor.

A Search field and Clear button allow you to filter the list to display only the sensors that

include your typed text.

You can click the Configure Columns icon to define which columns appear in the list. The
columns provide information for listed sensors.

Element

Description

List

Provides information about each virtual sensor in
the view.

Add Sensors

Click to add a sensor to the selected virtual
sensor.

Remove Sensors

Click to remove a sensor from the selected virtual
Sensor.

Note: You cannot remove all sensors from a
virtual sensor.
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Alarm views

Two views provide information about the alarms that occur at monitored devices, both of
which can be accessed from Alarms in the Windows menu: Active Alarms view is part of
the default layout of the Monitoring perspective; Alarm History view also can be accessed
by selecting Show Alarm History, a right-click menu option in the Device View, Map
View, or Device Groups view.

Alarms displayed in the alarm views

The alarms listed in the alarm views ( Active Alarms view or Alarm History view) depend
on whether a device or set of devices are selected in the Device View or Map View, and,
for some devices, whether a threshold related to an alarm has been defined at the Data
Center Expert server.

* When a device or set of devices is selected in the Device View or Map View, only
the alarms associated with that device or set of devices are listed in an alarms view.

« When an alarm threshold has been defined at the Data Center Expert server for a
sensor at a monitored device, two alarms may be listed in an alarms view for the same
sensor event:

* An alarm sent to the Data Center Expert server by a monitored device.

* An alarm generated by the Data Center Expert server when the data it monitors
for that device sensor violates the alarm threshold setting defined at the server
for that sensor.

Note: Not all SNMP devices can send alarms to the Data Center Expert server.
Also, the thresholds at SNMP devices are independent from the alarm threshold
settings at the Data Center Expert server.

"View Alarm Details and Comments" display

Clip option

Use this display, accessed by a View Alarm Details and Comments right-click option in
the Active Alarms view and Alarm History view, to view Details for any active or historical
alarm, as well as Comments, Clip and Graph data for that alarm, when available.

Note: The Clip option is available only for alarms that include a camera icon in the Clip
column of an alarm list; the Graph option is available only for some of the alarms that list
a sensor in the Sensor column of an alarms list, and unavailable for alarms that have no
sensor identified in the Sensors column.

Use this option to view clips that were included with a selected alarm.

A tab identifies each camera that has a clip attached to the alarm. The clip is displayed in
the upper portion of the tab, while icons used to view each frame, and to export the clip,
and information about the clip are provided in the lower portion.
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Element

Description

View Pane

Shows the content of the clip.

Play ( p )/Pause ( M! ) icons

Click the Play icon to start the clip; click
the Pause icon to pause the playback on
the current image.

You may begin playing the clip during the
load sequence, if you desire.

Clip slider bar

Drag the control left or right to find a specific
frame within the clip. The number to the right
of the bar shows the currently displayed
frame.

You also can click the up and down arrows
to the right of the slider bar to advance or
rewind the clip by a single frame.

The beginning date, ending date, and time
of the clip are displayed below the slider bar.

Export Clip icon (IH—])

Click this icon to access the "Export Clip" display.
Note: For information about the "Export Clip"
display, see "Recorded Camera Clips" display
under Surveillance perspective.

Audio icon (4%

If there is audio associated with the current clip,
the audio icon is displayed in black; if there is no
audio, the icon is grayed out.

Digital Signature icon (r’#)

If the clip has a digital signature associated with
it, this icon is displayed in color; if the clip is
unsigned, the icon is grayed out.

Status area

Displays the loading status of the selected clip:
Loading or Loading Complete.

Clip information

Displays the following information about the
current clip:

¢ Total Frame Count
¢ Duration
* Resolution

Comments option

Use this option to view, add, or remove comments about the selected alarm.

You can add up to 25 comments for the selected alarm. The date and time the alarm
occurred, and the username, date and time for each comment are displayed. You can click
the Xicon next to each comment to permanently remove it from the list.

Events generated by the Data Center Expert server are italicized in blue. The date and
time the alarm occurred, and the name of the user that acknowledged the alarm, if
applicable, are displayed. System events cannot be removed from the list.

Data Center Expert Server Administrator users can add and remove comments for any

alarm.
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Device Administrator users can add comments for alarms at devices in the device groups
to which they have access, and can remove only their own comments.

Device Viewer users can view comments for alarms at devices in the device groups to which
they have access.

Note: For a non- Data Center Expert Administrator user, including a user for which no role
is selected, access privileges are determined by Device Group Access settings in the
Users tab for that user, and for the user groups to which the user is assigned.

Details option

Use this option to view information about a selected alarm.

Note: Three elements ( Resolved by, Resolved Comment, and Resolve Alarm) are
available only for an alarm that must be manually resolved because it is associated with a
sensor alert threshold that has Return-to-Normal Requires User Input selected in its
Advanced tab.

Element Description

Sensor The sensor associated with the alarm.

Type The type of device.

Alarm Name The name of the alarm.

Device The label information for the device.

Device Location The location of the device, when available.

Time Occurred When the alarm occurred, by date and time.

Time Resolved When the alarm was resolved, by date and time,
or Not Yet Resolved, if still active.

Resolved by The user who manually resolved an alarm using
the "Resolve Alarm" display.

Resolved Comment Any optional comment made in the "Resolve
Alarm" display while manually resolving an
alarm.

Custom URL The Custom URL in the Advanced tab for the

alert threshold setting associated with the
alarming sensor, when defined for that threshold.
Note: For more information, see Alert
Thresholds under Alert Settings ( Device
menu).

Custom Description The Custom Description in the Advanced tab
for the alert threshold setting associated with the
alarming sensor, when defined for that threshold.
Note: For more information, see Alert
Thresholds under Alert Settings ( Device

menu).

Recommended Action Information about how to clear the alarm, when
available.

Resolve Alarm Click to use the "Resolve Alarm" display to

manually resolve an alarm.
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Graph option

Use this option to view a graph for an alarm associated with a sensor.

Note: This is available only for some of the alarms that list a sensor in the Sensor column
of an alarms list; it is unavailable for alarms that have no sensor identified in the
Sensors column.

Each graph has its value measurements labeled up the left side of the graph, and date and
time values labeled across the bottom.

Active Alarms view

This view provides information about the alarms that are active for all devices in a selected
device group, or for any device or set of devices selected in the Device View or Map
View.

Button icons (Active Alarms view)

In addition to standard minimize and maximize icons, four icons are available to perform
specific Active Alarms view functions.

Icon Description

}“;.fj) Use the Hide Alarm Details icon to hide
o the Alarm Details section.

({’{: Use the Show Alarm Details icon to show
' the Alarm Details section.

F_TI Use the Configure Columns icon to

identify the columns that appear in the active
alarms list. All available columns are
displayed by default.

@ Use the Show Hidden Alarms icon to view

acknowledged alarms set as hidden, or to
hide affected alarms once you have viewed
them.

ﬂj Use the Generate Custom Sensor

History Report icon to create a report or
graph for the historical values of sensors at
devices associated with alarms selected in
the alarms view (see Reports feature).

Active Alarms list

This Active Alarms view section lists active alarms for selected Device Group view,
Device View, or Map View devices, and provides information about each alarm.
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The view includes a search element that allows you to list only the alarms that match your
typed text, and a table that provides information about those alarms.

Column Description

Clip

Uses a camera icon (ﬂ) to identify alarms that
include a surveillance clip.

Description Describes details for the alarm.

Severity Describes the severity level associated with the

alarm.

Device Hostname Identifies the hostname or IP address of the

device.

Alarm Type Identifies the type of alarm.

Location Identifies the location of the device, when

available.

Parent Device Identifies the IP address or hostname for a

NetBotz Appliance, or <server_name> (Data
Center Expert) , for SNMP devices monitored by
the Data Center Expert server.

Time Occurred Identifies when the alarm occurred.

Sensor Identifies the sensor associated with the alarm,

when an alert threshold setting is defined for the
sensor alarm.

Note: For information about the alert threshold
settings, see Alert Thresholds, under Alert
Settings.

Notifications Suppressed Indicates whether notifications for the alarm were

suppressed when the alarm was acknowledged.

You can use the list, right-click options, and button icons to do the following:

Show or hide the Alarm Details section ( Show/Hide Alarms Details icon).

Select which columns appear in the list ( Configure Columns icon).

Click a column title to sort the list in ascending or descending order based on the
information in that column.

Access the "Alarm Details" display for a selected alarm ( View Alarm Details and
Comments option, or double-click the alarm).

Select an alarm in the list and select that device in the Device View ( Select
Device option).

Generate a report for the historical values of the sensors at the device associated with
the selected alarm ( Custom Sensor History Report icon).

Note: All device sensors associated with the device will be listed, with the sensor for
that alarm selected in that list.

View all the values being reported by the device associated with the selected alarm
( View Device Sensors option).

Log on to the web interface of the device associated with the selected alarm, if it has
one ( Launch to Device option).

Specify how you want to acknowledge selected alarms ( Alarm Acknowledgement
option).

View acknowledged alarms set as hidden, or hide affected alarms once you have
viewed them ( Show Hidden Alarms icon).
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» Show the selected threshold or device alarm in the Threshold Alarm
Configurations view or the Device Alarm Configurations view in the Alarm
Configuration perspective ( Find Alarm Configuration option).

Note: This option is not available for active alarms on NetBotz Appliances.

» Modify the settings for only the selected instance of a threshold or device alarm, or all
instances of that threshold or device alarm on every device that reports it ( Edit Alarm
Configuration option).

Note: This option is not available for active alarms on NetBotz Appliances.

Alarm Details section

When displayed, this Active Alarms view section provides information about the alarm
selected in the active alarms list: clicking the Show/Hide Alarm Details icon shows or
hides the Alarm Details section.

Note: View Alarm Details, a right-click menu option in the Active Alarms list accesses
a display that reports details for the selected alarm, details that may include a graph and
camera clips.

The alarm is identified at the top of the Details section.

Note: This section reports the information available to the Data Center Expert server for
a device and its alarms. Some devices provide more information than others.

Information Description

Sensor The sensor associated with the alarm.

Type The type of device.

Alarm Name The name of the alarm.

Device The label information for the device.

Device Location The location of the device, when available.

Time Occurred The time the alarm was reported.

Time Resolved The time the alarm was resolved, or Not Yet
Resolved when the alarm is still active.

Custom URL A custom URL included in alarm notifications.

Custom Description A custom description included in alarm
notifications.

Recommended Action Information about how to clear the alarm, when
available.

"Alarm Acknowledgement” display

Use this display to specify how you want to acknowledge selected active alarms at SNMP
and Modbus devices.

Type Description

Set as Hidden Checkmark to hide the alarm in the Active
Alarms view of any Data Center Expert client
logged in to the Data Center Expert server.
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Note: You can click the Show Hidden
Alarms icon to view acknowledged alarms set as
hidden. The information for affected alarms is
italicized. You can then select any italicized
alarms and uncheck the Set as Hidden option
to display them in the view.

Suppress Future Data Center Expert Checkmark to prevent notifications from being

Notifications sent for the alarm, when the alarm actions
specified in the notification policy are set to
repeat.

Note: When the alarm is resolved, Return to
Normal events are sent using the alarm actions
specified in the notification policy.

Add Comment Enter additional information about
acknowledging the alarm.

Alarm History view

This view provides information about the alarms that have occurred during a defined date
range, for a selected device or set of devices. The alarms displayed can be active or
resolved.

The Alarm History view can be accessed in several ways.

Note: The title of the view will identify the selected devices or group. For example, Alarm
History for All Devices, when the All Devices group in the Device Groups view was
selected for the Alarm History view, or Alarm History for Selected Devices, when
multiple devices in the Device View or Map View were selected for the Alarm History
view.

» Alarm History, an Alarms option in the Window menu: lists alarms for the selected
devices, whether that is all devices in the group selected in the Device Groups view,
or the device or devices selected in the Device View or Map View.

Note: This Alarm History option performs this function only when the Alarm
History view is not currently open. Once that view is open, this option has no affect
on that view.

* Show Alarm History, a right-click Device Groups view option: lists the alarms for
all devices in the group selected in the Device Groups view.

» Show Alarm History, a right-click Device View and Map View option: lists the
alarms for the device or set of devices selected in the view.

Note: Once the alarms for a device, set of devices, or device group are listed in the
Alarm History view, they will remain listed in that view until you select a different
device, set of devices, or device group and click the associated Show Alarm
History option.
The Alarm History view includes a Search text field that allows you to list only those
alarms that include text you type, a From Date and to date calendar control that allows
you to define a new date range for the alarms, and a Search button you click to search for
alarms associated with the new date range.
The Alarm History view also includes a table that provides information about the historical
alarms for the selected devices.
Note: When you open this view, the date range is set for the last 24 hours by default.

Column Description

Time Occurred Identifies when an alarm occurred.
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Time Resolved Identifies when an alarm was resolved, unless it
is still active.

Status Identifies whether an alarm is Active or
Resolved.

Description Describes details for the alarm.

Clip Uses a camera icon to identify alarms that
include a surveillance clip.

Severity Identifies the severity level associated with the
alarm.

Device Hostname Identifies the hostname or IP address of the
device associated with the alarm.

Alarm Type The type of alarm.

Location The location of the device, when known.

Parent Device Identifies the IP address or hostname for a

NetBotz Appliance, or <server_name> (Data
Center Expert) , for SNMP devices monitored by
the Data Center Expert server.

Sensor Identifies the sensor associated with the alarm,

when an alert threshold setting is defined for the
sensor alarm.

Note: For more information, see Alert
Thresholds, under Alert Settings.

You can use the list, right-click options, and button icons, to do the following:

Click a column title to sort the list in ascending or descending order based on the
information in that column.

Select which columns appear in the list ( Configure Columns icon).

Access the "View Alarm Details" display for a selected alarm ( View Alarm Details
right-click option, or double-click the alarm).

Select an alarm in the list and access the listing for its device in the Device View
( Select Device right-click option).

Generate a report or graph for the historical values of the sensors at the device
associated with the selected alarm ( Generate Custom Sensor History Report

right-click option or (ﬂ:l) icon).

Note: All device sensors associated with the device will be listed, with the sensor for
that alarm selected in that list.

View all the values being reported by the sensors at the device associated with the
selected alarm ( View Device Sensors right-click option).

Show the selected threshold or device alarm in the Threshold Alarm
Configurations view or the Device Alarm Configurations view in the Alarm
Configuration perspective ( Find Alarm Configuration option).

Modify the settings for only the selected instance of a threshold or device alarm, or all
instances of that threshold or device alarm on every device that reports it ( Edit Alarm
Configuration option).

Log on to the web interface of the device associated with the selected alarm, if it has
one ( Launch to Device right-click option).

Export a copy of the list as a *.csv (the default selection) or *.txt file ( Export Alarm

History ( - ) icon).

Scroll between multiple pages using standard scrolling elements (arrows and page
number box).
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Note: A maximum of 500 alarm entries can be reported by a page, with additional
pages provided for every additional 500 entries.

"Resolve Alarm" display

Use this display, accessed by the Resolve Alarm button for the Details option in the "View
Alarm Details" display, to manually resolve alarms associated with sensor alert thresholds
that have Return-to-Normal Requires User Input selected in the Advanced tab.

Note: Alarms that are not associated with a sensor threshold that has Return-to-Normal
Requires User Input selected cannot be manually resolved. For more information about
the Advanced tab, and other threshold settings, see Create Thresholds under Alarm
Configuration.

You can add Optional Comment text before you click OK to resolve the alarm.
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Device discovery processes

APC, MGE, NetBotz Appliances, and third-party devices are added to the list of devices
the Data Center Expert server monitors by creating and running device discovery
processes. As devices are discovered, they are added to the All Devices and
Unassigned device groups in the Device Groups view, and displayed in the Device
View and Map View if one of those device groups is selected, and added to the navigation
tree in the Thresholds view. Additionally, you can place SNMPv1 devices, Modbus
devices, and NetBotz Appliances into a device group you select, the Unassigned device
group by default, during the discovery process.

Separate discovery processes exist for each of the following types of devices:

* SNMPv1 devices: APC or third-party devices that use basic SNMP communications.

* SNMPv3 devices: APC or third-party devices that use secured SNMP
communications.

* NetBotz Appliances (except for the 250, 750, 300, 303, 310, 400, and 410 models).

e Modbus TCP

For information about discovering NetBotz 750 Appliances, see NetBotz 750 Appliance
discovery .

You can initiate a discovery process by accessing the "Device Discovery" wizard in the
following ways:
* Select Add Devices inthe Device menu.
* Right-click on any device in the Device View or Map View, and select Add
Devices.

Click the green plus sign icon (+ ) in the Device View.

 Right-click anywhere in the Saved Discovery view, and select Add.

* Right-click on a discovery process listed in the Saved Discovery view, and select
Run, to rerun that process, or Edit, to run an edited version.

Creating a discovery process

You can create discovery processes that can discover the SNMPv1 devices, SNMPv3
devices, NetBotz Appliances, or Modbus devices on your networks. To discover NetBotz
250 and 750 series Appliances, choose SNMPv1 or SNMPv3.

1. Access the "Device Discovery" wizard.
* Select Add Devices in the Device menu.

Click the plus sign icon (+) in the Device View.

* Right-click any device in the Device View or Map View, and select Add
Devices.

* Right-click anywhere in the Saved Discoveries view, and select Add.

2. In the "Choose Discovery Type" display, select the Device Discovery Type:

e SNMPv1 (includes 200 and 750 series NetBotz Appliances)

¢ SNMPv3 (includes 200 and 750 series NetBotz Appliances)

* NetBotz Appliance (includes 300-500 series NetBotz Appliances)

For information about discovering NetBotz 750 Appliances, see NetBotz 750
Appliance discovery .
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In the "Choose Device Group" display, select the device group where you want to
place the discovered devices, and click Next.

In the "Discovery Settings" display, define the settings to be used, and click Next to
schedule or run (or both) the process, or Finish, to add the process to the Saved
Discoveries view without running or scheduling the process.

3.

4,

Modbus TCP device discovery occurs immediately after you click Finish, and will not
appear in the Saved Discoveries view.

» "SNMPv1 Discovery Settings" display:

1.
2.

3.

E

IP Range: the IP addresses the discovery process will search.

Read Community Name: the community name used to read information
at the SNMPv1 devices.

Write Community Name: the community name used to control an APC
SNMP v1 device or register as a trap receiver at an APC SNMPv1 device.
Port: the port number that the SNMPv1 devices use for communication.
Timeout: how long the Data Center Expert server will wait for a response,
in seconds, when it polls an IP address before it considers the poll failed.
Retries: how many times the Data Center Expert server will attempt to
communicate with a device at an IP address, after the initial failure, before
it stops trying to access a device at that address.

Register for Priority Scanning: enables the Data Center Expert server
to be defined as a trap receiver at discovered APC SNMPv1 devices.
Note: Priority Scanning is a trap-based polling process that only occurs in
response to traps from APC SNMPv1 devices or informs from APC
SNMPv3 devices at which the Data Center Expert server is defined as a
trap receiver. It allows the Data Center Expert server to immediately poll
an APC SNMP device in response to a trap, rather than waiting to poll the
device during the normal scanning interval.

Device File Transfer Settings: accesses the "Device File Transfer
Settings" display used to edit, create, or view the file transfer settings for
FTP or SCP access to SNMP devices. For NetBotz 750, you must add the
credentials for the root user (not superuser).

« "SNMPv3 Discovery Settings" display:

1.
2.

3.

IP Range: the IP addresses the discovery process will search.
Username: the username used for secure communication with discovered
SNMPv3 devices.

Authentication Type/ Password: the authentication protocol and
password.

Encryption Type/ Password: the encryption method and password.
Port: the port number that the SNMPv3 devices use for communication.
Timeout: how long the Data Center Expert server will wait for a response,
in seconds, when it polls an IP address before it considers the poll failed.
Retries: how many times the Data Center Expert server will attempt to
communicate with a device at an IP address, after the initial failure, before
it stops trying to access a device at that address.

Register for Priority Scanning: enables the Data Center Expert server
to be defined as a trap receiver at discovered APC SNMPv3 devices.
Note: Priority Scanning is a trap-based polling process that only occurs in
response to traps from APC SNMPv1 devices or informs from APC
SNMPv3 devices at which the Data Center Expert server is defined as a
trap receiver. It allows the Data Center Expert server to immediately poll
an APC SNMP device in response to a trap, rather than waiting to poll the
device during the normal scanning interval.
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9.

Device File Transfer Settings: accesses the "Device File Transfer
Settings" display used to edit, create, or view the file transfer settings for
FTP or SCP access to SNMP devices.

« "NetBotz Appliance Discovery Settings" display:

1.
2.
3.

4.

IP Range: the IP addresses the discovery process will search.

Port: the port used for communication with the NetBotz Appliances.
Security Mode: the security mode used for communication with the
NetBotz Appliances.

Credentials: accesses a display used to manage the credentials that can
be used to communicate with NetBotz Appliances.

» "Modbus Discovery Settings" display:

1.
2.

3.
4,
5.

Single IP Address: one IP address the discovery process will search.
Select Device Type: lists the Modbus device types the Data Center
Expert server supports.

Server Address: identifies the server address of the Modbus device.
Port: the port number the Modbus device uses for communication.
Timeout (seconds): how long the Data Center Expert server will wait for
aresponse, in seconds, when it polls an IP address before it considers the
poll failed.

5. In the "Discovery Scheduling"” display, do one or both of the following actions, and
click Finish, to add the process to the Saved Discoveries view.
* Use the Enable discovery scheduling option to schedule the days and times
when the discovery process will be run automatically.
Note: You cannot schedule discovery for Modbus TCP devices.
* Use the Run discovery now option to run the discovery process when you
click Finish.

Editing a device discovery process

You can edit the discovery settings, the device group in which to place the discovered
SNMPv1 devices, Modbus devices, or NetBotz Appliances, and scheduling for any SNMPv1
devices, SNMPv3 devices, or NetBotz Appliances discovery process listed in the Saved
Discoveries view. You cannot edit the type of device the process will discover.

The difference in the three types of discovery processes is the type of settings used to define

the process.

1. Select Saved Discoveries view, a Device option in the Window menu, to access
the Saved Discoveries View.

2. Right-click a listed discovery process and select Edit.

3. In the discovery settings display, edit the settings, as appropriate, and click Next, to
change the scheduling or run (or both) the edited process, or Finish, to save the
changes in the Saved Discoveries view without running or scheduling the process.

» "SNMPv1 Discovery Settings" display:

1.
2.

3.

e

IP Range: the IP addresses the discovery process will search.

Read Community Name: the community name used to read information
at the SNMPv1 devices.

Write Community Name: the community name used to control an APC
SNMP v1 device or register as a trap receiver at an APC SNMPv1 device.
Port: the port number that the SNMPv1 devices use for communication.
Timeout: how long the Data Center Expert server will wait for a response,
in seconds, when it polls an IP address before it considers the poll failed.
Retries: how many times the Data Center Expert server will attempt to
communicate with a device at an IP address, after the initial failure, before
it stops trying to access a device at that address.
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7.

Register for Priority Scanning: enables the Data Center Expert server
to be defined as a trap receiver at discovered APC SNMPv1 devices.
Note: Priority Scanning is a trap-based polling process that only occurs in
response to traps from APC SNMPv1 devices or informs from APC
SNMPv3 devices at which the Data Center Expert server is defined as a
trap receiver. It allows the Data Center Expert server to immediately poll
an APC SNMP device in response to a trap, rather than waiting to poll the
device during the normal scanning interval.

Device File Transfer Settings: accesses the "Device File Transfer
Settings" display used to edit, create, or view the file transfer settings for
FTP or SCP access to SNMP devices.

« "SNMPv3 Discovery Settings" display:

1.
2.
3.

4.

IP Range: the IP addresses the discovery process will search.
Username: the username used for with discovered SNMPv3 devices.
Authentication Type/ Password: the authentication protocol and
password.

Encryption Type/ Password: the encryption method and password.
Port: the port number that the SNMPv3 devices use for communication.
Timeout: how long the Data Center Expert server will wait for a response,
in seconds, when it polls an IP address before it considers the poll failed.
Retries: how many times the Data Center Expert server will attempt to
communicate with a device at an IP address, after the initial failure, before
it stops trying to access a device at that address.

Register for Priority Scanning: enables the Data Center Expert server
to be defined as a trap receiver at discovered APC SNMPv3 devices.
Note: Priority Scanning is a trap-based polling process that only occurs in
response to traps from APC SNMPv1 devices or informs from APC
SNMPv3 devices at which the Data Center Expert server is defined as a
trap receiver. It allows the Data Center Expert server to immediately poll
an APC SNMP device in response to a trap, rather than waiting to poll the
device during the normal scanning interval.

Device File Transfer Settings: accesses the "Device File Transfer
Settings" display used to edit, create, or view the file transfer settings for
FTP or SCP access to SNMP devices.

« "NetBotz Appliance Discovery Settings" display:

1.
2.
3.

4.

IP Range: the IP addresses the discovery process will search.

Port: the port used for communication with the NetBotz devices.
Security Mode: security mode used for communication with the NetBotz
Appliances.

Credentials: accesses a display that lists credentials that can be used to
communicate with NetBotz Appliances, and allows you to manage (edit,
create, or delete) the credentials.

4. For SNMPv1 devices, Modbus devices, or NetBotz Appliances, in the "Choose Device
Group" display, edit the device group, as appropriate, and click Next.
5. In the "Discovery Scheduling" display, do one or both of the following actions, and
click Finish, to add the process to the Saved Discoveries view.
* Use the Enable discovery scheduling option to schedule the days and times
when the discovery process will be run automatically.
* Use the Run discovery now option to run the discovery process when you
click Finish.

NetBotz 750 Appliance discovery
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To discover NetBotz 750 appliances, choose the SNMPv1 or SNMPv3 discovery type. Only
a Data Center Expert Server Administrator can configure the settings needed to discover
NetBotz 750 appliances, and add SSL certificates if used.

1. Before you begin

When you log in to a NetBotz 750 device for the first time, you must log in as root via SSH
or through a serial connection and set the root password.

See the Installation and Quick Configuration Guide for the NetBotz Rack Monitor 750 and
the Security Handbook on the NetBotz 750 Rack Monitor product page: http://
www.apc.com/prod_docs/results.cfm?DocType=App%20Note&Query_Type=10

Before you discover NetBotz 750 appliance in Data Center Expert, make sure you have:

« Access to the NetBotz 750 appliances you want to discover.
« The IP addresses or IP address range for the NetBotz 750 appliances you want to
discover.

Only a Data Center Expert Server Administrator can configure Device File Transfer Settings,
NetBotz Appliance Credentials, and add the NetBotz 750 SSL certificates in Data Center
Expert.

2. Configure settings on the NetBotz 750 Appliance
On _each NetBotz 750 Appliance you want to discover:

1. Log in to the NetBotz 750 web client, and enable SNMPv1 or v3 in the Settings >
System > SNMP option. By default, SNMP is turned off on the NetBotz 750 appliance.

2. Uncheck the Verify DCE Certificate in Trust Storeoption in the Settings >
System > DCE Surveillance option if Data Center Expert uses a self-signed
certificate.

3. Add SSL Certificates to Data Center Expert and NetBotz 750 Appliance(s)

If Data Center Expert uses SSL to communicate, add SSL certificates to both Data Center
Expert and each NetBotz 750 you want to discover.

Add the NetBotz 750 certificate to Data Center Expert

Add the certificate from _each NetBotz 750 you want to discover in Data Center Expert.
Otherwise, the cameras connected to the NetBotz 750 will not appear on the Surveillance
tab.

Note: You do not need to add the NetBotz 750 SSL certificate if you intend to select No
verification in the NetBotz 750 Camera Communication Settings option in Data Center
Expert. This option is available after you discover the NetBotz 750.

1. Open a web browser, and go to the NetBotz 750 web client.

2. Download the certificate from the browser, and save the certificate file in Base-64
encoded X.509 format.

3. Log in to the Data Center Expert client.

4. Goto System > Server Administration Settings > Server SSL Certificates.

5. Click Add. Paste the certificate, or, click Import Certificate and then navigate to the
NetBotz 750 certificate to import it.

6. Click Add.
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Add the Data Center Expert SSL certificate to the NetBotz 750

Add the SSL certificate from Data Center Expert to each NetBotz 750 you want to discover.
Otherwise, the NetBotz 750 cannot post camera clips and motion updates to Data Center
Expert.

Note: If Data Center Expert uses a self-signed certificate, it is not necessary to upload the
Data Center Expert self signed certificate to the NetBotz 750. Make sure the Verify DCE
Certificate in Trust Storeoption is unchecked on _each NetBotz 750 in the Settings >
System > DCE Surveillance option.

1. Open a web browser, and go to the Data Center Expert web client.

2. Download the certificate from the browser, and save the certificate file in Base-64
encoded X.509 format.

Save the certificate file, and click Finish.

Log in to the NetBotz 750.

Go to Settings > System > Trust Store.

Click Add.

Open the certificate file in a text editor, and copy and paste the certificate into the field.
Click Add.

Repeat steps 4-8 for each NetBotz 750 you want to discover.

©oNo O A®

4. Configure settings on Data Center Expert

1. Click Device > SNMP Device Communication Settings > Device File Transfer
Settings to add the root credentials (not superuser) for at least one NetBotz 750.
Choose the protocol SCP Only. This allows Data Center Expert to download the
device definition file (DDF) from the appliance.

2. Click Device > NetBotz Appliance Communication Settings > NetBotz
Appliance Credentials. Click Add to specify the user credentials (not root) for the
NetBotz 750 appliances you want to discover. If the credentials are different for any
of NetBotz 750 appliances you want to discover, add each appliance to the list
individually.

Warning and critical alarms can occur if Device File Transfer Settings and NetBotz
Appliance Credentials are not configured either before you discover NetBotz 750
appliances, or, during discovery if you are a Data Center Expert Server Administrator. You
can see these alarms in the Active Alarms pane in Data Center Expert.

5. Discover NetBotz 750 appliances

1. Click Device > Add devices. Select SNMPv1 or SNMPv3 depending on how your
NetBotz 750 appliances communicate.

2. Specify the IP address or address range, SNMP settings, and whether you want to
register for Priority scanning.

3. Add Device File Transfer Settings for at least one NetBotz 750 Appliance if you have
not already done so. Click Device File Transfer Settings. Add the credentials for the
root user (not superuser) for at least one of the NetBotz 750 appliances you are
discovering. Choose the protocol SCP Only.

4. Add NetBotz Appliance Credentials for your NetBotz 750 Appliances if you have not
already done so. Click NetBotz Appliance Credentials. Click Add to specify the
information for NetBotz 750 appliances you want to discover. Enter the NetBotz 750
user credentials (not root). If the credentials are different for any of NetBotz 750
appliances you want to discover, add each appliance to the list individually.

5. Choose a group, and click Finish.
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6. Configure NetBotz 750 Camera Communication Settings in Data Center Expert

If you have imported signed certificates from the NetBotz 750 Appliance, it is not necessary
to modify the NetBotz 750 Camera Communication Settings.

If you imported a self signed certificate from the NetBotz 750 Appliance, and that certificate
does not have a valid hostname:

1. Goto Device > NetBotz Appliance Communication Settings > NetBotz 750
Camera Communication Settings. Select one or more NetBotz 750 IP addresses,
and click Edit Communication Settings.

2. Select Verify certificate and click OK.

7. Configure Surveillance Settings in Data Center Expert

Go to Device > Surveillance Settings. Select the NetBotz 750 cameras you want to
license, check the box to License Cameras, and click OK. For more information, see
Surveillance Settings.

"Device Discovery" wizard

Use this wizard to create, edit, and run the processes used to discover devices the Data
Center Expert server can monitor.

You can run a discovery process once, rerun that process whenever you want, or schedule
that process to run periodically.

To access the "Device Discovery" wizard, do one of the following actions.
» Select Add Devices in the Device menu.
* Right-click on any device in the Device View or Map View, and select Add
Devices.

Click the green plus sign icon (+) in the Device View.
* Right-click anywhere in the Saved Discovery view and select Add.
» Right-click on a discovery process listed in the Saved Discovery view and select
Run, to rerun that process, or Edit, to run an edited version.
How you use this wizard will depend, in part, on the type of devices you want to discover:
SNMPv1, SNMPv3, NetBotz Appliances, or Modbus TCP.

For information about discovering NetBotz 750 Appliances, see NetBotz 750 Appliance
discovery .

"Choose Discovery Type" display

Use this display to select the type of device to be discovered.

For instructions on discovering NetBotz 750 Appliances, see NetBotz 750 Appliance
discovery .

Option Description
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SNMPvV1 (includes 200 and 750 series Select to discover devices that use standard

NetBotz Appliance) SNMP communication (includes 200 and 750
NetBotz Appliances).

SNMPv3 (includes 200 and 750 series Select to discover devices that use secure SNMP

NetBotz Appliance) communication (includes 200 and 750 NetBotz
Appliances).

300-500 series NetBotz Appliances (355, 450, | Select to discover NetBotz Rack or Wall

455, 550, 570) Appliances (355, 450, 455, 550, 570 models).

Modbus TCP Select to discover devices that use Modbus TCP

communication.

"SNMPV1 Discovery Settings" display

Use this display to define the settings used to discover SNMPv1 devices including NetBotz
250 and 750 Appliances.

For more information about discovering NetBotz 750 Appliances, see NetBotz 750
Appliance discovery .

Element Description

IP or IP Range Define the IP addresses the discovery process
will search for SNMPv1 devices. For example:

XXX.XXX.12.6: searches a single IP address.

XXX.XxX.10-13.20-80: searches a specific
set of IP addresses (20 through 80) at the
10, 11, 12, and 13 subnets.

XXX.xxX.14.*: searches all IP addresses at
subnet 14.

SNMPvV1 Settings Read Community: define the community
name to be used to read information at the
SNMPv1 devices ( public, by default).

Write Community: define the community
name to be used to control the APC devices
or register as a trap receiver at the APC
SNMPv1 devices ( private, by default).

Port: define the port number that the SNMP
devices use for communication ( 161, by
default).

Timeout: define how long the Data Center
Expert server will wait for a response, in
seconds, when it polls an IP address before
it considers the poll failed ( 2, by default).

Retries: define how many times the Data
Center Expert server will attempt to
communicate with a device at an IP
address, after the initial failure, before it
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stops trying to access a device at that
address ( 3, by default).

Trap Registration Register for Priority Scanning: select to have
the Data Center Expert server registered as a
trap receiver at discovered APC SNMPv1
devices.

Note: Priority Scanning is a trap-based polling
process that only occurs in response to traps
from APC SNMPv1 devices or informs from APC
SNMPV3 devices at which the Data Center
Expert server is defined as a trap receiver. It
allows the Data Center Expert server to
immediately poll an APC SNMP device in
response to a trap, rather than waiting to poll the
device during the normal scanning interval.

Device File Transfer Settings Click to use the display for Device File Transfer
Settings, an SNMP Device Communication
Settings option in the Settings menu, to edit,
create, or view the file transfer settings used for
FTP or SCP access to SNMP devices.

"SNMPvVv3 Discovery Settings" display

Use this display to define the settings used to discover SNMPv3 devices including NetBotz
250 and 750 Appliances.

For more information about discovering NetBotz 750 Appliances, see NetBotz 750
Appliance discovery .

Element Description

IP or IP Range Define the IP addresses the discovery process
will search for SNMPv3 devices. For example:

XXX.XXX.12.6: searches a single IP address.

XXX.XxX.10-13.20-80: searches a specific
set of IP addresses (20 through 80) at the
10, 11, 12, and 13 subnets.

XXX.xxX.14.*: searches all IP addresses at
subnet 14.

SNMPv3 Settings Username: Define the username used for
secure communication with discovered SNMP
devices.

Authentication Type/ Password: select
the authentication protocol ( None, MD5,
SHA, SHA-224, SHA-256, SHA-384,
SHA-512) and password used with that
protocol.

Encryption Type/ Password: select the
encryption method (None, DES, AES-128,
AES-192, AES-256) and password used
with the DES or AES methods.
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Port: define the port number that the SNMP
devices use for communication ( 161, by
default).

Timeout: define how long the Data Center
Expert server will wait for a response, in
seconds, when it polls an IP address before
it considers the poll failed ( 2, by default).

Retries: define how many times the Data
Center Expert server will attempt to
communicate with a device at an IP
address, after the initial failure, before it
stops trying to access a device at that
address ( 3, by default).

Trap Registration

Register for Priority Scanning: select to have
the Data Center Expert server register itself as
a trap receiver at discovered APC SNMPv3
devices.

Note: Priority Scanning is a trap-based polling
process that only occurs in response to traps
from APC SNMPv1 devices or informs from APC
SNMPv3 devices at which the Data Center
Expert server is defined as a trap receiver. It
allows the Data Center Expert server to
immediately poll an APC SNMP device in
response to a trap, rather than waiting to poll the
device during the normal scanning interval.

Device File Transfer Settings

Click to use the display for Device File Transfer
Settings, an SNMP Device Communication
Settings option in the Settings menu, to edit,
create, or view the file transfer settings used for
FTP or SCP access to SNMP devices.

"Device File Transfer Settings" display

Use this display to manage the File Transfer Protocol (FTP) or Secure Copy (SCP) access
values for APC SNMPv1 and SNMPv3 devices.

Note: Functionally identical versions of this display are used by the "SNMPv1/SNMPv3
Device Discovery," "Apply Firmware Updates," and "APC SNMP Device Configuration”
wizards, as well as by Device File Transfer Settings, an SNMP Device Communication
Settings option in the Device menu. A change saved in one display is reflected in all.

* To use FTP for APC SNMP device access, FTP server access must be enabled at

that device.

» To use SCP for APC SNMP device access, Secure Shell version 2 (SSHv2) console

access must be enabled at that device.

» For NetBotz 750, you must add the credentials for the root user (not superuser).

For more information about discovering NetBotz 750 Appliances, see NetBotz 750

Appliance discovery .
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Element Description

List Lists the access settings the Data Center
Expert server can use for FTP or SCP
access to its monitored devices.

Username: The username used for access
to a device.

Note: By default, the Data Center Expert
server can download firmware only to
devices that use apc (lowercase) for the
username and password (the actual
password used for device access is
identified in the "Edit Device File Transfer
Settings" display).

IP or IP Range: The IP address, or range of
addresses, at which the access settings
support FTP or SCP communication.

FTP Port: The port used for FTP access to
a device.

SCP Port: The port used for SCP access to
a device.

Timeout: How long the server will wait
before it considers that an attempt to access
a device has failed.

Retry Limit: How many times the server will
try to access a device, after the initial
attempt failed, before it stops trying to
access that device ( 1, by default).

Protocol: The protocol the transfer settings
set will use to access devices ( FTP only,
SCP only, or Try SCP, fall back to FTP).

Add Click to add an access setting to the list.
Edit Click to edit a selected access setting.
Remove Click to delete a selected access setting.

"Edit Device File Transfer Settings" display

Use this display to add or edit the settings the Data Center Expert server uses for File
Transfer Protocol (FTP) or Secure Copy (SCP) access to APC SNMPv1 and SNMPv3
devices.

For more information about discovering NetBotz 750 Appliances, see NetBotz 750
Appliance discovery .

Note: Functionally identical versions of this display can be accessed from the "Device File
Transfer Settings" displays used by the "Apply Firmware Updates," "SNMPv1/SNMPv3
Device Discovery," and "APC SNMP Device Configuration" wizards, and by Device File
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Transfer Settings, an SNMP Device Communication Settings option in the Device

menu.

Element

Description

Username

Identify the name used for access to a device.

Password

Identify the password used for access to a
device.

Verify Password

Retype the password.

IP or IP Range

Identify The IP address, or range of addresses,
at which the access settings support FTP or SCP
communication ( *.*.*.*, by default).

Protocol

Identify whether the transfer settings will use FTP
(FTP only), SCP ( SCP only), or attempt to use
SCP, but fall back to using FTP if SCP fails ( Try
SCP, fall back to FTP). Note: For NetBotz 750,
choose SCP only.

FTP Port

Select the port the server will use for FTP access
to devices ( 21, by default).

SCP Port

Select the port the server will use for SCP access
to devices ( 22, by default).

Timeout

Identify how long the server will wait before it
considers that an attempt to access a device has
failed ( 3000, by default).

Retry Limit

Select the number of times the server will try to
access a device, after the initial attempt failed,
before it stops trying to access that device ( 1, by
default).

"NetBotz Appliance Device Discovery Settings" display

Use this display to define the settings used to discover NetBotz Appliances.

To discover NetBotz 250 or 750 appliances, choose the SNMPv1 or SNMPv3 discovery

type.

For more information about discovering NetBotz 750 Appliances, see NetBotz 750

Appliance discovery .

Element

Description

IP Range

Define the IP addresses the discovery process
will search for NetBotz Appliances. For example:

XXX.XXX.12.6: searches a single IP address.

XXX.XxX.10-13.20-80: searches a specific
set of IP addresses (20 through 80) at the
10, 11, 12, and 13 subnets.

XXX.Xxx.14.*: searches all IP addresses at
subnet 14.

Port Range
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NetBotz Appliances ( 80, by default). For
example:

80: uses port 80 only.
60-80: uses ports 60 through 80, inclusive.

Security Mode

Select the Secure Sockets Layer (SSL) protocol
to use for communication with NetBotz
Appliances:

None
Try SSL, fall back to none
Require SSL, no certificate validation

Require SSL, validate certificates

Note: When you select this option, you must first
add the certificate from the NetBotz Appliance
you want to discover to the Data Center
Expert server. You use the "Server SSL
Certificate" display, a Server Administration
Settings option in the System menu.

NetBotz Appliance Credentials

Click to use NetBotz Appliance Credentials,
a NetBotz Appliance Communication
Settings option in the Device menu, to manage
the credentials the Data Center Expert server
uses for communication with NetBotz
Appliances.

"Modbus Discovery Settings™ display

Use this display to define the settings used to discover Modbus devices.

Modbus TCP devices with static IP addresses can be discovered on the public LAN; on
Network A on the private LAN, when DHCP discovery is disabled (enabled by default); or
on one segment you define on Network B on the private LAN.

Note: Modbus TCP device discovery entries are not stored in the "Saved Discoveries" list.

Element

Description

Single IP Address

Define the IP address the discovery process will
search for a Modbus device.

Select Device Type

Define the device type from the list of those
supported by the Data Center Expert server.

Server Address

Define the address of the device associated with
the Modbus client IP address

Port

Define the port the Modbus device uses for
communication (502, by default).

Timeout (seconds)

Define how long the Data Center Expert server
will wait for a response, in seconds, when it polls
an IP address before it considers the poll failed

(5, by default).
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"Choose Device Group™" display

Use this display to select one device group into which to place the discovered devices, the
Unassigned group by default.

Server Administrator users can place devices into any device group. Device Administrator
users can place devices into only the device groups to which they have access.

For more information, see Device Group Access (Users tab).

"Discovery Scheduling™ display

Use this display to schedule a discovery process to run periodically, to run a discovery
process when you are done defining that process, or both.

Option Description

Enable discovery scheduling Select to schedule when a discovery process will
run automatically, by the day, or days, of the
week, and time of day.

Run discovery now Select to run the discovery process when you exit
the wizard.

Saved Discoveries view

When you create a device discovery process, information about that process is listed in this
view. Information about the device group selected during the SNMPv1 and NetBotz
Appliance discovery process is not included.

Note: Wait a few minutes after a discovery process reports it is idle before you consider
that it failed to discover all the devices it should have. The Data Center Expert server can
take more time to list discovered devices in the Unassigned group in the Device
Groups view, than it takes the discovery process to discover those devices.

Column Description
IP Range The IP addresses the discovery process will search for devices.
Run Whether the process is scheduled to run periodically: Yes or No.
Periodically
Type The devices the process will discover: SNMPv1, SNMPv3, or

NetBotz Appliance.

Activity Whether the discovery process is running or idle.
Last Run The time at which the last discovery process finished.

This Saved Discoveries view also has right-click menu options and button icons that
manage the discovery processes.
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Option Description

Add Accesses the "Device Discovery" wizard to create a new discovery
process.

Edit Accesses the "Device Discovery" wizard to edit a selected discovery
process.

Delete Deletes a selected discovery process.

Run Runs a selected discovery process.

Stop Stops a selected discovery process, when that process is running.

Import Import the SNMPv1 or NetBotz Appliance discovery entries from a

Discovery local file.

Entries

Export Export the SNMPv1 or NetBotz Appliance discovery entries to a local

Discovery file.

Entries

"Export Discovery Entries" display

Use this display to export information about the selected saved device discovery processes

to a local file.

Note: Information about the device group selected during the SNMPv1 and NetBotz
Appliance discovery process is not included.

Element

Description

Choose File

Select the location to save a copy of the device
discovery properties as a *.txt file.

List

Lists the saved discovery processes, and
provides the following information about
each:

IP or IP Range: The IP addresses the
discovery process searched for devices.

Type: The devices the process
discovered: SNMPvlor NetBotz
Appliance.

Parameters: The network settings the
discovery process used.

Export

Click to export the selected device discoveries to
the local drive.

"Import Discovery Entries™ display

Use this display to import saved device discoveries from a local file.
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Element Description
Choose File Select the location to import the device discovery
as a *.txt file.
List Lists the imported discovery processes, and
provides the following information about
each:

IP or IP Range: The IP addresses the
discovery process searched for devices.

Type: The devices the process
discovered: SNMPvlor NetBotz
Appliance.

Parameters: The network settings the
discovery process used.

Device Transfer File Settings Accesses the display used to manage the
settings the Data Center Expert server uses
for File Transfer Protocol (FTP) or Secure Copy
(SCP) access to APC SNMPv1 devices.

NetBotz Appliance Credentials Accesses the display used to manage the list of
credentials used for communication with the
NetBotz Appliances.

Import Click to import the selected device discoveries to
the Saved Discoveries view.

Discovery Entries file format

Use this file format to import SNMPv1 and NetBotz Appliance device discovery entries to
the Saved Discoveries view from a local *.txt file. Information about the device group
selected during the discovery process is not included.

Note: You cannot import device discovery entries for SNMPv3 or Modbus devices.

Format for SNMPv1:

SNMPvV1:<IP Address or Range>:<port>:<timeout>:<retries>:<trap registration (true or
false)>:<read community>:<write community>

Example: SNMPv1:10.218.10-15.*:161:2:3:true:public:private
Format for NetBotz Appliance:

NetBotz Appliance:<IP Address or Range>:<port>:<security mode (HTTP or
HTTPS_AVAIL_NO_VERIFY or HTTPS_REQ_NO_VERIFY or HTTPS_REQ_VERIFY)>

Example: NetBotz Appliance:10.218.10.166:80:HTTP
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Device firmware and server updates

The Updates menu provides options you can use to update the Data Center Expert server,
or to download firmware updates from APC, and then use FTP, to upload them to the
network management cards (NMCs) at monitored APC SNMP devices, or HTTP/HTTPS,
to upload them to monitored NetBotz Appliances.

Schedule Update Checks (Updates menu)

Use this display to schedule when the Data Center Expert server will check the APC
updates server for firmware updates that can be used for its monitored devices, either on
a one-time or recurring basis.

Available firmware updates are downloaded to the server, and listed in the "Load Firmware
Updates" display in the "Update Device Firmware" wizard.

Note: A message near the bottom of the display can report when the next scheduled update
check will occur, or that the checking service is disabled.

Type Description
Check for Updates Select to use the Date, Time, and
Recurrence settings to schedule update checks.
Date Define the date when the update check will occur.
Time Define the time of day that update check will
occur.
Recurrence Define how often the update check will occur,

either Once, at the defined date and time, or
recurring Daily, Weekly, or Monthly, starting
at the defined date and time.

Status messages: "Schedule Update Checks" display

Four different status messages can appear when you use the display for Schedule Update
Checks in the Settings menu.

Message Description

The next update check is set to occur on| Reports the date and time for the next
<Date> at <Time>. scheduled update check.

Recommended Action: None

The scheduled update checking service | The Check for Updates option is not
is disabled. selected.

Recommended Action: Select to enable
scheduling.

98



EcoStruxure IT Data Center Expert 8.1.0

Message Description
Unable to schedule the specified update| An unexpected server error occurred.
check. Recommended Action: Try again. If the
problem persists, contact APC Support
( http://www.apc.com/support ).
Cannot schedule the updates check. You attempted to use an invalid date or time

Based on the server's time settings, the | to schedule a check for updates.
selected time is in the past.

Recommended Action: Use a time setting
that is in the future.

Apply Firmware Updates (Updates menu)

Use this option to update the firmware at NetBotz Appliances, using HTTP/HTTPS, or at
SNMP devices, using FTP.

Performing a firmware update

You use the "Select Device Updates" display, accessed from the Apply Firmware Updates
option, to update firmware at the SNMP devices and NetBotz Appliances monitored by
the Data Center Expert server.

1.
2.

In the Updates menu, select Apply Firmware Updates.
In the "Select Device Updates" display, do one of the following, depending on whether
the Data Center Expert server has internet access.

* Internet access available: click Check Updates to check if any appropriate
updates (SNMP devices or NetBotz Appliances) are available from the APC
updates server that are more recent than the catalog, if any, currently installed
at the Data Center Expert server.

* Internet access unavailable: click Importtoimportthe SNMP devices or NetBotz
Appliance catalog at the Data Center Expert server.

In the "Device File Transfer Settings” display (SNMP devices), add new settings, or
edit existing settings, as needed, and click Finish.

Note: Two options in the Device menu allow you to manage the FTP, SCP, and
global NetBotz Appliance credentials without accessing the Apply Firmware
Updates option: Device File Transfer Settings, an SNMP Device Communication
Settings option in the Device menu, and NetBotz Appliance Credentials, a
NetBotz Appliance Communication Settings option in the Device menu.

Select the devices you want to update from the devices listed for each available
firmware update, and click Apply Updates.

Note: If no updates are available, click Close.
In the Window menu, select Firmware Update Status, a Device option.
In the update status view, review the progress for the selected updates.

Importing the APC updates catalog

You can download a copy of the APC device firmware update catalog (for SNMP devices
and NetBotz Appliances) to your client, and then import that catalog to the Data Center
Expert server, when that server does not have internet access to the APC updates server.
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Note: If your DCE client does not have access to the internet, you will need to download
the updates catalog to a machine that does have access, and transfer the file to your client.
1. Download the DCE Device Firmware Update Catalog from https://www.apc.com/us/
en/product/SFSWCDFCF/dce-device-firmware-catalog-file/.
2. Once the updates catalog is downloaded, select Apply Firmware Updates in the
Updates menu in the Data Center Expert client.
3. In the "Select Device Updates" display, click Import.
4. Inthe "Open" display, browse to the downloaded APC updates catalog, and click

Open.

5. Go to step 4 of the Performing a firmware update task to update devices using the

imported APC updates catalog.

"Select Device Updates" display

Use this display to select the NetBotz Appliances or SNMP devices at which you want to

perform a firmware update.

Element

Description

Search

Use the Search field to filter the list based
on the text you type.

Note: Only the Boolean operators AND, OR, and
NOT are supported.

Configure Columns icon

Use the Configure Columns icon to identify the
attribute columns that appear in the list.

List

Use this list, which identifies the available
updates, and the appliances or devices that can
use each, to select the ones you want to update.

To select all devices listed for an available
update, select the update.

To select some, but not all, select the device
or devices, but not the update.

Select/Deselect All

Select all the devices for all the updates.

Update Description

Provides information about the update selected
in the list.

Check Updates

Click to download any firmware updates
available from the APC updates server for the
Data Center Expert server's monitored devices,
when the server has internet access.

Import

Click to import the APC updates catalog to the
server from your client, when the server that has
no internet access.

Note: A copy of the APC updates catalog zip file
must already be downloaded to your client from
APC.

Device File Transfer Settings
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Device Discovery" and "APC SNMP Device
Configuration" wizards, as well as by Device
File Transfer Settings, an SNMP Device
Communication Settings option in the
Settings menu. A change saved in one display
is reflected in all.

Apply Updates Click to perform a firmware update.

"Device File Transfer Settings" display

Use this display to manage the File Transfer Protocol (FTP) or Secure Copy (SCP) access
values for APC SNMPv1 and SNMPv3 devices.

Note: Functionally identical versions of this display are used by the "SNMPv1/SNMPv3
Device Discovery" and "APC SNMP Device Configuration” wizards, as well as by Apply
Firmware Updates, an option in the Updates menu, and Device File Transfer
Settings, an SNMP Device Communication Settings option in the Settings menu. A
change saved in one display is reflected in all.

* To use FTP for APC SNMP device access, FTP server access must be enabled at
that device.

* To use SCP for APC SNMP device access, Secure Shell version 2 (SSHv2) console
access must be enabled at that device.

Element Description

List Lists the access settings the Data Center
Expert server can use for FTP or SCP
access to its monitored devices.

Username: The username used for access
to a device.

Note: By default, the Data Center Expert
server can download firmware only to
devices that use apc (lowercase) for the
username and password (the actual
password used for device access is
identified in the "Edit Device File Transfer
Settings" display).

IP or IP Range: The IP address, or range of
addresses, at which the access settings
support FTP or SCP communication.

FTP Port: The port used for FTP access to
a device.

SCP Port: The port used for SCP access to
a device.

Timeout: How long the server will wait
before it considers that an attempt to access
a device has failed.
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Element

Description

Retry Limit: How many times the server will
try to access a device, after the initial
attempt failed, before it stops trying to
access that device ( 1, by default).

Protocol: The protocol the transfer settings
set will use to access devices ( FTP only,
SCP only, or Try SCP, fall back to FTP).

Add Click to add an access setting to the list.
Edit Click to edit a selected access setting.
Remove Click to delete a selected access setting.

"Edit Device File Transfer Settings" display

Use this display to add or edit the settings the Data Center Expert server uses for File
Transfer Protocol (FTP) or Secure Copy (SCP) access to APC SNMPv1 and SNMPv3

devices.

Note: Functionally identical versions of this display can be accessed from the "Device File
Transfer Settings" displays used by the "SNMPv1/SNMPv3 Device Discovery" and "APC
SNMP Device Configuration" wizards, as well as by Device File Transfer Settings,
accessed from Apply Firmware Updates, an option in the Updates menu, and by Device
File Transfer Settings, an SNMP Device Communication Settings option in the

Settings menu.

Element

Description

Username

Identify the name used for access to a device.

Password

Identify the password used for access to a
device.

Verify Password

Retype the password.

IP or IP Range

Identify The IP address, or range of addresses,
at which the access settings support FTP or SCP
communication ( *.*.*.*, by default).

Protocol

Identify whether the transfer settings will use FTP
(FTP only), SCP ( SCP only), or attempt to use
SCP, but fall back to using FTP if SCP fails ( Try
SCP, fall back to FTP).

FTP Port

Select the port the server will use for FTP access
to devices ( 21, by default).

SCP Port

Select the port the server will use for SCP access
to devices ( 22, by default).

Timeout

Identify how long the server will wait before it
considers that an attempt to access a device has
failed ( 3000, by default).

Retry Limit

Select the number of times the server will try to
access a device, after the initial attempt failed,
before it stops trying to access that device ( 1, by
default).
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Firmware Update Status view

An update status view is available using the Firmware Updates option accessed from

Device in the Window menu.

Element

Description

List

Provides information about the update at each
device selected for a firmware updates process,
either an ongoing process, or the last process
performed.

Hostname: the device hostname or IP
address

Model: device model

Location: location information for the
device

Status: status of the update

App Version: application (App) version
number of the update

OS Version: operating system (OS) version
number of the update

Note: Reported for SNMP device updates
only.

Time Completed: when the update finished

Firmware Update Progress

Identifies the number of Updates in progress,
Updates canceled, Updates completed, and
Successful updates.

Cancel Pending Updates

Click to cancel pending device updates.

Note: The Data Center Expert server can
process device updates for up to 20 devices
at a time. This button appears in the
Firmware Update Status view only, and
only when more than 20 devices were
selected to be updated.

For example, if 77 devices are selected,
Cancel Pending Updates appears when
the first set of 20 devices begins to be
processed. You can click Cancel Pending
Updates at this point to cancel the
remaining 57 updates.

If you chose not to cancel the pending
updates, the button remains in the view
while the second and third sets of 20 devices
are processed, and disappears when the
last set of 17 devices begins to be
processed.
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Status messages: Firmware Update Status view (APC SNMP Devices)

Several different status messages can be reported in this view for SNMP device updates
initiated by using Apply Firmware Updates in the Updates menu.

Message Description
<Cancelled count> firmware updates The number of pending firmware updates
have been cancelled. that were cancelled.

Recommended Action: None

Attempting to connect to the device... The server is trying to connect to the device.

Recommended Action: None

Attempting to log on to the device... The server is trying to log on to the device.

Recommended Action: None

Failed to update device: file verification | A problem occurred, after the server

failed for <file type> <file version>. transferred the update to the device
successfully, that prevented the server from
verifying that the update at the device
matches the update sent to the device.
CAUTION: The device will not function
correctly if the update at the device does not
match the update from the server.

Recommended Action: Make sure the
access settings have not changed at the
server or device, and the appropriate file
transfer protocol is still enabled at the
device.

Make sure the device has not been turned
off or disconnected from the network.

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Failed to update device firmware. An unknown error occurred.

Recommended Action: Make sure the
device is turned on and online, the
appropriate file transfer protocol is enabled
at the device, and that the "Device File
Transfer Settings" display settings are
correct.

Correct any network connection problem.
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Message

Description

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Failed to update the device: unable to
connect.

A network or file transfer protocol
communication problem exists.

Recommended Action: Make sure the
device is turned on and online, the
appropriate file transfer protocol is enabled
at the device, and that the "Device File
Transfer Settings" display settings used to
access the device include the device's
correct port number.

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Failed to update device: unable to log on.

The server does not have the appropriate
file transfer protocol settings needed to log
on to the device, or communication was lost
after the connection was successful.

Recommended Action: Make sure the
access settings needed to log on to the
device are defined in the "Device File
Transfer Settings" display, and the
appropriate file transfer protocol is still
enabled at the device.

Make sure the device has not been turned
off or disconnected from the network.

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Failed to update device: unable to
transfer <file type> <file version>.
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A problem occurred, after the server logged
on to the device successfully, that prevented
the server from transferring the update.

Recommended Action: Make sure the
access settings have not changed at the
server or device, and the appropriate file
transfer protocol is still enabled at the
device.

Make sure the device has not been turned
off or disconnected from the network.

Correct any network connection problem.
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Message

Description

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Successfully connected to the device.

Now the server can attempt to log on to the
device.

Recommended Action: None

Successfully logged on to the device.

Now the server can attempt to transfer the
update to the device.

Recommended Action: None

Successfully transferred <file type> <file
version> to the device.

Now the server can attempt to verify that the
update at the device matches the file used
for the update.

Recommended Action: None

Transferring <file type> <file version> to
the device...

The server is trying to transfer the update to
the device.

Recommended Action: None

Unable to log on to the device: waiting to
retry...

The server has failed at least one attempt to
log on to the device, but has not reached its
retry limit.

Recommended Action: None

Unable to transfer <file type> <file
version>: waiting to retry...

The server has failed at least one attempt to
transfer the update to the device, but has not
reached its retry limit.

Recommended Action: None

Unable to verify <file type> <file
version>: waiting to retry...

The server has failed at least one attempt to
verify the update at the device matches the
update sent by the server, but has not
reached its retry limit.

Recommended Action: None

Update cancelled.

The update was cancelled.

Recommended Action: None

Update completed successfully.

The update was successful.

Recommended Action: None

Update pending...

An update is pending, but not started.

Recommended Action: None

Update started...

An update has started.

Recommended Action: None

Verifying transfer of <file type> <file
version> to the device...

106

The server is trying to verify that the update
at the device matches update sent by the
server.



http://www.apc.com/go/direct/index.cfm?tag=support

EcoStruxure IT Data Center Expert 8.1.0

Message

Description

Recommended Action: None

Verified update to <file type> <file
version>.

The server verified that the update at the
device matches the update sent by the
server.

Recommended Action: None

Waiting for <file type> <file version> to
load...

The server is waiting for the device to
restart, using the update that was
transferred.

Recommended Action: None

Would you like to cancel the pending
firmware updates?

You have selected to cancel at least one
pending update.

Recommended Action: Click Yes to
continue with the cancellation.

Status messages: Firmware Update Status view (NetBotz Appliances)

Several different status messages can be reported in this view for NetBotz Appliance
updates initiated by selecting Apply Firmware Updates in the Updates menu.

Message

Description

Failed to update device firmware.

An unknown error occurred.

Recommended Action: Make sure the
NetBotz Appliance is turned on and online,
its HTTP or HTTPS web service is enabled,
and the "NetBotz Appliance Credentials"
display accessed from Server
Administration in the Settings menu
includes the correct IP Address, Port,
Username, and Password settings.

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Failed to update the device: unable to
connect.
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A network or HTTP/HTTPS communication
problem exists.

Recommended Action: Make sure the
NetBotz Appliance is turned on and online,
its HTTP or HTTPS web service is enabled,
and the "NetBotz Appliance Credentials"
display accessed from Server
Administration in the Settings menu
includes its correct IP address and port
settings.
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Message Description

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Failed to update device: unable to log on.| The server does not have the FTP access
settings needed to log on to the device, or
communication was lost after the
connection was successful.

Recommended Action: Make sure the
"NetBotz Appliance Credentials” display
accessed from Server Administration in
the Settings menu includes the correct
Username and Password for the NetBotz
Appliance.

Make sure the device has not been turned
off or disconnected from the network.

Correct any network connection problem.

If the problem persists, contact APC
Support ( http://www.apc.com/support ).

Note: Once the problem is corrected,
select Apply Firmware Updates in the
Updates menu to update the device.

Transferring update... ({0}% The update is being transferred, with how
much of the transfer has occurred reported
as a percentage.

Update completed successfully. The update was successful.

Recommended Action: None

Update pending... The update is pending, but not started.

Recommended Action: None

Update started... The update has started.

Recommended Action: None

Waiting for NetBotz Appliance to load The update still needs to be loaded at the
update... NetBotz Appliance.

Recommended Action: None

Apply Server Update (Updates menu)

Use this option to update your Data Center Expert server when a new version becomes
available.
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Performing a server update

You select the "Apply Server Update" option to import a server update package list file from
your local machine, and install the server update.

1.

2.
3.

Before beginning this procedure, you must have received an update notification from
APC Support, and contacted them to download the appropriate update file.

In the Updates menu, select Apply Server Updates.

In the "Apply Server Update" display, click the Import button and navigate to the
downloaded *.Ist file. Click Open to list the available updates in the display.
Highlight the desired update and click Install Update. A dialog opens that states
"Installing this Data Center Expert update will cause the server to reboot. Would you
like to continue?"

Click Yes to confirm your selection and begin the update process.

When the update is complete, users attempting to log in will receive a message stating
that the client and server are different versions. A link will be provided to download
the updated client from the Data Center Expert server. Click the link to display the
download page for the updated client.

Download and install the new client and log in to the updated server.

Open the Help menu and select the About Data Center Expert menu item. The
display should reflect the new server version.

109



EcoStruxure IT Data Center Expert 8.1.0

Device groups feature

Data Center Expert allows you to logically organize monitored devices into smaller device
groups. For example, into all devices within a specific building, or on the same IP segment.
» Device groups can have subgroups. For example, to organize the devices within a
building on a floor-by-floor, or datacenter-by-datacenter basis.
« Device groups and subgroups use icons to indicate the following about the status of

their devices.

d All devices are operating normally.

At least one device has a warning condition.

At least one device has a critical, error, or failure condition.

Device Groups view

This view, which lists the groups to which devices are assigned, is displayed, by default,
when the Monitoring or Surveillance perspective is selected.

Note: For information about how this view is used in the Surveillance perspective, see

Surveillance.

The Device Groups view lists the following types of groups in a hierarchical format.
Note: The All Devices and Unassigned groups cannot be deleted or renamed.

All Devices This group includes all discovered devices, including any that have been
assigned to a user-defined device group.
Unassigned This group includes all discovered devices that are not assigned to a user-

defined device group.

User-defined device

groups

Each group or subgroup includes the devices that have been assigned to that
group.

The Device Groups View, which interacts with every view except Camera view in some
way, can be used to do the following:

» Use the Device View to assign devices to groups by dragging and dropping from one

group to another.

» Access information about the device alarms at any selected group in the Active

Alarms view.

» Select a device group for which you want to have camera information displayed in
the Thumbnails view.

* Use the Thumbnails view to assign camera devices to groups by dragging and
dropping from one group to another.

» Use right-click options, and the button icons at the top of the view, to perform the

following functions.

» Create anew group, when All Devices is selected, or subgroup, when any other
group, except Unassigned, is selected ( Create Device Group option).

« Edit a selected group, other than All Devices and Unassigned ( Rename
Device Group option).
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Delete a selected group, other than All Devices and Unassigned ( Delete
Device Group option).

Access the Alarm History view for any selected group ( Show Alarm
History option).

Access a 24-hour Graph View for up to 50 of a specific sensor type for a selected
device group ( Graphing and Reporting sensor options).

Note: For more information about this view, see Graph View under Graphing
and Reporting feature.

Initiate the process used to create a report or graph for the historical values of
the sensors at selected devices ( Custom Device Report option or graph icon).
Access a specific configuration option for a selected NetBotz Appliance or
Appliances ( NetBotz Appliance Configuration options).

Note: A NetBotz Appliance Configuration option is also in the Device menu.
For information about these options, see NetBotz Appliance Configuration .
Configure selected APC SNMP devices to use the same values for shared
settings ( APC SNMP Device Configuration option).

Note: An APC SNMP Device Configuration option is also in the Device menu.
For information about these options, see APC SNMP Device Configuration .
Create thresholds for a selected device, or set of devices ( Create
Thresholds option).

Note: For information about this option, see Create Thresholds option,
under Alarm Configuration .

Disable or re-enable notifications for any SNMP or Modbus device, or device
group ( Enter/Exit Maintenance Mode options).

Access the Custom Properties Editor view to add, modify, or remove custom
properties for selected devices or sensors ( Open Custom Properties Editor
option).

Create a virtual sensor for a selected device group ( Create Virtual Sensor
option).

Note: For information about this option, see Virtual Sensors view.

Device group management

You can manage the device groups, and the devices assigned to those groups.

» Use the right-click menu in the Device Groups view to create, edit, or delete groups.
» Use the Device View to define which devices are assigned to which groups.

Managing the device groups

You can create, edit, and deleted device groups.

Creating a device group

1.

aprpwN

o

In the Device Groups view, right-click one of the following device groups:

All Devices, to add a new group.
A user-defined group, to add a subgroup to the selected group.

Click Create Device Group.

Enter a name for the group or subgroup.

Enter an address for the device group (optional), and click Finish.

Assign devices to the new group by dragging and dropping devices from the Device
View.

Click Device Group Access to edit the user and user group monitoring and
surveillance access to the device group, as needed.
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Editing a device group

1.
2.
3.

In the Device Groups view, right-click the group or subgroup you want to rename.
Click Edit Device Group.
Enter a name for the group or subgroup, or change the address, and click Finish.

Deleting a device group

1.
2.
3.

In the Device Groups view, right-click the group you want to delete.
Click Delete Device Group.
Click Yes in the "Confirmation" display.

Assigning or moving devices to device groups

You can assign devices to a device group, change the device group assignments by moving
devices from one user-defined group to another, or assign devices to multiple device
groups.

Moving devices from one group to another group

1.

2.

Inthe Device Groups view, select the group in which the devices are currently located
(including Unassigned).
In the Device View, highlight the devices you want to move.

Note: To move a NetBotz Appliance, and its supported devices, highlight its main
listing; if you highlight a device associated with a NetBotz Appliance, a copy of that
device will move, and a copy remains with the NetBotz Appliance listing.

Drag the selected devices from the Device View to the desired group in the Device
Groups view.

Note: When devices are assigned to a subgroup, those devices are included in its
parent group, as well.

Assigning devices to multiple groups

1.

n

4.

In the Device Groups view, select a group that contains one or more of the devices
you want to assign to multiple device groups.

Note: For devices in the Unassigned group, move them to one of the groups in
which you want those devices assigned, then select that group.

In the Device View, highlight the devices you want to copy to another group.

Hold the Ctrl| key down, and drag copies of the selected devices from the Device
View to the desired group in the Device Groups view, including all devices associated
with a NetBotz Appliance, when that appliance's main listing is selected.

Note: For a device associated with a NetBotz Appliance, you can drag a copy to
another group without using the Ctrl key.
Repeat until all devices are in the correct device groups.

Removing devices from device groups

You can remove devices from a group by dragging those devices from that group, or by
using the Delete Devices right-click option in the Device View.

Note: Removing devices from a group does not delete them from Data Center Expert
server.
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Dragging devices out of device groups

When a device is assigned to multiple device groups, you will need to repeat this procedure
for each device group.
1. Inthe Device Groups view, select a device group to which the devices are currently
assigned.
2. Inthe Device View, highlight the devices you want to remove.
3. Drag the devices to Unassigned in the Device Groups view.

Note: If you want to assign those devices to another group, you can drag them to that
group instead of to Unassigned.

Using the right-click option in the Device View

When a device is assigned to multiple device groups, you will need to repeat this procedure
for each device group.
1. Inthe Device Groups view, select a device group to which the devices are currently
assigned.
2. Inthe Device View, highlight the devices you want to remove.
3. Right-click one of those devices, and highlight the Remove the device from group
option.
4. Select the name of the group from which you want the devices moved.

Note: The devices will be moved back to the Unassigned group.
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Users and Device Group Access (System menu)

Use the "Users and Device Group Access" option in this display to manage local and remote
user access to the Data Center Expert server and its features and functions, and to manage
the access those users have to the monitoring and surveillance data available for each

device group in the Device Groups view.

Note: To logon to the Data Center Expert server, a user must have at least View Access
for one device group that contains a minimum of one device.

The "Users and Device Group Access" display has two tabs, one with two sections.

Users and User Group Details (Users tab)

Use this section in the "Users and Device Group Access" display Users tab to manage the
users and user groups that can access the Data Center Expert server.

Information about the users and user groups is provided in a table:

Column

Description

User or User Group Name

Lists the user groups, including default

( Device Administrators, Device
Viewers, Server Administrators, and
Unassigned Users) and user-created
groups. Users are listed under the user
group to which they are assigned (local
users not assigned to another group are
listed under Unassigned Users; remote
users are listed only under Remote
Users).

Note: This column is used in the Device
Group Access section of the Users tab, as
well.

Full Name Identifies the full name for a local user only,
when defined in its "User Configuration"
display.

Type Identifies each user or user group by its

specific type.

Local User

Remote User

Local User Group
Remote User Group
Unassigned Users Group

Remote Users Group

Data Center Expert Administrator
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Column Description

access to all server features and functions
(Yes or No).

You use buttons or right-click options to add new local users or local user groups, and to
edit or delete users or user groups, whether local or remote.

Note: Remote users and user groups are added using the "Users and Device Group
Access" display Authentication Servers tab.

* Add a local user using the "User Configuration" display ( Add User button or right-
click option).

Note: You can select right-click and local device group and click Add User to
Selected Group to add a new user directly to the selected group (this option is
unavailable when a remote user group is selected).

* Add a local user group using the "User Group Configuration" display ( Add User
Group button or right-click option).

 Edit the credentials, user roles, and user group membership for a selected local user
using the "User Configuration” display ( Edit button or right-click option).

« Edit the name, user group roles, and user group members for a selected local user
group using the "User Group Configuration" display ( Edit button or right-click option).
Note: You cannot edit the Unassigned Users group, a group that lists local users
that are not assigned to another local user group.

« Edit the user roles for a selected remote user using the "User Configuration" display
( Edit button or right-click option).

« Edit the user group roles for a selected remote user group using the "User Group
Configuration” display ( Edit button or right-click option).

Note: You cannot edit the Remote Users group, listed in the table only when at least
one authentication server has been added using the Authentication Servers tab.

» Delete a local or remote user or user group ( Delete button or right-click option).
Note: You cannot delete the Remote Users group, listed in the table only when at
least one authentication server has been added, or the Unassigned Users group,
which is always listed.

* Access the Device Group Access section of the Users Tab ( Device Group
Access button or right-click option).

Managing a local user

Use the "User Configuration" display to add or edit a local user.

Note: To delete a local user, select that user in the Users and User Group Details section
of the Users tab, and click Delete.

1. Inthe Users and User Group Details section of the Users tab, click Add User to
add a local user, or select a listed local user and click Edit User to access the "User
Configuration" display.

2. Inthe User Information tab:

a. Inthe User Credentials section, define the credentials.
b. Inthe User Roles section, select the role or roles for the user, if any.

Note: If you selectthe Data Center Expert Administrator role, click OK to
exit the "User Configuration" display: this role provides full access to all server,
monitoring, and surveillance functions; settings in the User Group
Memberships and Device Group Privileges tabs will have no affect on the
user's privileges.

c. If you want the user disabled, deselect Enable this User.
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3. Inthe User Group Memberships tab, select the local user groups to which you want
the user to belong, if any.

Note: If you select a user group with Data Center Expert Administrator identified
in its Roles column, selecting any other user group will have no affect on user
privileges: this user group provides full access to all server, monitoring, and
surveillance functions.

Managing a local user group

Use the "User Group Configuration” display to add or edit a local user group.

Note: To delete a local user group, select that group in the Users and User Group
Details section of the Users tab, and click Delete.

1. Inthe Users and User Group Details section of the Users tab, click Add Group
to add a local user group, or select a listed local user group and click Edit to access
the "User Group Configuration” display.

2. Inthe User Group Information tab.

a. Define a name for the group.
b. Select the role or roles for the group, if any.

Note: The Data Center Expert Administrator role provides full access to all
server, monitoring, and surveillance functions to any user assigned to the group.
3. Inthe User Group Members tab, select the local users you want assigned to the
group, if any.

Managing a remote user

Use the "User Configuration” display to edit the user role assigned to a remote user.

Note: To add a remote user, use the Authentication Servers tab; to delete a remote user,
select that user in the Users and User Group Details section of the Users tab and
click Delete.
1. Inthe Users and User Group Details section of the Users tab, select a listed remote
user and click Edit, to access the "User Configuration” display.

Note: For a remote user, only the User Roles selections in the User Information
tab are available.
2. Inthe User Roles section, select a role for the user, if any, and click Apply.

Note: The Data Center Expert Administrator role provides full access to all server,
monitoring, and surveillance functions.

Managing a remote user group

Use the "User Group Configuration” display to edit the user role assigned to a remote user
group.

Note: To add aremote user group, use the Authentication Servers tab; to delete aremote
user group, select that group in the Users and User Group Details section of the
Users tab and click Delete.
1. Inthe Users and User Group Details section of the Users tab, select a listed remote
group and click Edit, to access the "User Group Configuration" display.
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Note: For a remote user group, only the User Roles selections in the User Group
Information tab are available.

2. Inthe User Group Roles section, select the role or roles for the group, if any, and
click Apply.

Note: The Data Center Expert Administrator role provides full access to all server,
monitoring, and surveillance functions.

"User Configuration™ display

Use this display to add a local user, or to edit the settings for an existing local or remote
user.

The "User Configuration” display has two tabs; one tab has two sections.

User Credentials (User Information tab)

Use this tab to define the credentials for a local user only.

Credential Definition

Username Identify the name used to log on to the
server.

Password Type in the password to be used to log on
to the server.

Verify password Retype the password.

Full name (optional) Identify the user's full name.

E-mail address (optional for non- Data Identify the user's email address.

Center Expert Administrators) Note: This address is used to send e-malil

to a Data Center Expert Administrator

for notifications related to the Data Center
Expert server itself, and monitored NetBotz
Appliances, but not for monitored SNMP or
Modbus devices.

Description (optional) Identify a role, title, or other attribute that
describes the user.

User Roles or User Group Roles (User or User Group Information tab)

Use this tab to select the role you want to assign to a local or remote user or user group.

Note: For a non- Data Center Expert Administrator user, including a user for which no
role is selected, access privileges are determined by Device Group Access settings in
the Users tab for that user, and for the user groups to which the user is assigned.

Role Description

Data Center Expert Administrator Full access to all server, monitoring, and
surveillance functions for all device groups.
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Role

Description

Note: The Data Center Expert Proxy is
included automatically when the Data
Center Expert Administrator role is
selected.

Data Center Expert Proxy

Telnet access from the Data Center
Expert server's public network to devices on
its private network. Provides no access to
server, monitoring, or surveillance
functions, except as defined by other
settings:

Local Users: User Group Memberships
tab, and Device Group Access settings in
the Users tab

Remote Users: Device Group Access
settings in the Users tab

Local or Remote User groups: Device
Group Access settings in the Users tab

Note: Before a Data Center Expert
Proxy user can use Telnet to access a
private-side device, Telnet must be enabled
at that device, and SOCKS Proxy, a
Server Access option for Server
Administration Settings in the System
menu, must be enabled.

User Group Memberships tab

Use this tab to select the user groups to which you want to assign a local user.

Note: Local users cannot be added to remote user groups; remote users cannot be added

to any user group, local or remote.

This tab lists all local user groups, allowing you to select the groups to which a local user
is assigned. Three of those user groups are provided, by default.

Note: The user will be listed under any user group in the "Users and Device Group Access
display's Users tab to which it is assigned in its User Group Memberships tab.
» Device Administrators: by default, this user group provides Administration
Access for monitoring, and No Access for surveillance, at all device groups.
» Device Viewers: by default, this user group provides View Access for monitoring,
and No Access for surveillance, at all device groups.
« Server Administrators: by default, this user group provides the same access as
the Data Center Expert Administrator user role: full access to all server, monitoring,

and surveillance functions.

Note: You can edit the default names and access privileges for any of these user

groups.

"User Group Configuration™ display

Use the tabs in this display to add or edit a local user group, including defining its roles and
members, or to edit the roles only for a remote user group.
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The "User Group Configuration” display has two tabs; one tab has two sections.

Group Name (User Group Information tab)

Use this setting to define the name for a local user group only.

User Group Members tab

Use this tab to select the local users you want to assign to a local user group.

Note: Local users cannot be added to remote user groups; remote users cannot be added
to any user group, local or remote.

Lists all local users, allowing you to select which of those users you want assigned to the
user group.

Note: A user selected in this tab will be listed under the user group in the "Users and Device
Group Access" display's Users tab.

Device Group Access (Users tab)

Use this section in the "Users and Device Group Access" display's Users tab to manage
the monitoring and surveillance access you want a user or user group to have at each device

group.

Note: These settings are accessed by selecting the right-click Device Group Access
option for any device group in the Device Groups view, or by clicking Device Group
Access in the "Users and Device Group Access" display's Users tab.

To manage the access settings, select a listed user or user group and click Modify Device
Group Access to access the "Device Group Access" display. However, this button is
inactive for the following entries:
e The Unassigned Users group
* The Remote Users group
Note: This users group is listed only when at least one authentication server has been
added using the Authentication Servers tab.
* The primary Data Center Expert Administrator user ( apc, by default).
* Any user or user group that has Data Center Expert Administrator selected for its
role.
Note: You can change this role for any user or user group except the primary Data
Center Expert Administrator user ( apc, by default).

Membership in a user group can affect a user's monitoring and surveillance access at the
device groups. The settings that provide the least-restrictive access, whether it is the user's
or user group's Device Group Access settings, define the access a user has. For example,
if a user with No Access for surveillance at a device group belongs to a user group with
View and Tag Access for surveillance at that device group, that user has View and Tag
Access.

Column Description

User or User Group Name Lists the user groups, including default ( Device
Administrators, Device Viewers, Server
Administrators, and Unassigned Users) and
user-created groups. Users are listed under the
user group to which they are assigned (local
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users not assigned to another group are listed
under Unassigned Users; remote users are
listed only under Remote Users).

Note: This column is used in the Users and
User Group Details section of the Users tab,
as well.

Device Group

Reports the Monitoring and Surveillance
access a selected user or user group has at the
device groups.

You can edit the access settings for a device
group if Modify Device Group Access is
enabled for the selected user or user group.

Note: The All Devices group access settings
provide a baseline for all other device groups.
The other device groups will use at least the
same access settings as All Devices, but any
group can be set to use less-restrictive settings.

Monitoring

Reports the monitoring access a selected user or
user group has at the device groups.

Surveillance

Reports the surveillance access a selected user
or user group has at the device groups.

Monitoring access

Five selections are available for user or user group monitoring access at a selected device

group.

Note: Users assigned the Data Center Expert Administrator role, or assigned to a
user group that has this role, have full monitoring and surveillance access, as well as access

to all server functions.

Monitoring Access

Description

No Access

No monitoring access is provided.

View Access - No Camera
Images

A user with this access setting for a device group can perform the
following functions for the devices in that group:

View information about active and historical alarms.
View information about device sensors.

Create a Graph view for a selected sensor type that is associated with
the devices.

View and export copies of saved reports in a table (as .csv or .txt file) or
graph (as .bmp, jpg, or .png file) format.

Create and export copies of device sensor reports in a table (as .csv or .txt
file) or graph (as .bmp, jpg, or .png file) format.

Launch to the web interfaces at the devices.
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Monitoring Access

Description

Request that the Data Center Expert server scan a selected SNMP or
Modbus device, or set of SNMP and Modbus devices, to update the
available information.

View Access

A user with this access setting for a device group can perform the
following functions for the devices in that group:

View information about active and historical alarms.
View information about device sensors.

View NetBotz Appliance camera images.

View clips in active and historical alarms.

Create a Graph view for a selected sensor type that is associated with
the devices.

View and export copies of saved reports in a table (as .csv or .txt file) or
graph (as .bmp, jpg, or .png file) format.

Create and export copies of device sensor reports in a table (as.csv or.txt
file) or graph (as .bmp, jpg, or .png file) format.

Launch to the web interfaces at the devices.

Request that the Data Center Expert server scan a selected SNMP or
Modbus device, or set of SNMP and Modbus devices, to update the
available information.

View and Control Access

Users with this access setting for a device group can perform the same
monitoring functions View Access provides, as well as the following
additional functions:

Change the state of a sensor in the right-click menu of the "View Device
Sensors" display, when available.

Change the state of an outlet in the "Outlet Control" display, when
available.

Administration Access

A user with this access setting at a device group can perform all the same
monitoring functions View Access provides, as well as the following
additional functions:

Create a custom Map View for the device group.

Configure NetBotz Appliance Alert Thresholds and SNMP and
Modbus Thresholds for device sensors in that group.

Configure NetBotz Appliance Configuration options at monitored
NetBotz Appliances in that group.

Configure the Device Configuration settings for SNMP and Modbus
devices in that group.

Configure the Device File Transfer Settings.

Apply SNMP device and NetBotz Appliance firmware updates that have
been downloaded to the Data Center Expert server for the group's
devices.

Note: Only a Data Center Expert Administrator can download the
updates to the server.
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Surveillance access

Five selections are available for a user or user group's surveillance access at a selected
device group.

Note: Users assigned the Data Center Expert Administrator role, or assigned to a
user group that has this role, have full monitoring and surveillance access, as well as access
to all server functions.

In addition to the surveillance functions identified in the following table, a user can perform
all functions for the monitoring access associated with a device group: any Surveillance
setting other than No Access for a device group requires at least View Access for that

group's monitoring access setting.

Surveillance Access

Description

No Access

No surveillance access is provided.

View Live Feed Only (No
camera clips)

A user with this access setting for a device group can perform the
following functions for that group's camera devices:

Access the Camera view for a licensed camera in the Thumbnails view.

Change the state of a sensor in the Camera view, when available, when
the user is also assigned View and Control monitoring access.

View Access

A user with this access setting for a device group can perform the
following functions for that group's camera devices:

View and export surveillance clips.
Access the Camera view for a licensed camera in the Thumbnails view.

Change the state of a sensor in the Camera view, when available, when
the user is also assigned View and Control monitoring access.

View and Tag Access

A user with this access setting at a device group can perform all
functions View Access provides, but with the added ability to tag
surveillance clips.

Administration Access

A user with this access setting at a device group can perform all
functions View and Tag Access provides, but with the added ability to
configure the Surveillance Settings for all camera devices, and delete
surveillance clips.

"Modify Device Group Access" display

Use this display to define the Monitoring Access and Surveillance Access you want a
user or user group to have for the device group selected in the Device Group Access
settings section of the Users tab.

The access settings defined for one device group can affect the settings available to other

device groups.

 All settings are available for All Devices, unless another device group has had
settings added (check-marked in the Device Group Access settings list): no setting
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above the highest setting selected at any other group is available for the All
Devices group. For example:

« If a device group has had a setting setto View Access, and no device group
has a higher setting selected, only the View Access and No Access settings
will be available for the All Devices group.

« If any device group has had its Monitoring Access set at View and Control
Access, Administration Access will be unavailable for that monitoring access
for the All Devices group.

Note: If any group other than Unassigned has had access set at
Administration Access, all settings for that monitoring access will be available
for the All Devices group.
» The settings available at other groups depend on the settings defined at their parent
group: settings more restrictive than the parent group's settings ( All Devices, or the
group to which a subgroup is assigned) are unavailable. For example:

When All Devices has View Access selected for its Device Access, and View
and Tag Access selected for its Surveillance Access, No Access is unavailable
for the Monitoring Access at all other groups, and No Access and View Access
are unavailable for the Surveillance Access at all other groups.
Another factor affects the access set at device groups other than All Devices: you can
select an access that is identical to the access a group is inheriting from All Devices, or a
parent group. Although the selected group's access settings remain unchanged, those
access settings are no longer inherited, and can no longer be affected by changes made
to inherited settings. For example, if you select View Access, instead of View Access
(Inherited from All Devices), the access selection will not be affected by changes to the
All Devices group access selection.

Authentication Servers tab

Use this Users and User Groups option tab to manage the authentication servers used
to add remote users and user groups for the Data Center Expert server.

Each authentication server listed has users and user groups that can be assigned as remote
users and user groups at the Data Center Expert server.

Use the "Add Authentication Server" wizard to add the authentication server to the tab and
assign users and groups.

Use the "Edit Authentication Server" wizard to modify settings.

You can select an authentication server to configure the timeout for AD/LDAP up to 300
seconds, 15 seconds by default. When you increase the timeout on this tab, also increase
the timeout on the desktop client login screen.

Users and user groups will be listed in the Groups and Users folders for the appropriate
server or servers in the Authentication Servers tab and in the Users tab.

Note: When a remote user, or a user that belongs to a remote user group, attempts to log
in to the Data Center Expert server, the username and password are sent to the
authentication server associated with that user. It is that server, and not the Data Center
Expert server, that authenticates the login attempt.

Managing authentication servers, remote users, and remote user groups

You use the "Add Authentication Server" or "Edit Authentication Server" wizard to add
remote users and user groups that will have access to the Data Center Expert console,
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depending on whether the authentication server that lists those users and user groups is
included in the Authentication Servers tab.

Note: Use the Users tab to edit or delete remote users, and the User Groups tab to edit
or delete remote user groups that have access to the Data Center Expert console.

1. Inthe Authentication Servers tab for the Users and User Groups option, click
Add Authentication Server to access the "Add Authentication Server" wizard, or
select a listed server and click Edit Authentication Server to access the "Edit
Authentication Server" wizard.

Note: To delete an authentication server, select that server in the Authentication
Servers tab and click Delete.

2. Inthe "OpenLDAP/Active Directory Server Settings" display, configure the settings, if
necessary, and click Next.

3. In the "OpenLDAP/Active Directory Bind Settings" display, configure the settings, if
necessary, and click Next.

4. In the "Remote Users and User Groups Selection” display, select the users and user
groups you want to add that will have access to the Data Center Expert console.

"Add Authentication Server" or "Edit Authentication Server" wizard

Use this wizard to add remote users and user groups, and to add or edit the authentication
servers at which those users and user groups are defined.

"OpenLDAP/Active Directory Server Settings" display

Use this display to configure the settings for the authentication server.

Element Description

Server Label Define a name to be used as a label that
identifies the authentication server.

Server Address Identify the hostname or IP Address of the
authentication server.

Server Type Select the type of authentication server:
Active Directory or OpenLDAP.

Server Port Identify the number of the port used for
authentication server communication ( 389
is the default).

Use SSL Select to use the Secure Sockets Layer
(SSL) protocol for communication between
the Data Center Expert and the
authentication server.

"OpenLDAP/Active Directory Bind Settings" display

Use this display to configure the settings the Data Center Expert server uses to access the
authentication server.
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Element Description

Bind User DN Identify the user DN required to access the
authentication server.

Bind Password Identify the password required to access the
authentication server.

Search Base Identify a search base that can narrow the
search scope and decrease directory
lookup time at the authentication server.

"Remote Users and User Groups Selection" display

Use this display to select the remote users and remote user groups that will have logon
access to the Data Center Expert server.
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Reports menu

Provides options used to generate Sensor History reports and Snapshot reports, and
manage the export configurations that are used to export reports on a scheduled basis.

Note: A Manage Export Scheduling right-click option in the Saved Sensor Reports
section also accesses the "Manage Export Scheduling” display. For more information about
the Manage Export Scheduling option, see Reports feature.
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Reports perspective

This perspective provides access to predefined snapshot reports, and sensor history reports
you create, about the devices monitored by the Data Center Expert server.

The Reports perspective allows you to generate, view, and export reports in HTML, CSV
(comma-delimited), or PDF format, for the device groups selected.

» Available Reports: lists the snapshot reports, sensor history reports, and saved
sensor reports available for the devices the Data Center Expert server monitors, and
allows you to generate those reports for selected device groups and devices.

* Sensor History Reports: allows you to generate and customize sensor history
reports for the devices the Data Center Expert server monitors. Sensor history
reports can be saved in the Saved Sensor Reports section, and exported in graph-
format, or viewed and exported in table-format or summary-format.

* Snhapshot Reports: allows you to generate a report, containing data for the particular
time at which the report is generated, for the devices the Data Center Expert server
monitors. Snapshot reports can be viewed in graph-format only, and exported to
HTML, CSV (comma-delimited), or PDF.

» Saved Sensor Reports: allows you to view, edit, rename, delete, and export sensor
history reports you have saved.

* Report Views: display snapshot reports, and sensor history reports, generated for the
device groups selected, and allows you to export those reports. See Snapshot Reports
and Sensor History Reports for more information.

Sensor History Reports option

This option allows you to create Sensor History Reports for specific sensor types
associated with a group selected in the Device Group view, as well as Custom Sensor
History Reports (graph-format, table-format, or summary-format) for any or all sensors
associated with monitored SNMP, Modbus, and NetBotz Appliance devices.

» Custom Sensor History Reports are created using the Custom optionin Generate

Sensor History Report , a right-click option and icon (ﬂ:l), in the Device Groups
view, Active Alarms view, Alarm History view, and Device View, and a right-click
option in Map View. You select the date range, devices and device groups, sensor
types, and sensors to include in the report. You can modify the report after it is created
by selecting the Edit Report Criteria icon.

* Sensor History Reports are created for a selected device group, for the previous
24 hours, using the list of sensor types included in the right -click Sensor History
Reports option of the Device Groups view, Device View, and Map View. You can
modify the date range, devices and device groups, sensor types, and sensors to
include in the report after the report is created by selecting the Edit Report Criteria
icon.

Note: You can also create Sensor History Reports in the Available Reports view of
the Reports perspective.

You can create and save reports in graph-format, table-format, or summary-format, then
access those reports at any time in the Saved Reports section of the Reports perspective.
You can create a graph-format report, then view the data as a table by selecting the Table
Data icon, or as a summary by selecting the Summary Data icon. You can export table
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data or summary data reports as .csv or .txt files, and graph reports as .bmp,.jpg, or.png
files.

Note: You cannot save Snapshot Reports in the Saved Reports view. You can save
these reports locally as *.HTML,*.CSV (comma-delimited), or *.PDF files. For more
information, see Snapshot Reports .

Edit Report Criteria option

Use this display to create graph-format, table-format, or summary-format reports for the
device groups or devices selected when you click the Custom option in the right-click
Sensor History Reports menu, or the Custom Sensor History Report icon in the
Device Groups, Alarm History, Active Alarms, or Device View. In addition, use this
display to edit the report criteria fora Sensor History Report or Custom Sensor History
Report you have already created.

The devices and device groups, sensor types, and sensors listed by default in the "Report
Criteria" display depend upon which view was used to access it:
* Device Groups view: lists all sensors for all devices in the selected device group.
» Device View or Map view: lists all sensors for a selected device or set of devices.
» Active Alarms view: lists all sensors for a device associated with the selected alarm,
or for the devices associated with a set of alarms.
» Alarm History view: lists all sensors for the device associated with the selected alarm.

You can modify the report criteria before or after you create a report.

Note: When you click Generate Report, the report will not appear in the Saved
Reports view until you use the Save icon to save the report.

Element Description

Choose Date Relative: select to use a drop-down menu option
that identifies a period of time you want the report
to cover.

Range: select to use to define the Start
and End dates for the period of time you
want the report to cover.

Choose Report Format Select to display the report in graph (the default),
summary, or table format.

Choose Devices and Device Groups Select the devices or device groups you want to
include in the report.

Choose Sensor Types Select the sensor types you want to include in the
report.

Select Sensors Search and Clear: use to search for a

specific sensor, or to narrow the list to
include only those sensors that include your
typed text.

Configure Columns icon: identify the
columns that appear in the display.

Sensors list: select the device sensors you
want the report to include. When modifying
an existing report, the list includes all
sensors for the devices that were selected
when the report was created or last edited,
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with the following information provided for
each sensor:

e Device: device label

* Sensor: sensor name

* Sensor Type: sensor type

e Alarm State: current sensor status

» Location: device location, if known

» Device Status: current device status

¢ Hostname: device hostname or IP
address

Select/Deselect All: use to selectto include
all sensors in the report, or to deselect the
currently selected sensors.

"Name and Schedule Data Export™ display

Use this display to export data from a report in the Saved Reports section by defining a
name for the report, if desired, and defining how and when the report will be periodically

exported.

You access this display from the Edit Report Scheduling right-click option in the Saved
Reports section, or the Edit Report Criteria icon, accessed from the view for any saved
or unsaved sensor history report. An unsaved sensor history report is saved in the Saved
Reports section when you click OK to schedule the data export.

Element

Description

Report Name

Define or modify the name that will identify the
report in the Saved Reports view.

Enable Export

Select to enable the report data export on a
scheduled basis.

Export Name

Select the name of an existing export
configuration.

Add Export Click to use the "Add Export" wizard to add a new
export configuration.
Delimiter Select how the report data will be delimited for

export: Comma, Semicolon, Space, or Tab.

Configure Columns

Choose the columns, including those created
using custom property keys, and the order in
which they will appear in the report.

Locale Select to specify the locale for the report data
or Use Server Locale (the default).
Scheduling Days of the week: Select the day or days

of the week for the exports.

First of the month: Select the first of the
month for the exports.

Time: Select the time of day for the exports.

Report Interval

Select the interval between entries in a
report.

129



EcoStruxure IT Data Center Expert 8.1.0

Graph-format reports

This report format provides data, in the form of a graph and device sensor list, for up to
1026 device sensors.

Note: You can access a graph-format report view by clicking Generate Report in the
Reports perspective, and choosing Graph as the report format (the default), or by selecting
areport in the Saved Reports view.

The name (*Sensor History Report, for an unsaved report) is identified on the tab for each
report; the sensor type and time frame is identified at the top of each report.

You can select the Trend Line button icon to display a linear trend line when all numeric
sensors included in the graph-format report use the same unit of measure. Trend lines are
calculated using a linear regression model and the ordinary least squares estimation
method. All the available data returned by the Data Center Expert server for the sensors
selected, and the time range specified for the report, are considered in the model. The data
are extended for twice the specified time range to create the trend line. For example, in a
report with a time range of seven days, the linear regression is calculated over fourteen
days: seven days of actual data, and seven days of prediction.

You can use the device sensor list columns, right-click menu, and button icons, to do the
following:

« Click a column title to sort the list in ascending or descending order based on that
column's information.

 Edit the date range, report format, or sensors for a selected report using the "Report
Criteria" display ( Edit Report Criteria option or icon).

« Edit the report name or export properties using the "Name and Schedule Data Export"
display ( Edit Report Criteria option or icon).

* Save a copy of the report as a *.bmp (the default selection), *.jpg, or *.png file ( Export
Graph icon).

» Access the "Set Refresh Rate" display used to control how often an open graph will
refresh automatically, if at all ( Refresh icon).

Note: The refresh settings are client-specific, and have no affect on the refresh
settings used by other Data Center Expert clients.

« Display a linear trend line for twice the time period as the data, on numeric sensors
only, when all numeric sensors included in the graph use the same unit of measure
( Trend Line icon).

 Highlight the point for which data is displayed when you move the cursor over the
graph ( Marker icon).

» Click and drag the graph to view a specific area ( Pan icon).

* View a summary-format version of a selected report ( Summary Data icon or Open
Summary Data option).

* View a table-format version of a selected report ( Table Data icon or Open Table
Data option).

* Name a report and save it in the Saved Reports section of the Available Reports
view ( Save icon).

* View the graph in more or less detail ( Zoom In or Zoom Out option and icon).
Note: You can click and drag the cursor to select a portion of the graph to view in
more detail.

* Reset the graph back to its original position ( Reset Graph Position option).
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Graph section

Provides a graphic representation of the values reported by the device sensors included in
a Sensor History Report or Custom Sensor History Report, over the period of time

selected.

Every device sensor is represented by its own color, as identified in the device sensor
list.

The time frame is identified below the title, and labeled along the bottom of the graph.
Fora Sensor History Report , a single sensor's value range is labeled along the
left-side of the graph.

For Custom Sensor History Reports , which can cover multiple types of sensors,
one sensor value range is labeled along the left-side of the graph, while any additional
value ranges for the report's sensors are labeled to the right of the graph.

A linear trend line is plotted on graph-format reports for twice the time period as the
data, on numeric sensors only, when all numeric sensors included in the graph use
the same unit of measure.

Sensor list section

Lists and provides information about each device sensor included in a Sensor History
Report, including the color used to represent values for each sensor in the graph.

Column

Description

Color

The color used for the sensor values in the graph.
Note: You can deselect the color to remove
sensor values from the graph, or select (the
default), to include the sensor values.

Location

The location of the sensor, if known.

Parent Device

Data Center Expert for SNMP and Modbus
devices, or the hostname of a NetBotz Appliance
for devices monitored by a NetBotz Appliance.

Monitored Device

The device label.

Sensor The sensor type, followed by a name, if the
sensor has one.
Units The unit of measurement for numeric sensors,

only.

Last Known Value

The last reported value during the time span of
the report.

Minimum Value

The lowest value measured by numeric sensors
only, during the time span of the report.

Maximum Value

The highest value measured by numeric sensors
only, during the covered time span.

Average Value

The average value measured by numeric
sensors only, during the covered time span.

"Set Refresh Rate" display

Use this display to control how often the selected graph-format Sensor History Report
or Custom Sensor History Report will refresh automatically, if at all.
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You can use any auto-refresh setting when you create a graph with less than 50,000 data
points. When you create a graph with 50,000 - 199,999 data points, the graph will refresh
only when you select a refresh interval of five minutes or greater. When you create a graph
with 200,000 data points or more, the graph will not refresh.

Note: These settings are client-specific, and have no affect on the refresh settings used
by other Data Center Expert clients.

Element Description
Enable Graph Refresh Enable (check-marked) or disable (default
setting) the automatic refresh of the graph-format
report.
Refresh Interval Select how often the report will refresh (5
Minutes, by default).

"Sensor Table Data" display

This display allows you to view and save the data in a graph-format report as a table.

You click the Table Data icon or select the Open Table Data option in a graph-format
Sensor History Report to view data as a table.

The "Sensor Table Data" display shares all the same features as a table-format Sensor
History Report with the following exceptions:
* Sensor table data cannot be saved in the Saved Reports section of the Reports
perspective.
» The report criteria for the table data cannot be modified.
« Scheduled data export is not available.

The number of sensors covered in the report, total number of data points, and the time
frame are identified at the top of each table. You can use the search feature, table columns,
and button icons, to do the following:
* Type text in the Search field to locate a specific device or sensor in the report, or to
narrow the list to a particular set of device sensor entries.
 Click a column title to sort the list in ascending or descending order based on that
column's information.
» Select the columns, and the order in which they appear in the table, and choose
whether or not to highlight alarming sensors in the table ( Edit Report Options icon).
* Save sensor table data as a *.csv (the default selection) or *.txt file ( Save Report
Data and chevron icons).
Note: You must use the chevron icon to select the *.txt format.
* Browse through a multiple-page report ( Go to arrow icons, and a box that identifies
the page number).

Column Description

Device The device label.

Parent Device <hostname> (Data Center Expert) for SNMP
and Modbus devices, or the IP address or
hostname of a NetBotz Appliance for devices
monitored by that appliance.

Sensor The sensor name.

Location The location of the sensor, if known.
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Time The date and time of the most recent sensor
value change.

Value The value measured at the identified date and
time.

Unit The unit of measurement for numeric sensors,
only.

Status The sensor status: Alarm (when a Warning,

Error, Critical, or Failure condition exists), or
no text (when no alarm condition exists).

Note: Sensor status is reported only for sensors
that have been configured at the Data Center
Expert server, for SNMP and Modbus devices
the server monitors directly, or at the NetBotz
Appliances, for devices monitored by those
appliances, using Alert Thresholds, the
NetBotz Appliance Configuration > Alert
Settings options in the Device menu.

"Sensor Summary Data" display

This display allows you to view and save the data in a graph-format report as a summary.

You click the Summary Data icon or select the Open Summary Data option in a graph-
format Sensor History Report to view data as a summary.

The "Sensor Summary Data" display shares all the same features as a summary-format
Sensor History Report with the following exceptions:
* Sensor summary data cannot be saved in the Saved Reports section of the
Reports perspective.
» The report criteria for the summary data cannot be modified.
« Scheduled data export is not available.

The total number of data points are identified at the top of each table. You can use the
search feature, table columns, and button icons, to do the following:

* Type text in the Search field to locate a specific device or sensor in the report, or to
narrow the list to a particular set of device sensor entries.

 Click a column title to sort the list in ascending or descending order based on
information in that column.

» Select the columns, and the order in which they appear in the table; choose whether
or not to include the total for the delta value in the table; and choose whether or not
to highlight alarming sensors in the table ( Edit Report Options icon).

* Save sensor summary data as a *.csv (the default selection) or *.txt file ( Save Report
Data and chevron icons).

Note: You must use the chevron icon to select the *.txt format.

* Browse through a multiple-page report ( Go to arrow icons, and a box that identifies

the page number).

A summary-format report shares all of the same features as a table-format report, with the
following exceptions:

» A table-format report provides entries for each value change at those sensors during
the reports time-frame; a summary-format report provides a single entry for each
selected sensor that summarizes the values at those sensors during the reports time-
frame.

« Unlike a table-format report, a summary-format report does not include a Status
column.
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Note: A summary-format report includes information about the Last Known Value,
which has a different meaning than the Value reported by a table-format report.
* Only a summary report includes the following information:

Column Description

Minimum Value The lowest value recorded during the
time-frame of the report.

Maximum Value The highest value recorded during the
time-frame of the report.

Average Value The average of the values recorded
during the time-frame of the report.

Last Known Value The most recent value recorded before
the end of the time-frame of the report.

Delta Value The difference between the minimum and
maximum values recorded during the
time-frame of the report.

Total for Delta Value The total of the delta values for the
sensors in the report, included when
Show Total for Delta Value is selected
in the "Edit Report Options" display.
Note: The Show Total for Delta Value
option is available only when all sensors
in the report are the same type.

Table-format reports

This report format provides data for up to 1026 sensors, in the form of table that lists all the
device sensors included in a report.

You create a table-format Sensor History Report by selecting the Table report format in
the "Report Criteria" display.

You can access a table-format report view of a previously generated report:
» Select the Edit Report Criteria icon in the report view, and the Table report format.
» Select the Edit Report Criteria right-click option in Saved Reports in the
Reports perspective, and the Table report format.
Note: You can click the Table Data icon or select the Open Table Data option in a graph-
format Sensor History Report to view data as a table. See "Sensor Table Data" display.

The number of sensors covered in the report, total number of data points, and the time
frame are identified at the top of each table. You can use the search feature, table columns,
and button icons, to do the following:
* Type text in the Search field to locate a specific device or sensor in the report, or to
narrow the list to a particular set of device sensor entries.
« Click a column title to sort the list in ascending or descending order based on that
column's information.
« Edit the date range, report format, or sensors for a selected report using the "Report
Criteria" display ( Edit Report Criteria icon).
 Edit the report name or export properties using the "Name and Schedule Data Export"
display ( Edit Report Criteria option or icon).
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* Name a report and save it in the Saved Reports section of the Available Reports

view ( Save icon).

» Select the columns, and the order in which they appear in the table, and choose
whether or not to highlight alarming sensors in the table ( Edit Report Options icon).
* Save sensor table data as a *.csv (the default selection) or *.txt file ( Save Report

Data and chevron icons).

Note: You must use the chevron icon to select the *.txt format.
* Browse through a multiple-page report ( Go to arrow icons, and a box that identifies

the page number).

Column

Description

Device

The device label.

Parent Device

<hostname> (Data Center Expert) for SNMP
and Modbus devices, or the IP address or
hostname of a NetBotz Appliance for devices
monitored by that appliance.

Sensor The sensor name.

Location The location of the sensor, if known.

Time The date and time of the most recent sensor
value change.

Value The value measured at the identified date and
time.

Unit The unit of measurement for numeric sensors,
only.

Status The sensor status: Alarm (when a Warning,

Error, Critical, or Failure condition exists), or
no text (when no alarm condition exists).

Note: Sensor status is reported only for sensors
that have been configured at the Data Center
Expert server, for SNMP and Modbus devices
the server monitors directly, or at the NetBotz
Appliances, for devices monitored by those
appliances, using Alert Thresholds, the
NetBotz Appliance Configuration > Alert
Settings options in the Device menu.

"Edit Report Options" display (table-format)

Use this display to choose the columns and the order in which they appear in the table-

format report.

Type

Description

Highlight Alarming Sensors

Select to highlight (in red) the Value for sensors
that have active alarm conditions when a
threshold setting has been defined for that alarm
atthe Data Center Expert server, for a sensor
associated with a monitored SNMP device, or at
a NetBotz Appliance associated with a sensor.

Available Columns

Lists columns created using custom property
keys, and any default columns not included in the
report.
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Add/Remove Columns Allows you to choose the columns to include in
the report.

Chosen Columns Lists the columns to include in the report.

Move Up/Down Allows you to specify the order in which the

columns appear in the report.

Report Interval Select the interval between entries in a report.

Summary-format reports

This report format provides data for up to 4000 sensors, in the form of a table that identifies
all the device sensors included in the report, and summarizes the values measured by those
sensors during the time-frame specified for the report.

You create a summary-format Sensor History Report by selecting the Summary report
format in the "Report Criteria" display.

You can access a summary-format report view of a previously generated report:
» Select the Edit Report Criteria icon in the report view, and the Summary report
format.
» Select the Edit Report Criteria right-click option in Saved Reports in the
Reports perspective, and the Summary report format.
Note: You can click the Summary Data icon or select the Open Summary Data option
in a graph-format Sensor History Report to view data as a summary. See "Sensor
Summary Data" display.

A summary-format report shares all of the same features as a table-format report, with the
following exceptions:

» Atable-format report provides entries for each value change at those sensors during
the reports time-frame; a summary-format report provides a single entry for each
selected sensor that summaries the values at those sensors during the reports time-
frame.

* Unlike a table-format report, a summary-format report does not include a Status
column.

Note: A summary-format report includes information about the Last Known Value,
which has a different meaning than the Value reported by a table-format report.

* Only a summary report includes the following information:

Column Description

Minimum Value The lowest value recorded during the
time-frame of the report.

Maximum Value The highest value recorded during the
time-frame of the report.

Average Value The average of the values recorded
during the time-frame of the report.

Last Known Value The most recent value recorded before
the end of the time-frame of the report.

Delta Value The difference between the minimum and
maximum values recorded during the
time-frame of the report.
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Column Description

Total for Delta Value The total of the delta values for the
sensors in the report, included when
Show Total for Delta Value is selected
in the "Edit Report Options" display.
Note: The Show Total for Delta Value
option is available only when all sensors

in the report are the same type.

The total number of data points covered in the report are identified at the top of each
summary. You can use the search feature, columns, and button icons, to do the following:

Type text in the Search field to locate a specific device or sensor in the report, or to
narrow the list to a particular set of device sensor entries.

Click a column title to sort the list in ascending or descending order based on that
column's information.

Edit the date range, report format, or sensors for a selected report using the "Report
Criteria" display ( Edit Report Criteria icon).

Edit the report name or export properties using the "Name and Schedule Data Export"
display ( Edit Report Criteria option or icon).

Name a report and save it in the Saved Reports section of the Available Reports
view ( Save icon).

Select the columns, and the order in which they appear in the table; choose whether
or not to highlight alarming sensors in the table; and choose whether or not to include
the total for the delta value in the report ( Edit Report Options icon).

Save sensor table data as a *.csv (the default selection) or *.txt file ( Save Report
Data and chevron icons).

Note: You must use the chevron icon to select the *.txt format.

Browse through a multiple-page report ( Go to arrow icons, and a box that identifies
the page number).

"Edit Report Options" display (summary-format)

Use this display to choose the columns and the order in which they appear, highlight active
Critical, Error, Failure, and Warning alarms, and include the total for the delta value in the
summary-format report.

Type Description

Highlight Alarming Sensors Select to highlight (in red) the Value for sensors

that have active alarm conditions when a
threshold setting has been defined for that alarm
atthe Data Center Expert server, for a sensor
associated with a monitored SNMP device, or at
a NetBotz Appliance associated with a sensor.

Show Total for Delta Value Select to include the total for the delta value in

the report, available only when all sensors in the
report are the same type.

Available Columns Lists columns created using custom property
keys, and any default columns not included in the
report.

Add/Remove Columns Allows you to choose the columns to include in
the report.

Chosen Columns Lists the columns to include in the report.

Move Up/Down Allows you to specify the order in which the

columns appear in the report.
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Snapshot Reports

This section provides access to predefined reports about the devices monitored by the

Data Center Expert server.

The Snapshot Reports section allows you to generate, view, and export reports in HTML,
CSV (comma-delimited), or PDF format, for the device groups selected.

Element

Description

UPS Runtime

Lists UPS systems, by IP Address, within
available UPS Runtime-range categories (for
example, <10 minutes).

Device Type Inventory

Lists the number of monitored devices for each
device type, by model name.

Battery Age

Lists UPS systems, by IP address, within Battery
Age-range categories (for example, 2-3 years).

Environmental Humidity

Lists the % Humidity, by sensor, within Humidity-
range categories (for example 40-50).

Environmental Temperature

Lists the Temperature, by sensor, within
Temperature-range categories (for example
60-80).

Generate Report

Allows you to choose the device groups you want
to include in the report selected.

Snapshot Report View

This view displays Snapshot Reports and allows you to export it.

You can use the Go To arrow icons to browse through a multiple-page report, along with

the box that identifies the page being viewed.

Icon

Description

—

S

Use the chevron icon included with this Export
icon to save the selected report as *.HTML,
*.CSV, or *.PDF.

"Choose Device Groups" display

Use this display to choose the device groups you want to include in a Snapshot Report.

Element

Description

Device Group
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Note: Alldevice groups, and the Select/Deselect
All option, are check-marked by default.

Generate Report

Click to render the report for the device groups
selected.

Button icons (report views)

The report views have icons you can use to perform various functions.

Sensor History Report graph-format icons

Ilcon

Description

~

Use this Edit Report Criteria icon to edit
the time frame or sensors you want a
selected report to cover.

R]

Use this Marker icon to highlight the point
for which data is displayed when you move
the cursor over the graph.

Use this Pan icon to click and drag the
graph to view a specific area.

Use this Zoom In icon to view the graph in
more detail.

Use this Zoom Out icon to view the graph
in less detail.

Use this Summary Data icon to view a
summary-format version of a selected
report.

Use this Table Data icon to view a table-
format version of a selected report.

& O E| L 2 B

Use this Trend Line icon to view a linear
trend line for the same time period as the
data, on numeric sensors only, when all
numeric sensors included in the graph use
the same unit of measure.

Use this Refresh icon to select how often
reports will refresh.

Use this Save icon to name a report and
save it in the Saved Reports section of
the Available Reports view.

Note: An asterisk (*) preceding the report
name indicates the report has not been
saved.
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Icon

Description

-

Use this Export icon to save a copy of a
report to the local drive.

Sensor History Report table-format and summary-format report icons

These report views share two icons and Go to arrow icons you can use to browse through
a multiple-page report, with a box that identifies the page being viewed.

Ilcon

Description

~

Use this Edit Report Criteria icon to edit
the time frame or sensors you want a
selected report to cover.

Use this Save icon to name a report and
save it in the Saved Reports section of
the Available Reports view.

Note: An asterisk (*) preceding the report
name indicates the report has not been
saved.

Use this Save Copy of Graph icon for a
graph-format report to save it as a *.bmp,
*.jpg, or *.png file.

Use this Save Report Data icon for a table-
format or summary-format report to save a
copy of the report as a .*txt or *.csv file.
Note: You must use the chevron icon
included with this Save Report Data icon in
table-format and summary-format reports to
select *.txt.

7

Use this Edit Report Criteria icon to edit
the time frame or sensors you want a
selected report to cover.

Snapshot report icons

The snapshot report views have one icon and Go to arrow icons you can use to browse
through a multiple-page report, with a box that identifies the page being viewed.

Icon

Description

Use this Exporticon to export a copy of the
shapshot report as an *.html file.

Note: You must use the chevron icon
included with this Exporticonto select *.csv
(comma-delimited) or *.pdf
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Saved Sensor Reports section

This section of the Available Reports view allows you to view, edit, rename, or delete
saved reports.

Note: Reports are saved using the "Name and Schedule Data Export" display, accessed
fromthe Edit Report Criteriaicon, or by using the Save icon in the view for a graph-format
report.
You can use the right-click options to perform the following functions:

Edit the date range or sensors for a selected report using the "Edit Report Criteria"

display ( Edit Report Criteria option).

Edit the name or export properties for a selected report using the "Name and Schedule
Data Export" display ( Edit Report Scheduling option).

Modify the name of a selected report ( Rename option).

Delete a selected report ( Delete option).

Manage Export Scheduling option (Reports menu)

Use this option to manage the schedule configuration settings used to export saved reports

from the Data Center Expert server.

"Manage Export Scheduling" display

Use this display to manage the list of schedule configurations for saved reports, used for
scheduled export from the Data Center Expert server.

Element

Description

List

Lists the export configurations for saved reports,
and provides the following information about
each:

Saved Sensor Report: the name of the
report scheduled for export.

Scheduled Days: the day or days of the
week for the exports.

Scheduled Time: the time of day for the
exports.

Scheduled: whether or not the report export
is enabled.

Summarized Export: whether the export is
summary-report data only.

Export Name: the name of the export
configuration.

Export Type: the type of the export
configuration.
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Export Action Configuration

Click to access the display used to manage
actions used to export saved reports from the
Data Center Expert server.

Edit Report Criteria

Click to access the display used to modify report
criteria for the selected report.

Edit Schedule

Click to access the display used to modify or
schedule data export for the selected report.

Delete Report

Click to remove the saved report from the Data
Center Expert server.

"Export Action Configuration™ display

Use this display, accessed by the Manage Export Scheduling option in the Reports
menu, to manage a list of export configurations used for the scheduled export of saved
reports from the Data Center Expert server.

Element

Description

List

Lists the saved export action configurations, and
provides the following information about each:

Export Name: the name defined for the
export action.

Export Type: the type of export used (E-
mail, FTP, etc.).

Server Hostname: the hostname or IP
address of the server used, if any.

Username: the username used to access
the server, if any.

Add Export

Click to use the "Add Export" wizard to add an
export configuration action.

Edit Export

Click to use the "Edit Export" display to edit the
settings of a selected export action configuration.

Remove Export

Click to delete a selected export action
configuration.

Managing the export action configurations

You can add new export action configurations, or edit existing configurations, using the
"Export Action Configuration” display, accessed from the Manage Export Scheduling

option of the Reports menu.

Note: To remove an export action configuration, select it in the list and click Remove

Export.

Adding a new export action configuration
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1.

Select Export Action Configuration, accessed from the Manage Export
Scheduling option in the Reports menu. Alternatively, click the Edit Report
Scheduling option in the Saved Sensor Reports section of the Reports
perspective, or click the Edit Report Criteria icon in a graph-format report, to access
the Name and Schedule Data Export option.

In the "Export Action Configuration” display, click Add Export to access the "Add
Export" wizard. Alternatively, in the "Name and Schedule Data Export" display, click
Add Export to access the "Add Export" wizard.

In the "Choose Export Type" display, select the type of export action configuration you
want to add.

In the settings display for the selected export type, define the settings.

Note: Each export type uses its own settings display to add or edit an export
configuration.
Click Test Export to test the export settings.

Note: You need to verify the test was successful. For example, for e-mail settings,
verify an e-mail was received.

Editing an export action configuration

1.

2.

Select Export Action Configuration, accessed from the Manage Export
Scheduling option in the Reports menu.

In the "Export Action Configuration” display, select a listed export, and click Edit
Export.

In the settings display for the selected export configuration, define the settings.

Note: Each export type uses the its own settings display to add or edit an export
configuration.
Click Test Export to test the edited export settings.

Note: You need to verify the test was successful. For example, for e-mail settings,
verify the e-mail was received.

"Add Export" wizard

Use this wizard to select the type of export action configuration you want to add, and to
define the settings for that configuration.

Note: When you click Edit Exportin the "Export Action Configuration" display, you access
the 'Edit Export” display, the same display, except in name, that was used to add the export
action configuration.

"Choose Export Type" display

Use this display to select the type of export you want to add.

Option Description
E-mail Export Click to add e-mail settings.
FTP Export Click to add FTP settings.
HTTP Export Click to add HTTP settings.
NFS Export Click to add NFS settings.
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| Windows Export

Click to add Windows settings.

"E-mail Export Settings" display

Use this display to add or edit an export action configuration that exports a report's data to

specified e-mail addresses.

Note: The SMTP server the Data Center Expert server uses to send e-mail saved report
data is defined by the E-Mail Settings option in the "Server Administration Settings"

display.

Type

Description

Export Name

Define the name for the e-mail export settings.

Subject of Message

Define the subject of the e-mail message that will
be generated and sent.

Body of Message

Define the body of the e-mail message that will
be generated and sent.

E-mail Addresses

Lists the e-mail addresses to which reports will
be sent.

Add

Click to add an e-mail address to the list.

Remove

Click to remove a selected e-mail address from
the list.

Test Export

Click to test the export settings.
Note: Verify an e-mail message actually was
received.

"FTP Export Settings" display

Use this display to add or edit an export action configuration that exports a report's data to

a specified FTP server.

Element

Description

Export Name

Define the name for the FTP export settings.

Server Hostname or IP

Identify the hostname or IP address of the FTP
server at which reports can be saved.

Port

The port the server uses for FTP communication
(21, by default).

Use Passive Transfer

Select to use passive FTP transfers when
communicating with the FTP server.

Note: Passive FTP transfers can be useful if
your Data Center Expert server is
communicating across a firewall.

Username

Identify the name used to access the FTP server.

Password

Identify the password used to access the FTP
server.

Verify Password

Retype the password.
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Target Directory Identify the path to be used for storing reports at
the defined server. This path should always be
relative to the default directory associated with
the username that accessed the server.

Note: If the directories you define for the path do
not exist, they will be created automatically.

Test Export Click to test the export settings.
Note: Verify the test data actually was saved at
the target directory on the FTP server.

"HTTP Export Settings" display

Use this display to add or edit an export action configuration that exports a report's data to
a specified HTTP address using an HTTP POST.

Element Description
Export Name Define the name for the HTTP export settings.
Target URL Identify the full URL to where reports will be

posted at the target server.

Server Requires Authentication Activate the Username, Password, and Verify
Password settings used for authenticated HTTP
server access.

Username Identify the name needed to post data to the
HTTP server at the specified Target URL.

Password Identify the password needed to post data to the
HTTP server at the specified Target URL.

Verify Password Retype the password.

SSL Options Select No verification, Verify certificate, or

Verify certificate and hostname.

Test Export Click to test the export settings.
Note: Verify the test data actually was posted
and saved at the target server.

"NFS Export Settings" display

Use this display to add or edit an export action configuration that exports a report's data to
a specified UNIX server that uses the Network File System (NFS) protocol.

Element Description
Export Name Define the name for the NFS export settings.
Server Hostname or IP Identify the hostname or IP address of the UNIX

server running NFS that you want to receive the
exported report data.

Share Identify the name of the directory used for file
sharing on the server.
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Subdirectory

Identify the subdirectory to be used to store
reports.

Note: The subdirectory field is optional: if no
subdirectory is specified, data will be stored in
the Share root directory.

Protocol

Select the transport protocol: UDP or TCP.

Version

Select the NFS version: v2.0, v3.0, v4.0, or v4.1.

Test Export

Click to test the export settings.

Note: Verify the test data actually was saved at
the NFS server, in the correct Share and
subdirectory (if used).

"Windows Export Settings" display

Use this display to add or edit an export action configuration that exports a report's data to

a specified Windows share server.

Element

Description

Export Name

Define the name for the Windows export settings.

Server Hostname or IP

Identify the hostname or IP address of the
Windows share server.

Username Identify the name needed to connect to the share
at the Windows server.
Password Identify the password needed to connect to the

share at the Windows server.

Verify password

Retype the password.

Domain Identify the domain to which the Windows share
is connected.
Share Identify the name of the shared folder at the

Windows server.

Subdirectory

Identify the subdirectory to be used to store
reports.

Note: The subdirectory field is optional: if no
subdirectory is specified, data will be stored in
the Share root directory.

Security

Specify the NT LAN Manager authentication
level: NTLM, NTMLi, NTLMv2, NTLMv2;i,
NTLMSSP, or NTLMSSPi.

Test Export

Click to test the export settings.
Note: Verify the test data actually was saved in
the proper folder on the Windows server.
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Alarm Configuration Overview

The Alarm Configuration perspective provides options used to configure how the Data
Center Expert server reports alarms and threshold violations, and manages alarm actions,
for monitored SNMP and Modbus devices.

By default, four views appear in the Alarm Configuration perspective. These views, along
with Manage Alarm Actions, an Alarm Configuration menu option, allow you to perform
threshold and device alarm configuration and notification functions for monitored SNMP
and Modbus devices.

* Navigation view: contains the navigation tree, listing device groups and the
monitored devices associated with them. This view allows you to do the following:

» Selectadevice group or device in the navigation tree to view the list of thresholds
or device alarms that can be configured or added to a notification policy.

» Select a device group or device in the navigation tree and create thresholds for
that selection.

 Edit thresholds.

* View device sensors and current sensor data for the selected device.

« Enter and exit maintenance mode to prevent and re-enable alarm notifications
for the device groups or devices selected.

« Add and remove thresholds from a notification policy.

» Select a device group or device in the navigation tree and edit the configuration
for all the device alarms for the selection.

» Select a device group or device in the navigation tree and change the notification
policy associated with that device group or device.
Note: A device can be associated with only one notification policy at a time.

* Modify the default labels in the navigation tree.

* Notification Policies view: displays the default notification policy, user-created
notification policies, and the notification policy details. This view allows you to do the
following:

» Create, modify, and delete notification policies.

» Double-click a notification policy to view the actions, thresholds, and devices

associated with it.

Note: The Default notification policy can be edited and renamed, but it cannot be
deleted.
Note: At device discovery, alarms for SNMP and Modbus devices monitored by the
Data Center Expert server are added to the Default notification policy. You can
change the notification policy associated with a device from Change Device Alarm
Notification Policy, a right-click option in the Navigation view.

* Threshold Alarm Configuration view: displays the list of thresholds that can be
configured or added to a notification policy. By default, a communication link status
threshold is displayed for every device monitored by the Data Center Expert server.
This view allows you to do the following:

* Modify and delete thresholds.
Note: You cannot delete communication link status thresholds.
« Add and remove thresholds from notification policies.
« Display the notification policies associated with the selected thresholds.
* Find the device associated with the selected threshold in the Navigation view.

* Device Alarm Configuration view: displays the list of device alarms that can be
configured or added to a notification policy. This view allows you to do the following:

« Enable or disable an alarm, modify the severity and recommended action, and
add a custom description.
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* Find the device associated with the selected alarm in the Navigation view.
» Expand the list when there is more than one device alarm in the selection.

Creating alarm notifications

Use the Alarm Configuration perspective to define the alarm notifications you want available
to the Data Center Expert server for monitored SNMP and Modbus devices.

You must do the following before the Data Center Expert server can generate alarm
notifications:

» Create at least one alarm action.

* Add at least one alarm action to the Default notification policy.

You can do the following to specify how the Data Center Expert server generates additional
alarm notifications:

» Create thresholds for sensor types supported by each device.

» Create new notification policies.

« Add at least one alarm action to each notification policy you created.

» Add thresholds, devices, and additional alarm actions, to the Default notification
policy, or natification policies you created.

« Add SNMP and Modbus devices to notification policies you created.

« Modify thresholds or device alarm configurations, if necessary.

You can create and configure thresholds, alarm actions, and notification policies, or modify
device alarm configurations, at any time, in any order. For example, you can create alarm
actions first, create thresholds, then add selected actions, thresholds, and devices, as
needed, to the Default notification policy. Alternatively, you can create new notification
policies first, then create actions or thresholds, and add them to any notification policy.

Alarm Configuration menu

Provides options used to configure how the Data Center Expert server reports alarm
conditions.

"Search" field

Use the Search field to filter the list based on text you type.

You can broaden or narrow your search using the Boolean operators AND, OR and NOT.
For example, you can search for UPS AND On Battery; PDU NOT Phase 1; Humidity OR
Temperature; Humidity OR Temperature NOT UPS.

Only items that contain the text you specify in the Search field are displayed. When the
results of a search are displayed, the background of the search field is shaded. When you
clear the search field, the background shading is removed and all items are displayed.

Note: Search fields support the Boolean operators AND, OR, and NOT only.
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Navigation View

This view in the Alarm Configuration perspective shows the device groups and devices
for which thresholds and device alarms can be configured on SNMP and Modbus devices.

You can select a device group or device in the Navigation view to display the thresholds
or device alarms that can be configured or added to a notification policy for that selection.
Thresholds are displayed in the Threshold Alarm Configuration view; device alarms are
displayed in the Device Alarm Configuration view. The number of thresholds or device
alarms associated with each device group or device is shown next it, in parentheses.

You can use the Search fields to filter the list based on text you enter in the Navigation,
Threshold Alarm Configuration, and Device Alarm Configuration views; only items that
contain the text you type are listed.

When the results of a search are displayed, the background of the search field is shaded.
When you clear the search field, the background shading is removed and all items are
displayed.

Note: You can hold the Ctrl key down to select multiple items.

You can use the right-click options and the button icons at the top of the view to do the
following:

« Create thresholds for any sensor value reported for any device group or device
( Create Thresholds option).

« Edit the thresholds for the device group or device selected ( Edit Thresholds option).

« Access the "View Device Sensors" display to see current sensor data for the selected
device ( View Device Sensors option).

« Prevent alarm notifications from occurring for the device groups or devices selected
( Enter Maintenance Mode option).

* Re-enable alarm notifications for the device groups or devices selected ( Exit
Maintenance Mode option).

< Add the thresholds for the selected device group or device to a specified notification
policy ( Add Thresholds to Notification Policy option).

« Remove the thresholds for the selected device group or device from a specified
notification policy ( Remove Thresholds from Notification Policy option).

« Enable or disable, modify the severity and recommended action, and add a custom
description on one or more alarms for the device group or device selected ( Edit
Device Alarm Configuration option).

« Change the notification policy associated with the device alarms in the device group
or device selected ( Change Device Alarm Notification Policy option).

Note: All device alarms for all devices are added to the Default notification policy at
device discovery.

« Access the "Configure Navigation Tree Labels" display to select up to three labels to
specify how monitored devices appear in the navigation tree ( Configure Navigation

=
Tree Labels icon (L£7)).

Button icons (Navigation view)

In addition to standard minimize and maximize icons, one icon is available to perform
specific Navigation view functions.
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Icon Description

= Use this Configure Navigation Tree
Labels icon to identify up to three labels that
appear in the navigation tree. The device
type and hostname are displayed by default.

"Configure Navigation Tree Labels" display

Use this display to select up to three labels to specify how monitored devices appear in the
navigation tree. This affects the navigation tree in the Navigation view and the Choose
Thresholds display in the Notification Policies view.

Note: The device type and hostname are displayed by default.

Label Description

Groups The names of any device groups a device
belongs to, including Unassigned.

Type The type of device.

Model The device model, if known. For example,
Symmetra PX, for an APC/MGE UPS.

Hostname The hostname, or IP address, if no hostname is
defined, for a monitored SNMP or Modbus
device.

Serial Number The serial number assigned to a device, if known.

IP Address The IP address used by a monitored SNMP or
Modbus device.

Location The location associated with a device, if known.

Application Version The application or firmware version number for a

device, if known. For example, v3.5.8, for a
Smart-UPS 3000 RM device.

Label The label of the device.

Maintenance Mode Indicates whether notifications have been
disabled for the device.

<Custom Property Key Name> All custom property keys, identified by name.

Contact Name The name of the contact associated with the
device.

Create Thresholds option
The Data Center Expert allows you to create thresholds for any sensor reported by a device.

In addition to the alarms available for each device, you can create thresholds for the Data
Center Expert server. Two basic types of thresholds are available: those that use numeric
settings, and those that use state settings.

Note: You can create a threshold for a virtual sensor using the Create Threshold option
for the selected virtual sensor. You cannot create a virtual sensor for state sensors. See
Virtual Sensors view for more information.
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Numeric thresholds:
* Air Flow
¢ Audio
e Current (Amps)
e Dew Point
* Energy (kwh)
* Humidity
¢ Other Numeric Sensors
* Power (VA)
* Power (kVA)
* Power (Watts)
* Power (Kilowatts)
» Temperature
* Voltage
State thresholds:
* Door
* Dry Contact
¢ Motion Sensor
¢ Other State Sensors

Both types of thresholds allow you to do the following:

Create thresholds at one time for multiple sensors of the same type (for example, all
are Humidity sensors, or all are Door sensors).

Specify the severity and return-to-normal parameters for any defined threshold.
Provide a custom URL and custom description for any defined threshold.

Configure Threshold Scheduling to specify when any defined threshold is active.
Add any defined threshold to one or more Data Center Expert notification policies.

Five menus provide access to create alarm thresholds:

Create Thresholds , an option in the Alarm Configuration menu.

Right-click menu Create Thresholds in the navigation tree in the Navigation view.
Right-click menu Create Thresholds in the Device Groups view in the
Monitoring perspective.

Right-click menu Create Thresholds in the Device View in the Monitoring
perspective.

Right-click menu Create Thresholds in the Map View in the Monitoring
perspective.

Each threshold option allows you to search the sensors monitored by the Data Center
Expert server that match the selection. You can add a threshold to one of those sensors,
or add thresholds with the same settings to any number of those sensors simultaneously.

Using the right-click menus to add thresholds to one or more sensors allows you to focus
threshold management to the sensors at a single device, or at a set of devices.

Creating numeric and state thresholds

All numeric and state thresholds use the same basic procedure and displays to create
threshold settings.

Note: The same displays are used to create thresholds when you select the Create
Thresholds option in any of the following:

The Alarm Configuration menu.

The right-click menu in the navigation tree in the Navigation view of the Alarm
Configuration perspective.

The right-click menu in the Device Groups, Device View, or Map View of the
Monitoring perspective.
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Threshold settings for all monitored devices are available when you use the Alarm
Configuration menu options. Threshold settings for only the device group or device
selected are available when you use the right-click menu in the Navigation view, Device
Groups, Device View, or Map View.

1. Select the sensor type on which you want to add a threshold from the Create
Thresholds option in the Alarm Configuration menu. Alternatively, select a device
group or device in the Alarm Configuration or Monitoring perspective views, and
right-click to select the Create Thresholds option.

2. Inthe "Select Threshold Type" display, select the threshold type you want to add, and
click Next.

3. Inthe "Select Sensors" display, select the sensor or sensors for which you want to
add thresholds, and click Next.

4. Inthe "Create Threshold" display, define the settings, and, if desired, configure when
the Data Center Expert server will generate notifications if the threshold becomes
active using the Threshold Scheduling button, and click Next.

5. Inthe "Select Notification Policies" display, select the notification policies to which you
want to add the alarm threshold, and click Finish to exit the wizard.

Thresholds and supported devices

Which thresholds can be used for sensors at the monitored devices depends on the type
of device.

For a full SNMP support device or Modbus device monitored by the Data Center Expert
server, all threshold options except Dew Point can be used to define threshold settings
the Data Center Expert server will monitor for that device. These thresholds are created
using the Create Thresholds option.

Full SNMP support and Modbus devices:

When you create thresholds for full SNMP support and Modbus devices, the threshold
settings you define are set at the Data Center Expert server, and used to monitor the
associated sensors at those devices.

Note: This can result in two alarms when a threshold you define at the Data Center
Expert server is violated: one from the SNMP device, and one for the threshold violation at
the Data Center Expert server.

You can define thresholds for SNMP and Modbus devices to do the following:
« Set the threshold settings that the Data Center Expert server will monitor for these
devices.
« Select the natification policies the Data Center Expert server will use for alarm
notifications related to these devices.

NetBotz Appliances:

When you create alert thresholds for a NetBotz Appliance, its sensor pods, camera pods,
and monitored SNMP devices (using Alert Settings, a NetBotz Appliance
Configuration option in the Device menu), the threshold settings are set at the NetBotz
Appliance. It is the NetBotz appliance that stores the settings and sends the alerts to the
Data Center Expert server.

Note: Because NetBotz Appliance alert profiles are device-specific, you will not be able to
configure the profile for a threshold setting when configuring that setting for multiple
appliances.
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Basic and model ID SNMP support devices:

For devices without full SNMP support, you can define supplemental OIDs for numeric
sensors at those devices using Supplemental OIDs, an SNMP Device Communication
Settings option in the Device menu. Once the supplemental OIDs are defined, you can
create thresholds on the sensors.

Numeric alarm thresholds

Numeric alarm thresholds are thresholds defined for sensors that report numeric values.

There are nine specific types of numeric thresholds that can be set on numeric sensors.

Numerical threshold options:

* The Other Numerical Sensors and Other State Settings options, and for some
third-party devices, Voltage, can be used to set threshold settings at a NetBotz device
for the full SNMP support devices it monitors.

« All threshold options except Dew Point can be used to define threshold settings
the Data Center Expert server will use to monitor its full SNMP support devices.

Threshold

Value

Description

Air Flow

<n> ft/min

Settings for sensors that
measure air movement as feet
per minute.

Note: Sensors that use a
different measurement, such as
cubic feet per minute (CFM) will
be displayed under the Other
Numeric Sensors option.

Audio

Relative number (0 - 100)

Settings for sensors that
measure the volume of sound.

Current (Amps)

Amps (0.0 - 100.0)

Settings for sensors that
measure current as total
amperage (amps).

Dew Point

°F (-40.0 - 122.0)/ °C (-40.0 -
50.0)

Settings for sensors that
measure dew point as degrees
Fahrenheit (°F) or Celsius (°C).

Energy (kWh)

kWh

Settings for sensors that
measure energy consumption
as kilowatt hours (kwh).

Humidity

% (0 - 95)

Settings for sensors that
measure relative humidity as a
percentage (%).

Other Numeric Settings

Varied

Settings for sensors that
measure numeric settings not
reported for other Thresholds
options.

Power (VA)

VA and kVA
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power as a percentage of VA
will be displayed under the
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Other Numeric Sensors
option.

Power (Watts)

Settings for sensors that
measure power as total watts
(W) or kilowatts (kW).

Temperature °F (-40.0 - 122.0)/ °C (-40.0 - Settings for sensors that
measure temperature as
degrees Fahrenheit (°F) or
Celsius (°C).

Voltage Settings for sensors that

measure either AC or DC
voltage as total volts (V).

Numerical threshold types:

Setting

Description

Minimum Value Threshold

An alarm occurs when the sensor's value is
below the Minimum setting.

Maximum Value Threshold

An alarm occurs when the sensor's value is
above the Maximum setting.

Range Threshold

An alarm occurs when the sensor's value is
outside the range defined by the Minimum and
Maximum settings.

Below Value for Time Threshold

An alarm occurs if the sensor value is below the
Minimum setting for longer than the delay in
the Time Allowed Below Minimum setting.

Above Value for Time Threshold

An alarm occurs if the sensor value is above
the Maximum setting for longer than the delay
in the Time Allowed Above Maximum setting.

Rate of Increase Threshold

An alarm occurs if the sensor value increases by
more than the Maximum Increase setting since
the last time the sensor value was sampled. For
example, at a sensor that measures amps, 1
would result in an alarm when the amps
measured by the sensor increases by one amp.

Rate of Decrease Threshold

An alarm occurs if the sensor value decreases by
more than the Maximum Decrease setting since
the last time the sensor value was sampled. For
example, at a sensor that measures total watts
(W), 100 would result in an alarm when the watts
measured by that sensor goes down 100 watts.

Other numeric thresholds

The Other Numeric Sensors option allows you to set thresholds for numeric sensors that
monitor values not covered by the nine threshold-specific numeric options.

The following lists identify some common examples of numeric sensors you can configure
using the Other Numeric Sensors option. The actual sensors will depend on the device
types managed by the Data Center Expert server.

Note: You can configure multiple sensors discovered for the Other Numeric Sensors
option, when the sensors you select can all use the same threshold settings. For example,
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battery and UPS age sensors use the same units of measure, and can be configured at the
same time, as can utility, input, and output voltage sensors.

UPS Battery Sensors: Other UPS Sensors: Other Sensors:
» Battery Age * UPS Age e Max Number of
« Battery Runtime * Input Frequency Output Relays
Remaining e Output Frequency e Max Number of Input
 Battery Capacity e Output Load Contacts
Remaining e Output Power e Runhours of Fan
e Time Running on Percent VA  Air Flowrate of Fan (in
Battery cfm)
 Total Air Flow (in cfm)
* RPM Speed of Fan

State alarm thresholds
State thresholds are thresholds defined for sensors that report state values.

There are three specific types of state thresholds that can be set for state sensors.

State threshold options:

Threshold Value Description

Door Open or Closed Settings for sensors that
determine whether a door is
open or closed.

Dry Contact Unknown, No Fault, or Fault| Settings for sensors that
determine the fault status of dry
contacts.

Motion Sensor No Motion or Motion Detected| Settings for sensors that detect
motion.

Other State Sensors Varied Settings for sensors that

measure state settings not
reported for other Thresholds

options.
State threshold types:
Setting Description
State Threshold An alarm occurs when the sensor state matches

the Alarm State setting.

State Mismatch Threshold An alarm occurs when the sensor state does not
match the Normal State setting.

Note: This threshold setting is useful for sensors
that can report more than two states.

State for Time Threshold An alarm occurs when the sensor state matches
the Alarm State setting for longer than the delay
in the Time Allowed in Alarm State setting.
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State Mismatch for Time Threshold An alarm occurs when the sensor state does not
match the Normal State setting for longer than
the time defined by the Time Allowed in Alarm
State setting.

Note: This threshold setting is useful for sensors

that can report more than two states.

Other state thresholds

The Other State Sensors option allows you to set thresholds for state sensors that monitor
operational states not covered by the three threshold-specific, state options.

The following lists identify some common examples of state sensors you can configure
using the Other State Sensors option. The actual sensors will depend on the device types
managed by the Data Center Expert server.

These options use the same set of four threshold settings as the other state threshold
options.

Note: You can configure multiple sensors discovered for the Other State Sensors option,
when the sensors you select use the same alarm states settings. For example, all sensors
that use On and Off states can be configured at the same time, as can all sensors that
use Up and Down.

Active/lnactive:
» Button
e Temperature
Override Status
Open/Closed:
* Input Contact
* Output Relay
* Bypass

On/Off:

* Switch

* QOutlet

» Alarm Device

» Test Relay

Other Settings:

» Ethernet Link

* UPS Input Voltage
(line neutral)

e Current Output
Phase

Fault/No Fault:
e Contact
e Input State

Connected/
Disconnected:

* Speakers

» External Microphone

Yes/No:

* UPS on Bypass

* UPS on Battery

» Audio Alarm

* Battery Low

* Overload

* Inverter Off

e UPS Over
Temperature

« Utility Power Failure

- Battery Needs
Replacement

 Battery Fault

Multiple Statuses::

e Online

» Device Status

» Battery Status

e UPS Status

» Communication
Status

» Alarm State

» Self-Test

* Runtime Calibration

» Reason for Last
Transfer to Battery

» Battery Charge Fault

* Rack ARU Operating
Status of Fan

* ARU Primary Power
Present

"Select Threshold Type" display

This display allows you to select the type of threshold for which you want to create an alarm.

You use this display to choose the type of threshold you want to create on any available
sensors for the device group or device you select. The types of thresholds available depend
on the type of sensor you select.
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Note: Once you access this display, you must select a threshold type and click Next or
click Cancel to exit the wizard.

"Select Sensors" display

Use this display to select the sensors on which you want to create an alarm threshold.

When you access this display from the Alarm Configuration menu Create
Thresholds option, all the sensors monitored by the Data Center Expert server for the
selected threshold type are listed.

When you access this display from the right-click menu in the Navigation view of the
Alarm Configuration perspective, only the sensors for the selected device group or device
are listed.

You can select the Configure Columns icon to identify the columns that appear in the
display. You can click the column headers to sort the list in ascending or descending order.

Column Description

Sensor Identifies the sensors that can be configured for
the threshold selected.

Current Reading The most recent value reported by the sensor.

Hostname Identifies a device by its hostname, or IP address
when no hostname is defined.

Unit of Measure Defines the unit of measure for numeric sensors
only.

Device Type Identifies a device by its type, or by SNMP

Device, if the Data Center Expert server cannot
determine the device type.

Device Model Identifies a device by its model number, when
known.

Device Label Identifies a device by its label, or IP address.

Parent Device <server_name> (Data Center Expert) for
devices monitored by the Data Center Expert
server.

<Custom Property Key Name> A custom property key, identified by name.

"Create Sensor Threshold" display
Use this display to configure the settings for the identified threshold.

In addition to the settings provided, the display also identifies the name of the sensor

( Sensor Name), the type of sensor ( Sensor Type) and value currently read by the sensor
( Current Reading), and allows you to define a name for the threshold setting ( Threshold
Name). You can use the Threshold Scheduling button to access the Threshold
Schedule display to configure when the threshold alarm action will be active.

Note: When more than one sensor is selected, the name of the sensor is identified in the
display as <Multiple>, and value currently read by the sensor is identified as <Multiple
Values>.

Threshold settings :
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Element

Description

Threshold value

Define the criteria for the threshold.
Note: The available value fields will depend on
the type of numerical or state threshold selected.

Enabled Select to enable the threshold, if it is disabled.
Note: Thresholds are enabled by default.
Severity Select the severity you want associated with the

threshold: Information, Warning, Error,
Critical, or Failure.

Return-to-Normal Requires User Input

Select to clear a threshold violation only when a
user with Administrator privileges marks the
alarm condition as resolved.

Return-to-Normal Delay

Define a delay, in seconds, that will occur after a
threshold is no longer violated before the alarm
condition clears. This delay helps prevent
multiple alarms for values that may rapidly switch
between alarm and non-alarm conditions before
a problem finally clears.

Custom Description

Provide a description you want included in a
threshold's alarm notifications.

Custom URL

Identify an Internet address you want included in
an alarm notification for the threshold.

"Select Notification Policies" display

This display allows you to select the natification policies to which to add the selected

threshold.

You can add the threshold to one or more existing notification policies, or none.
Note: The Default notification policy is selected by default and can be deselected.

Edit Thresholds option

The Data Center Expert allows you to edit threshold settings for any sensor reported for

any device.

You select a device group or device in the navigation tree of the Navigation view in the
Alarm Configuration perspective to view the thresholds for that selection.

Three basic types of thresholds are available: those that use numeric settings, those that
use state settings, and those that monitor communication link status.

* Numeric thresholds:
* Air Flow
e Audio
e Current (Amps)
* Dew Point
* Energy (kWh)
* Humidity

¢ Other Numeric Sensors

* Power (VA)

* Power (kVA)

* Power (Watts)
* Power (kWatts)
* Temperature
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* Voltage
» State thresholds:
* Door
* Dry Contact
¢ Motion Sensor
¢ Other State Sensors
» Communication threshold
« Communication status

All types of thresholds allow you to do the following:

 Edit thresholds at one time for multiple sensors of the same type (for example, all
are Humidity sensors, or all are Door sensors) at the devices monitored by the Data
Center Expert server.

« Specify the severity and return-to-normal parameters for any defined threshold.

» Provide a custom description for any defined threshold.

» Configure Threshold Scheduling to specify when any defined threshold is active.

Three menus provide access the Edit Thresholds option:

* Right-click menu Edit Thresholds in the navigation tree in the Navigation view:
each option allows you to simultaneously edit the thresholds for one or more sensors
that match that option, for the selected device group or device.

* Right-click menu Edit Thresholds in the Threshold Alarm Configuration view:
allows you to edit only the threshold selected, or when multiple thresholds are
selected, each option allows you to simultaneously edit the thresholds for all the
sensors that match that option.

* Right-click menu Edit Alarm Configuration in the Active Alarms view of the
Monitoring perspective: allows you to edit only the threshold selected.

Note: You can use the Filter Thresholds icon (% ) to modify the Threshold Alarm
Configuration view to prevent communication link status, user-created thresholds,
thresholds with 'Enabled’ set to 'No', and thresholds of any severity from appearing in the
view.

"Edit thresholds" display
Use this display to configure the settings for the identified thresholds.

In addition to the settings provided, the display also identifies the number of sensors to be
modified, the name of the sensor ( Sensor Name), the type of sensor ( Sensor Type) and
value currently read by the sensor ( Current Reading), and allows you to define a name
for the threshold setting ( Threshold Name).

Note: When more than one sensor is selected, the name of the sensor is identified in the
display as <Multiple>, and value currently read by the sensor is identified as <Multiple
Values>.

Threshold settings :

Element Description

Threshold value Define the criteria for the threshold.
Note: The available value fields will depend on
the type of numerical or state threshold selected.

Enabled Select to enable the threshold, if it is disabled.
Note: Thresholds are enabled by default.
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Severity Select the severity you want associated with the
threshold: Information, Warning, Error,
Critical, or Failure.

Return-to-Normal Delay Define a delay, in seconds, that will occur after a
threshold is no longer violated before the alarm
condition clears. This delay helps prevent
multiple alarms for values that may rapidly switch
between alarm and non-alarm conditions before
a problem finally clears.

Return-to-Normal Requires User Input Select Yes to clear a threshold violation only
when a user with Administrator privileges
marks the alarm condition as resolved.

Custom Description Provide a description you want included in a
threshold's alarm notifications.

Custom URL Identify an Internet address you want included in
an alarm notification for the threshold.

"Threshold Schedule" display

Use this display to define the specific periods of time, for each day of the week, during which
an associated threshold will be disabled (by default, scheduling is enabled 24 hours a day,
seven days a week).

Note: This display is used to schedule when a threshold will be enabled and disabled, using
the threshold's settings display.
Two menus in the Alarm Configuration perspective provide access to the Threshold
Schedule display:

* The threshold settings display in the Create Thresholds option.

* The threshold settings display in the Edit Threshold option.

The table provides cells for 15-minute increments, and columns for every day of the week.
You can do all of the following to schedule when an alarm threshold is enabled:

« Click a column title to enable or disable all of that day's cells.

» Drag your mouse from one cell to another cell in a column, to enable or disable a set
of cells.

» Drag your mouse from a cell in one column to a cell in another column, to enable or
disable an identical set of cells for each of the selected days.

 Click a single cell.

"Edit Thresholds" display
Use this display to edit existing thresholds for the selected device.

The display lists all the settings currently defined for each option.

Element Description
Threshold Types Select the threshold type you want to view in the
display.
Search Filter the list based on text you enter in this

box; only existing thresholds that contain the
text you type are listed. You can broaden or
narrow your search using the Boolean
operators AND, OR and NOT only.
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When the results of a search are displayed,
the background of the search field is
shaded. When you clear the search field, the
background shading is removed and all
items are displayed.

List Check-mark the previously defined thresholds
that you want to edit or delete.

The following information is provided for the
listed threshold.

Threshold: the sensors that can be
configured for the threshold selected.

Current Value: the most recent value
reported by the sensor.

Parameters: the settings defined for the
threshold.

Alarmed State: whether the threshold is in
an alarm state.

Hostname: the hostname, or IP address
when no hostname is defined.

Unit of Measure: the unit of measure.
Name: the name of the threshold.
Severity: the severity of the threshold.

Label : the device label, or IP address when
no label is defined.

Device Model : the model, when known.
IP Address: The IP address of the device.
Device Type: the type of device.

Notification Policy: the policy or policies
with which the threshold is associated.

Edit Click to edit a selected threshold.

View Device Sensors option
This option shows the current sensor data for the selected device or active alarm.

You can select a device or active alarm to view the most recent sensor data available for

that selection. By default, data for all sensor types are displayed when data for more than
one sensor type is available. For some devices, you can select one sensor set for which to
display current data.

Use the Search field to filter the list of sensors based on the text you type. You can broaden
or narrow your search using the Boolean operators AND, OR and NOT. Only items that
contain the text you specify in the Search field are displayed. When the results of a search
are displayed, the background of the search field is shaded. When you clear the search
field, the background shading is removed and all items are displayed.

Use the Configure Columns icon to show or hide sensor columns and custom properties.
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Five menus provide access to the "View Device Sensors" display:

* Right-click menu View Device Sensors in the Device View and Map View of the
Monitoring perspective.

* Right-click menu View Device Sensors in the Active Alarms view in the
Monitoring perspective: view the most recent sensor data available for the device on
which the selected alarm occurred.

Note: Camera clips are not displayed when more than one active alarm is selected.

* Right-click menu View Device Sensors in the navigation tree in the Navigation
view of the Alarm Configuration perspective.

* Right-click menu View Device Sensors in the Alarm History view, accessed from
the Window menu.

Enter/Exit Maintenance Mode options

Schedule when you want to disable or re-enable notifications for any device or device group.
This option is available to users with Device Administration or View and Control access on
the Data Center Expert server.

You use the Enter Maintenance Mode option to disable notifications for the selected
devices or device group on a date and time you specify, and re-enable notifications on a
date and time you choose, or never.

You can choose Never re-enable notifications if you do not want to get notifications for the
selected devices, or you prefer to re-enable notifications manually.

You can use the Exit Maintenance Mode option re-enable notifications now or at a time
you choose.

Note: The date and time you choose to enter and exit maintenance mode is the local time
of the Data Center Expert client.

The Maintenance Mode Schedules window automatically opens when you create a
schedule and displays all the schedules you create. You can modify a schedule to specify
the time to disable or re-enable notifications at any time.

Right-click a schedule to:

* View Devices in a schedule and remove selected devices from the schedule if
needed.

» Edit Maintenance Mode Schedule and Comment to change the date and time to
enter or exit maintenance mode, or to modify the comment.

» Delete the schedule. When you delete a schedule, the maintenance mode settings
are also disabled and deleted.

When notifications are disabled:
* The Active Alarm and Alarm History views report the date and time the notifications
were disabled and when they were enabled again.

Notifications also appear in the web client event log.

« The information for affected devices is italicized, and the regular status icons are
replaced, in the Device View, Map View, and view in the Alarm Configuration
perspective.

* You can click a device to view its status in the Active Alarms view. All alarm
conditions are reported while notifications are disabled.

User Access

Users with Device Administration access can perform all actions on schedules created by
all users, and view the usernames of all schedule owners.
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Users with Device View and Control access can see all the schedules created in the
Maintenance Mode Schedules window.

Users with Device View access can only see schedules in the Maintenance Mode
Schedules window if they have access to devices listed in that schedule. The usernames
of the schedule owners are not visible. View and Control users can see only the devices
they have access to in any schedule, and can only modify the schedules they create.

Schedule ownership

The user who creates a schedule is the owner of that schedule. Access permission to a
schedule is based on the owner.

Administration users can add devices to any schedule regardless of ownership.

If an Administration user adds devices to a schedule owned by a View and Control user,
the View and Control user can only see those devices if they have access to them.
Otherwise, a message is displayed.

A schedule owner can remove any device from the schedule regardless of whether they
have control access to it.

Add Thresholds to Notification Policy option

This option allows you to add thresholds for the selected device group, device, or thresholds
to an existing policy used by the Data Center Expert server to generate alarm notifications.

In the Alarm Configuration perspective, you can select a device group, device, or
threshold and add the thresholds for that selection to an existing notification policy. All the
thresholds for that selection will be added to the selected notification policy.

Note: You can view thresholds after they have been added to the notification policy, and
choose which thresholds to include or exclude. You can add alarm actions and configure
options for those actions.

Two menus in the Alarm Configuration perspective provide access to the Add
Thresholds to Notification Policy option:
* Right-click menu Add Thresholds to Notification Policy in the Navigation view.
* Right-click menu Add Thresholds to Notification Policy in the Threshold Alarm
Configuration view.

Remove Thresholds from Notification Policy option

This option allows you to remove thresholds for the selected device group or device from a
policy used by the Data Center Expert server to generate alarm notifications.

In the Alarm Configuration perspective, you can select device groups, devices, or
thresholds and remove the thresholds for that selection from an existing notification policy.
When one or more device groups or devices are selected, all the thresholds for that selection
will be removed from the selected notification policy.

Two menus in the 